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Chapter 1: Purpose 
 

The Latent Print Unit will provide the highest quality professional and analytical impression 

evidence examination and comparison services by qualified professional staff for the Wake 

County law enforcement community and the Office of the District Attorney for the Tenth 

Prosecutorial District. 
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Chapter 2:  Staff Qualifications and General Work Procedures 
 

 

The CCBI Latent Print Unit is under the direction of the Crime Laboratory Division Deputy 

Director.  The Latent Print Unit is composed of a Forensic Supervisor and Latent Examiners.   

The Latent Print Unit shall be staffed during normal work hours; Monday through Friday from 

8:30am to 5:15pm.  Occasionally, however, the Latent Print Unit may be needed outside of the 

normal scheduled hours based on criminal investigations.  As such, the Director, the Crime 

Laboratory Division Deputy Director, or the Forensic Supervisor may adjust employee work 

hours to accommodate such needs. 

CCBI latent print staff are exclusively qualified, and therefore authorized, to compare impression 

evidence and make resulting identification and exclusion determinations.   

CCBI is committed to employing the highest quality professional staff to conduct Latent 

Examination Services.  As such, Latent Print Unit will be subject to the following requirements: 

Forensic Supervisors 

- Persons assigned to the position will obtain a Latent Print Certification from the 

International Association for Identification. 

- Persons assigned to the position of Forensic Supervisor will keep current on any training 

required to operate equipment deemed necessary to the job functions for the analysis of 

latent evidence. 

- The Forensic Supervisor will be required to successfully complete annual proficiency 

testing. 

 

Lead Latent Examiner – Assistant Supervisor  

- Persons assigned to this position must meet the criteria of the Latent Examiners, and will 

assist the Forensic Supervisor with various administrative duties as needed. In the absence of 

the Forensic Supervisor, the Lead Latent Examiner assumes charge of the unit.   

 

Latent Examiners 

- Persons newly assigned to the position of Latent Examiner must complete a training 

program. 

- Persons newly assigned to the position of Latent Examiner will obtain the International 

Association for Identification Latent Print Examiner Certification within 18 months of the 

start of their employment, if not already certified at the time of their appointment.  
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- Persons assigned to the position of Latent Examiner will keep current on any training 

deemed necessary to the job functions for the analysis of latent evidence. 

- Persons assigned to the position of Latent Examiner will be required to be tendered as an 

expert witness in court. 

- The Latent Examiner will be required to successfully complete annual proficiency testing. 

 

Forensic Technicians 

The Forensic Technician is a CCBI employee/s is assigned to assist the Latent Print Unit when 

available. Their assistance to the Latent Print Unit may consist of the following responsibilities:  

 

- Conduct database searching in the local and state systems, and disposition search results of 

their searches as well as clearing old search results from the database reverse queues.  

- Persons newly assigned to the position of Forensic Technician must complete a training 

program.  

- Maintaining and updating the chain-of-custody for latent print evidence transactions.  

- Prepare case files for the Latent Examiners. 

- May be required to attend autopsies for the collection of post-mortem prints from deceased 

individuals. 
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Chapter 3: After Hours Requests for Latent Unit Assistance 
 

The Chain of Command for the Latent Print Unit is as follows: 

1) The Director 

2) The Deputy Director of the Crime Laboratory 

3) The Forensic Supervisor of the Latent Print Unit 

4) Assistant Supervisor of the Latent Print Unit 

5) The Latent Print Examiners 

If Latent Unit assistance is requested after normal work hours, notification of the request should 

be made to the immediate supervisor of the Latent Print Unit.  The Forensic Supervisor will 

notify the Deputy Director of the Crime Laboratory and/or the Director to advise of the request 

for after-hours Latent Unit assistance.  

If the request for assistance is approved by the Deputy Director and/or the Director, the Forensic 

Supervisor will then make contact with a Latent Examiner(s) to request their assistance and 

advise on the nature of the event.  

A Latent Examiner(s) who responds to an after-hours request for Latent Unit assistance may 

consider their work time as starting from the time their commute to the office or assignment 

location begins, up until their return time to their residence at the completion of their duties.  

Overtime hours may be accumulated for that work week (Monday through Sunday), or the 

additional hours may be flexed out as long this occurs sometime during the same work week 

(Monday through Sunday). Any deviation to this work time adjustment must be approved by 

either the Deputy Director of the Crime Laboratory and/or the Director.  
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Chapter 4: Proficiency Testing 
 

A proficiency testing program is a reliable means of assuring that the quality of each examiner’s 

work is being maintained and ensures that CCBI’s technical procedures are valid. Proficiency 

testing is not a measure of methodological error rate; rather, it measures individual performance 

and identifies areas where improvements may be needed. 

 

A proficiency test should target individual Latent Print Examiner analysis, 

comparison, and evaluation competency, and may also target casework procedures, 

such as documentation, verification, evidence handling, etc. 

 

Policies regarding proficiency testing are as follows:  

 

- The proficiency test will be administered by the Quality Manager. Deputy Director of the 

Crime Laboratory, or another individual as assigned by the Deputy Director.  

- Latent Print Examiners and Forensic Technicians trained to competency will be proficiency 

tested.  

- Latent Print Examiner/Forensic Technician trainees will not be proficiency tested.  

- Each Latent Print Examiner trained to competency should be proficiency tested at least 

annually in latent print analysis. Footwear proficiency examinations shall be completed in 5-

year intervals by examiners who conduct footwear cases as part of their regular work 

assignments.  

- Undue time constraints shall not be imposed. 

- There is no requirement to proctor tests. 

- Test location and conditions shall reflect a normal working environment, and examiners 

shall be allowed to utilize any instrument or equipment normally available to them for the 

completion of their duties.  

- Corrective action shall be taken when an erroneous individualization occurs. 

- An erroneous individualization is defined as when a Latent Examiner identifies a latent or 

unknown friction ridge impression to the incorrect source.  

- Clerical or administrative errors are not erroneous individualizations, for example, writing 

the wrong finger number or misspelling a name. 

- All failures to individualize, clerical or administrative errors shall be reviewed for corrective 

action. 

- Proficiency test records will be maintained by the Quality Manager. Deputy Director of the 

Crime Laboratory, or the Forensic Supervisor of the Latent Print Unit.  

- Proficiency tests shall be administered in an open format, signifying that the examiners are 

aware they are being tested. 
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Chapter 5: Chain-of-Custody  
 

The evidence chain-of-custody is a document (or documents) containing a record of individuals 

who have had physical possession of evidence items, and for which dates.  

All CCBI personnel collecting latent print evidence or recovering such evidence for examination 

purposes will document the submission of this evidence to the Latent Print Unit utilizing 

standard documentation procedures.  

For each evidence transfer that occurs within the Latent Print Unit, the following criteria must be 

met: 

- The date of the transfer must be recorded. 

- A physical signature by each of the participants engaged in the transfer must be present, and 

the chain-of-custody document must be signed at the time of the transfer of the evidence.  

- A description of the items being transferred to include item numbers or lift card numbers, 

when applicable. 

At the point when the latent evidence items are ready for long-term storage in the Latent 

Evidence Control room (LEC), the chain-of-custody forms are to be retained in the case file and 

sent to the central records section.   

Whenever a latent print envelope needs to be withdrawn from the LEC room, a new chain-of-

custody sheet will be generated and placed in the Latent Examiner’s case file. The person 

removing the latent evidence from the LEC room is responsible for creating and updating a new 

chain-of-custody form. The template for the chain-of-custody forms is are available on 

SmartWorks., and blank chain-of-custody sheets and/or continuation sheets are located in the 

LEC room.  

If a latent print case is a possible database hit and is awaiting assignment to a Latent Examiner, 

the chain-of-custody from will be located in the case packet. After the case has been assigned 

and completed by a Latent Examiner, all documentation, including the chain-of-custody, will be 

retained as part of the case file.  

See Laboratory Administrative Procedures Manual, Chapter 8, section “Evidence Handling and 

Case Management”.  
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Chapter 6: Evidence Handling 
 

Any evidence item received from any non-Latent Print Unit employee shall be inspected for the 

following: 

- Agency and CCBI case information is visible. 

- Evidence description is visible. 

- Evidence packages are appropriately sealed. 

- Evidence seals are marked with the initials and date. 

- Chain-of-custody is documented. 

 

Whenever a package containing an evidence item is received by a Latent Examiner/Forensic 

Technician, the person receiving the item must place his/her initials and the date of receipt 

somewhere on the evidence package. The back of the latent print envelope is an area that may be 

used for this purpose.   

Attempts should be made whenever possible not to break or open another individual’s evidence 

seals and markings on any evidence packages.     

Evidence items which are transferred within the Latent Print Unit are not necessarily subject to 

the criteria of the sealing and marking of seals of evidence packages. 

Once evidence items leave the Latent Unit, then the Latent Examiners will seal the evidence 

packages and mark the seals with their initials and the date the evidence package was sealed.  

Evidence transactions to and within the unit shall be recorded on a chain-of-custody document/s.  

See Laboratory Administrative Procedures Manual, Chapter 8, section “Evidence Handling and 

Case Management”.  

 

REFERENCES  

 

ASCLD/LAB-International Supplemental Requirements for the Accreditation of Forensic 

Science Testing and Calibration Laboratories, American Society of Crime Laboratory 

Directors/Laboratory Accreditation Board, Garner, NC, 2011.  

 

ISO/IEC 17025-General Requirements for the Competence of Testing and Calibration 

Laboratories, International Organization for Standardization, Geneva, Switzerland, 2005.  
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Chapter 7: Evidence Storage 
 

Short-term evidence storage:  

Each Latent Examiner will be responsible for the secure retention of evidence items assigned to 

their custody.  

Latent Examiners will be provided with mobile, lockable evidence storage containers to be 

utilized for the secured placement of case work when not on duty. 

Upon the conclusion of the work day, the Latent Examiner must lock their evidence items within 

their mobile evidence container and transfer it directly to the LEC room.   

When an individual with evidence in their immediate custody leaves the work area during the 

workday for a short time (e.g., restroom break, meal break) the evidence in the work area must 

be secured by locking the door to the work area.  When evidence is to be left unattended for an 

extended period (i.e., longer than a meal break) the evidence must be secured by locking it in a 

mobile evidence container and transferring it to the LEC room. Case files, latent print evidence, 

notes, or any other case work documentation in current progress may not be left opened or on 

desks., with the exception of during breaks, lunch hours, and/or other activities that may 

withdraw the Latent Examiner from their case work for a minimal time. 

Each Latent Examiner will also be provided with a large evidence locker, located in the Main 

Evidence Vault, for larger or bulkier items of evidence. The items will be signed over to the 

custody of the Latent Examiner, though they may be maintained in the evidence locker. 

Short-term storage of evidence should exceed no more than one year from the date in which the 

Latent Examiner received the evidence as documented on the chain-of-custody. 

Long-term evidence storage:  

Long term evidence storage is storage for cases which are not actively assigned or are being 

actively worked by a Latent Examiner. These cases are maintained in a secured location in the 

event that the case becomes active and requires assignment to a Latent Examiner.  

The long-term storage area for latent print evidence consists of two areas:  

The Latent Evidence Control room (LEC), room C2422.  
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The Main Evidence Vault, room C1397.  

Latent evidence in long term storage may be destroyed using the following protocol: 

- Property cases only. 

- Property cases spanning over twenty years (and earlier, if applicable) from the current year. 

- With a court order. 

Upon completion of a latent print case assignment, the latent print evidence will be transferred 

to the Latent Evidence Control room (LEC) for secure long term storage.  

The Latent Print Unit will be responsible for the secure retention of all latent print evidence 

submitted, unless specifically requested by an authorizing individual (Forensic Supervisor of the 

LPU, a CCBI Deputy Director, the CCBI Director, or a supervisor from the contributing agency) 

to turn the latent evidence over to the contributing agency.  

Upon the conclusion of a footwear examination, footwear evidence shall be returned to the 

contributing agency via the CCBI Evidence Technician.  

Access to the records maintained within the CCBI Latent Evidence Control room (LEC) shall be 

limited to the Forensic Technicians, the Latent Print Examiners, the Forensic Supervisor of the 

Latent Print Unit, the Deputy Director of the Crime Lab or his/her designee, and the Director or 

his/her designee, and the Quality Manager.  
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Chapter 8: Rotation of Latent Print Evidence from the LEC Room to the 

Evidence Room 
 

The Latent Evidence Control room, C2422, will store latent evidence using the following 

protocol.   

All cases:  

Will be maintained in the LEC room for approximately five to six (5-6) years from the current 

year. The cases are filed by the CCBI case number.  

After five to six (5-6) years, the property crimes latent print evidence will be placed in a storage 

container that is to be sealed, initialed, and clearly marked with descriptive information 

explaining the contents of the container.  

The sealed containers will then be placed in the Main Evidence Vault, C1397, for long-term 

storage. 

The person’s crimes latent print evidence cases will be retained for long-term storage in the LEC 

room, C2422.  

See Laboratory Administrative Procedures Manual, Chapter 11, page 45, section “Case File 

Management”.  
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Chapter 9: Latent Unit Workflow Procedures 
 

RECEIVING LATENT PRINT EVIDENCE 

 

The Crime Scene Agents or the Forensic Photographer will generally deposit latent evidence 

envelopes in the Main Evidence Vault. On some occasions, latent evidence may be received 

directly from a Crime Scene Agent, Evidence Technician, or Forensic Photographer. In every 

instance, the chain-of-custody must be documented accordingly. 

  

Latent evidence envelopes received from outside agencies (not from the CCBI Crime Scene 

Agents) will be treated with standard latent evidence protocol, and will be placed in long-term 

storage when latent examination is completed.   

 

RETRIEVAL OF LATENT EVIDENCE FROM THE EVIDENCE BOX 

Latent Evidence collected from the Main Evidence Vault by the Forensic Technician, the 

Forensic Supervisor of the Latent Print Supervisor, the Evidence Technician, or another designee 

as requested by a supervising authority.  

TRIAGING OF CASES FOR IMMEDIATE DATABASE SEARCHING 

 

1) Person’s crimes cases will be given higher priority for database entry.  

2) Residential burglary cases will be given secondary priority for database entry.  

3) Other property crimes will be given lower priority for database entry. There 

may be instances when it is necessary for lower priority property crimes to be 

stored in the evidence room prior to database searching, to allow for database 

searching of higher priority cases first. If however, any of these lower priority 

cases has been marked with “rush” by the Crime Scene Agent who submitted 

them, or are indicated as a “rush” by a Supervisor, they may be database 

searched accordingly.  

4) A Database Review note sheet will be generated for each latent case received.  

 

Latent print cases that do not produce possible latent print identifications to any known 

individual/s will be signed over to the Latent Evidence Control room (LEC) for long-term 

storage.  
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Refer to Latent Print Unit Technical Procedures, Chapters 14, 16, and 18 for detailed 

step-by-step instructions regarding latent print database searches.  

 

CASES PENDING ASSIGNMENT  

 

Cases that have been signed over to the LEC (and are not part of the verification process) 

to await assignment to a latent examiner are not considered to be in process. These cases 

will be received by the LEC in a sealed condition.   

 

Person’s crimes cases in which database searching may provide identification 

information may be analyzed in the following manner:  

 

1) An initial identification and verification of all subjects should be completed. 

Case notes will be generated.  

2) When possible, a rapid notification should occur alerting the appropriate law 

enforcement agency/ investigator of the latent print identification information. 

If sent by e-mail, a copy of the e-mail will be retained. If notified via 

telephone or in person, a communication log form will be filled out and 

maintained in the case file.  

3) The remaining latent prints in the case will be compared to all the subjects 

identified by database searching, and possibly any additional subjects 

submitted for comparison at the request of the investigator. The case may be 

assigned directly to a Latent Examiner for a full case examination, or may be 

signed over to the LEC room to pend for no longer than 18 months for 

assignment to a Latent Examiner.  

4) Once the case is assigned to a Latent Examiner, a full case examination will 

be conducted and full case notes will be generated. 

5) If additional identifications occur, the case gets transferred to another Latent 

Examiner for verification.  

6) After verifications are completed, and the case is returned to the primary 

Latent Examiner, the Latent Examiner will generate a full case report.  

7) The case and subject identification information are updated on the monthly 

spreadsheet, to be disseminated to the law enforcement community at the 

beginning of during the next calendar month.  

8) The administrative review of the case is conducted.  

9) The case file is forwarded to the records section.  
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10) The latent evidence is signed back over to the LEC room. All evidence 

transfers must be documented on the chain-of-custody forms.  

11) The case information is published.  

 

See the Technical Review work flow procedures Chapter 10, for cases flagged for Technical 

Review.   

 

Property crime cases in which database searching may provide identification information 

may be handled in the following manner:  

 

A) Residential burglaries 

1) Latent print identifications that occur in residential burglary cases shall 

generally be completed utilizing the limited identification program.  

2) One latent print identification and verification per subject will be 

conducted.  

3) When possible, a rapid notification should occur alerting the appropriate 

law enforcement agency and investigator of the latent print identification 

information. If sent by e-mail, a copy of the e-mail will be retained. If 

notified via telephone or in person, a communication log form will be 

filled out and maintained in the case file.  

4) The Latent Examiner will produce a limited identification report.  

5) The monthly identification spreadsheet is updated with the case and 

subject information.  

6) After the administrative review, the case file is sent to the central records 

section for storage. 

7) The latent evidence is signed back over to the LEC room.  

8) All evidence transfers must be documented on the chain-of-custody forms.  

 

Person’s crimes and residential burglary cases in which database searching may provide 

identification information may be analyzed in the following manner: 

 

1) An initial rapid identification and verification of all subjects should be completed, and 

case notes will be generated.   

2) When possible, a rapid notification should occur alerting the appropriate law enforcement 

agency/investigator of the latent print identification information. If sent by e-mail, a copy 

of the –mail will be retained. If notified via telephone or in person, a communication log 

form will be filled out and maintained in the case file.  
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3) The examiner will produce a limited identification report.  

4) The monthly identification spreadsheet is updated with the case and subject information.  

5) After the administrative review, the case file is sent to central records for storage. 

6) The latent evidence is signed back over to the LEC room.  

7) All evidence transfers must be documented on the chain of custody forms.  

 

See the Technical Review work flow procedures Chapter 10, for cases flagged for Technical 

Review.   

 

Other property crimes will follow the same procedure as outlined above, with the exception of 

not producing a rapid identification/notification for investigators, unless specifically requested to 

do so by an investigating authority.   

 

B) Other property crimes  

1) The case information sheets from the database(s) are printed, the known 

finger/palm print cards are prepared, and the latent evidence is placed in a 

case file packet. 

2) The case file packet is turned over to the LEC room, unless there is a Latent 

Examiner readily available to accept the case. 

3) These case examinations will generally be subject to the limited 

identification program.  

4) Upon assignment to the Latent Examiner, the case is prepared utilizing the 

same protocol as in steps 2, and 4-8 as referenced above for the residential 

burglaries.  

5) This category of cases may not pend for assignment in the LEC for a period 

longer than 18 months from the date they were turned over to the LEC 

according to the chain-of-custody. 

 

See the Technical Review work flow procedures Chapter 10, for cases flagged for Technical 

Review.   

 

REVERSE SEARCH CASE WORK FLOW 

There are occasions when apparent database identifications occur as a result of reverse searching. 

This means that a latent print from a previous entry may be potentially associated with an 

individual whose known standards were recently added to the database. In this scenario, the 

following procedures are applicable for all case types:  
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1) The case information sheets from the database(s) are printed, the known 

finger/palm print cards are prepared, and the latent evidence (which should 

already be in the LEC) is placed in a case file packet. 

2) The case file packet is stored in the LEC room, if there is not a Latent 

Examiner readily available to accept the case. 

3) Depending on the circumstances of the case, the limited identification 

program is applicable to the property crimes and potentially some person’s 

crimes as well. The limited identification program will be applied to these 

cases.  

4) Upon assignment to the Latent Examiner, the case is prepared utilizing the 

same protocol as in steps 2, and 4-8 as referenced above for the residential 

burglaries.  

 

 

The limited identification program may be applied in person’s crimes cases older than one year 

(from the date of the occurrence of the crime) if the case has been declared closed by the 

investigating agency or the courts. However, the application of the limited identification program 

to a person’s crime can only occur at the direction of an investigating authority.  

 

The purpose of applying the limited identification program to a closed case would be to notify 

the appropriate entities that additional information has been generated. Any communication with 

the investigating authority regarding the application of the limited identification program to a 

person’s crimes case must be documented and retained in the case file.  

 

The limited identification program applies to person’s and property crimes. It is applicable in any 

case or instance in which a potential latent print identification has been produced as a result of 

database searching.  

 

A check of the reporting system is necessary to see if a Latent Examiner has previously 

conducted an exam and written a report on this case. If so, an effort to assign the case to the 

primary Latent Examiner will be made.  

 

REQUESTS FOR LATENT PRINT COMPARISON WORK FLOW 

 

Any requests for latent print comparison submitted by an investigator should follow the below 

work-flow:  
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1) The latent comparison requests must be submitted on a CCBI evidence 

submission form, and must be received by the Latent Print Unit. Requests are 

received via e-mail, fax, or in person. Verbal requests are not accepted and will 

not be honored.  

2) Latent Examiners may not conduct examinations for a different 

agency/investigator other than who submits the request, unless it can be clarified 

that the cases are linked. For example, a Raleigh police detective may not submit 

a request for comparison against an individual for latent evidence collected in a 

Knightdale case. Such a request would have to be generated by a Knightdale 

police investigator. Should the Knightdale case be a follow-up for an original 

Raleigh case (a recovered vehicle in Knightdale that was stolen in Raleigh, for 

example), this information must be documented and the comparison may be 

performed. Another exception to this is any request received by the District 

Attorney’s Office.  

3) If no known standards exist for the individuals listed on the request, the requestor 

must be contacted and notified that no known standards exist in CCBI files, 

therefore the comparison cannot be completed. A simplified notification will be 

generated and updated in the reporting system.  

4) If known standards and latent print evidence exist, the request is then maintained 

in the central records area until the Latent Unit is available to accept them.  

5) When the Latent Unit is ready to receive requests for comparison, the requests 

and known standards will be turned over to the LEC room so the latent print 

evidence can be combined in the case file.  

6) The requests will be maintained in the LEC until a Latent Examiner is ready for 

assignment.  

7) A Latent Examiner will be assigned to complete the request (it will be assigned to 

the original Latent Examiner, if applicable).  

8) If the latent request is received by the Latent Examiner 6 (six) months after the 

original date of receipt by the central records section, the Latent Examiner should 

attempt to make contact with the requestor to determine if the request for 

comparison is still needed. 

9) If the case has been closed and analysis is not required, this information must be 

documented thoroughly in the case file and the request will be considered 

cancelled. A simplified notification detailing the circumstances as to why the 

analysis was not conducted will be generated and updated in the reporting system. 
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10) If the case is still active, the Latent Examiner will complete a full case 

examination (unless specifically advised by the investigating authority that a 

Limited Identification examination would be sufficient), generate case notes, and 

conduct any additional database searching if applicable 

11) If any latent print identifications are made, the case must be sent to a second 

Latent Examiner for the verification process.  

12) The case and subject identification information is updated on the monthly 

spreadsheet.  

13) Upon return of cases from verification, the applicable case report is created. 

14) If no latent print identifications are effected, a negative report is generated by the 

Latent Examiner. 

15) After the administrative process is complete, the case file is turned over to central 

records for storage. 

16) The latent evidence is returned to the LEC room.  

17) All evidence transfers must be documented on the chain-of-custody forms.  

 

See the Technical Review work flow procedures Chapter 10, for cases flagged for Technical 

Review.   
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Chapter 10: Requests for Comparison with 10-print cards as Evidence Items (incl. 

Post-mortems), and Requests for Service from Outside Agencies.  
 

Latent Examination with 10-print cards as evidence items:  

 

1) The evidence item (known standards) is submitted to the Evidence 

Technician, or appropriate designee, with a request for comparison on an 

evidence submission form. 

2) Once the evidence item is accepted and assigned an item number, it is either 

directly assigned to a Latent Examiner, or is turned over to the LEC room to 

pend until assignment can be made.  

3) A copy of the request form is sent to the Accreditation & Budget Manager 

submitted for tracking and management purposes. 

4) Upon assignment of the case to a Latent Examiner, a full case examination 

will be conducted.  

5) Follow steps 8-19, as noted above in Requests for Latent Print Comparison 

Work Flow. 

6) Once the case examination is complete, the evidence items (known standards) 

are turned over to the Evidence Technician to be returned to the contributing 

agency. 

7) Upon completion, a second copy of the request form is submitted for tracking 

and management purposes.   

 

Latent Unit Assistance for Outside Agencies: 

Anytime the latent unit is requested to assist an outside agency with database searching for latent 

analysis or footwear services, the request must be approved by the Director or a Deputy Director.  

Any request may be denied at the discretion of the approving authority.  

The request will be documented on the Laboratory Request Form. The contact information of the 

individual requesting the service will be listed on the form. The contact information should 

include an e-mail address or fax number, and/or phone numbers.  

If the request is approved, the Forensic Supervisor and/or the Lead Latent Examiner will 

coordinate and assign the case to the Forensic Technician/Examiner. A CCBI unique agency case 

number must be created, for which all created documentation will be filed.  
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Every effort must be made to prevent the acceptance of evidence from an outside agency. This 

may require the representative of the outside agency physically be present, although non-

involved, during the database searching process. All normal CCBI protocols should be followed 

to include: latent markings, envelope markings, reporting system notification updates, 

communication logs, etc. Additionally, due to the fact that the items being reviewed by a 

member of the CCBI latent unit will not be retained in CCBI storage, photocopies of evidence 

items and evidence envelopes should be made upon the completion of the examination (to clearly 

show CCBI latent examination markings) and all photocopies must be retained as part of the 

technical documents of the case file.  

Unless directed to do so by the CCBI Director or a Deputy Director, latent staff will refrain from 

effecting latent print identifications for outside agencies, conducting latent print verifications on 

identifications effected by outside agencies, writing latent print reports for outside agencies, 

conducting comparative footwear analysis, or insinuating a latent print identification as the result 

of a “database hit” from searching done at the request of outside agencies. With regards to 

footwear examination, requests for database search through SICAR may be completed and a 

SICAR report will be produced.  

In the event that an apparent positive finger or palm print association has been produced as a 

result of a database search, the Forensic Technician/Examiner must advise the outside agency 

representative of the information and clearly indicate that a latent print comparison conducted by 

a qualified latent print examiner would be in order.   

At the completion of the request for service, a notification will be forwarded to the requesting 

individual via e-mail or fax.  
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Chapter 11: WORK FLOW CASE ASSIGNMENTS 
 

1) Latent case assignments are generally issued, on a monthly basis at the start of 

each calendar month. Cases may be self-assigned, or assigned to Latent 

Examiners by the Forensic Supervisor or appropriate designee.  

2) Under normal circumstances, the Latent Examiner may complete their case 

assignments during the course of the month. Cases assigned to Latent Examiner 

shall not normally exceed 12 months without completion. Exceptions will be 

handled on a case-by-case basis, with supervisor approval as documented in the 

Latent Examiner’s case notes.   

3) By approximately the third week of the month, most cases are submitted to the 

Forensic Supervisor or designee for verification and/or technical and 

administrative reviews.   

4) After verifications and appropriate reviews are completed, the monthly latent 

print identification spreadsheet is updated.  

5) Once the cases are returned to the Latent Examiners, the case report is generated, 

unless the case was flagged for a technical review. In this instance, a rough draft 

copy of the report would be included in the examination documentation for 

technical review purposes.  

6) After all final reports are approved as part of the administrative review, the latent 

print evidence is returned to the LEC room.  

7) The examination documentation for each case completed is then submitted to 

central records. 

8) At the beginning of each Each calendar month the previous month’s latent print 

identification spreadsheet is disseminated to the law enforcement community.  
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Chapter 12: FOOTWEAR CASE ASSIGNMENTS 
 

 

1) Footwear evidence is received per normal evidence receipt procedures (see 

Laboratory Administrative Procedures Manual, Chapter 8, page 27, section 

“Evidence Handling and Case Management”).  

2) A written request on an evidence submission form for footwear comparison must 

be received by from the investigator/officer/detective/district attorney. Verbal 

requests will not be accepted or honored.  

3) A copy of the request is turned over to the Accreditation & Budget Manager 

submitted for management and statistical purposes.  

4) The evidence items to be compared are turned over to the designated footwear 

evidence locker in the Evidence Control room.  

5) The footwear comparison requests are assigned to the Latent Examiners by the 

supervisor upon the completion of previous requests, not by any predesigned 

schedule.    

6) The Latent Examiner conducts the examination, and creates documentation (case 

notes) as part of the examination process. 

7) The Latent Examiner will turn the case over to another qualified Examiner for 

review and/or verification. 

8) After review/verification, the case is returned to the original Examiner and a 

report is generated.  

9) The Latent Unit Supervisor is notified of the completion of the case and the 

pending report. 

10) The administrative review occurs after the completion of the case examination.  

11) The case file is then turned over to the records section. 

12) The Latent Examiner returns all evidence to the contributing agency via the 

Evidence Technician.  

13) Chain-of-custody must be maintained for all footwear evidence transactions.  

14) Upon completion, a second copy of the request form submitted for management 

and statistical purposes.  

 

See chapter 10 for cases flagged for Technical Review. 

 

FOOTWEAR DATABASE SEARCHING 
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Person’s Crimes:  

1) Person’s crimes footwear cases are generally received via the Main Evidence 

Vault. However, occasionally there may be a direct transfer of evidence. In all 

instances, it is important to document evidence transactions on the chain-of-

custody.  

2) Person’s crimes cases with footwear evidence of value to be searched (as 

determined by a Latent Examiner) will be entered into the SICAR database for 

searching.  

3) Case notes are generated, and the reporting system is updated with a notification 

advising of the database search.  

4) The footwear evidence is turned over to the contributing agency via the Evidence 

Technician, following proper evidence transfer procedures.  

Property crimes:  

 

1) Property crimes footwear All footwear cases are only searched through the SICAR 

database system at the request of an investigating authority.  

2) The written request is submitted on an evidence submission form and is turned over 

to an Evidence Technician at the CCBI evidence unit, along with the questioned 

footwear items.  

3) The request and questioned footwear items may then be directly turned over to the 

Main Evidence Vault, or can be turned directly over to a Latent Examiner. In all 

instances, it is important to document evidence transactions on the chain-of-custody.  

4) Once the questioned footwear evidence items and request are received by a Latent 

Examiner, their value for database searching will be assessed.  

5) Property crimes cases Cases with footwear of value to be searched (as determined by 

a Latent Examiner) are entered into the SICAR database for searching. 

6) Case notes are generated, and the reporting system is updated with a report advising 

of the database search results.  

7) The footwear evidence is turned over to the contributing agency via the Evidence 

Technician, following proper evidence transfer procedures.  

 

All documentation created as a result of a review of evidence for SICAR searching must be 

organized in a case file and turned over to central records for storage.  
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Chapter 13: Technical Reviews 
 

The Latent Print Unit shall technically review a minimum of 25% of cases completed received 

annually.   

The technical review will begin with the receipt of latent evidence cases. Upon receipt of 

incoming latent print case work, a minimum of 25% of those cases will be flagged for technical 

review. Footwear cases and Ten Print Examinations will be 100% technically reviewed.  

The latent print cases will be prioritized for technical review with person’s crimes given first 

priority, and property crimes second priority.  

Once a latent print case has been flagged for technical review, the case will be technically 

reviewed throughout its entire work cycle; regardless of how many times a case is reopened (for 

example, each time a case file is generated).  

If a case has been flagged for technical review, “TCR” should be clearly written on the front of 

the latent evidence envelope.  

A technical review form must be completed and maintained with the case records for each 

technical review conducted per analysis. 

Technical reviews may be conducted by individuals in the Latent Unit who possess expertise and 

specialized training in latent print and/or footwear evidence matters, and have been authorized to 

conduct technical reviews by the Director. The Technical Reviewer must also be or have been a 

case-working Examiner in the method being reviewed, and have six (6) months of independent 

casework experience in that discipline. 

 

A technical review may not be conducted by the author of the documentation under review.  

The Technical Reviewer and the latent print identification Verifier may not always be the same 

individual. 

Technical Review Process: 

Cases that are “Not Database Quality” or “No Value” for comparison: 

1) The Latent Examiner will turn the database review note sheet, latent evidence, and chain-

of-custody over to the individual assigned as the Technical Reviewer. 
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2) The Technical Reviewer will: 

a. Conduct a technical review using appropriate form. 

b. Approve the database search review in the RMS reporting system. 

c. In RMS, turn the completed case file into a PDF, and forward it to the secured 

Wake County FTP agency file folders and publish the report to the appropriate 

agency folder.  

d. The Technical Reviewer also conducts the administrative review associated with 

these types of cases, which is to be documented on the administrative front page 

cover sheet. 

e. The Technical Reviewer returns the latent evidence to the LEC room may return 

the latent evidence to the Latent Examiner if corrections are needed, or may return 

the latent evidence to the LEC room if no corrections are required.  

f. After the administrative review is completed, the The Technical Reviewer may 

publish the notification, and forward the case file the records section.  

Cases that are part of the Limited Identification Program: 

1) The Forensic Technician/Latent Examiner creates database review note sheet and case 

file, and updates the RMS reporting system.  

2) If the Forensic Technician conducted the database search in the case, the Forensic 

Technician will turn the case file over to a Latent Examiner for a limited identification 

examination. 

3) If the Latent Examiner conducted the database search in the case, the Latent Examiner 

will complete a limited identification examination.  

4) Once complete with the limited identification examination, the Latent Examiner will 

submit the case to the Technical Reviewer. 

5) The case should contain: 

a. The database review note sheet 

b. A single identification case note sheet 

c. A rough draft of the written report (on a word document) 

d. The latent evidence 

e. The chain-of-custody 

6) The Technical Reviewer will then: 

a.  Verify the latent print identifications, if applicable. (There are instances in which 

the Technical Reviewer and the Verifier are two separate individuals. In such all 

instances the verification must occur before the technical review.) 

b. Conduct the technical review using appropriate form. 

c. Approve the database search review notification in the RMS reporting system. 
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d. In RMS, the entire case report will be turned into a PDF file, and will be 

forwarded to the secured Wake County FTP agency file folders.  

If the agency does not have a folder then their case information will be e-mailed. 

A copy of the sent e-mail will be maintained in the case file.  

e. The Technical Reviewer will then return the case to the Latent Examiner. 

7) The Latent Examiner will update the final latent report into the RMS reporting system.  

8) The Latent Examiner turns the latent evidence over to the LEC and will update the chain-

of-custody accordingly.  

9) The Latent Examiner turns their case file over to the Forensic Supervisor, or another 

person authorized to conduct the administrative review.  

10) The administrative reviewer will approve the final latent report in the RMS reporting 

system, conduct the administrative review. The report will then be published. 

11) The Administrative Reviewer will forward the case files to the records section.  

 

Full case examinations, i.e. Person’s Crime examinations and Requests for Comparison 

submitted by Investigators. 

For cases in which a latent print identification/s was/were produced via database searching:  

1) The database review note sheet, the database review in the RMS reporting system, and 

the initial identification, with the appropriate case notes, are generated.  

2) The case is submitted to a Latent Examiner for verification and rapid notification. If a 

Latent Examiner is not available to accept the case, it will be signed over to the LEC and 

will wait until a Latent Examiner is available. When available, a Latent Examiner may 

sign the case over to his/her custody from the LEC room for the purpose of verifying 

identifications.   

3) After the verification is complete, the verifier will also: 

a. Approve the database search review notification in the RMS reporting system. 

b. In RMS, turn the entire case report into a PDF file, and forward it to the secured 

Wake County FTP agency file folders and publish the report to the appropriate 

agency folder. 

c. The case is then transferred to the LEC room to pend for assignment, or is 

assigned to a Latent Examiner for complete examination of the case.  

 

For both Person’s Crimes and Requests for Comparison: 

4) Once the case is assigned to a Latent Examiner, the case is analyzed and a rough draft 

report (on a word document) is produced. 

5) After the Latent Examiner completes the analysis, the case file and latent evidence is 

submitted to the Technical Reviewer for the technical review process, as well as for 
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verification. (There are instances in which the Technical Reviewer and the Verifier are 

two separate individuals. In such all instances the verification must occur before the 

technical review.)  

6) After the case is technically reviewed, the case file and latent evidence is returned to the 

original Latent Examiner.  

7) The Latent Examiner will update the final latent report into the RMS reporting system.  

8) The Latent Examiner will turn the latent evidence over to the LEC, and will update the 

chain-of-custody accordingly.  

9) The Latent Examiner turns their case file over to the Forensic Supervisor, or another 

person authorized to conduct the administrative review.  

10) The administrative reviewer will approve the latent report in the RMS reporting system, 

and complete the administrative review. The report will then be published.  

11) The Administrative Reviewer will forward the case file to the records section.  
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Chapter 14: Administrative Reviews and Publishing 

Reports/Notifications   
 

Administrative Reviews 

The administrative review is a review of the case file for consistency with laboratory policy, 

editorial correctness, and completeness. An administrative review shall be conducted on 100% of 

case files reports generated by the Latent Print Unit, using the Latent Print Unit Administrative 

Review Form. Simplified notifications (such as Database Search Reviews or Returned Unworked 

notifications) do not require administrative reviews.  

Expertise and/or specialized training in latent print and/or footwear evidence is not required of 

the individual conducting administrative reviews. Administrative reviews for the case files 

created by the Latent Print Unit staff may be conducted by the: Forensic Technician/s, Latent 

Examiners, Assistant Forensic Supervisor, Forensic Supervisor, Deputy Director of the Crime 

Laboratory, and the Quality Manager.  

Latent Print Unit case files and reports will be submitted to the Administrative Reviewer upon 

their completion.  

The administrative review for the Latent Print Unit is double-pronged. The latent report must be 

approved in the RMS system and published, and the Latent Examiner’s complete case file is 

administratively reviewed as well. upon completion of the Administrative Review.  

 

The RMS system displays the name of the person who has approved the report. The case file 

contains an administrative review case notes cover sheet, which must be checked off (when 

appropriate) and signed by the same person who approved the report in RMS.  The “date turned 

over” area on the administrative case notes cover sheet will reflect the date that the Latent 

Examiner turned their case file(s) over to the reviewer. The unique case identifier and the Latent 

Examiner/Forensic Technician’s handwritten initials must be visible on each page of the 

administrative documents. Double-sided pages are counted as two.  

 

Once both prongs of the administrative review are complete, Upon publication the case file is 

forwarded to the records section.  

 

If the report was denied, the reason for the denial must be documented in the RMS system. If 

possible, cut and paste the section of the report that requires correction in to the denial area of 

RMS, and then advise where the correction is needed.   
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See the Laboratory Administrative Procedural Manual for case file reviews, Chapter 2, “Case 

File Reviews & Verifications.”  

 

See the Report Writing Manual for the Publishing of Reports/Notifications in the RMS 

reporting system.  

    

1) The Latent Examiner updates a notification/report into the RMS reporting system. For 

notifications of database searches, the Latent Examiner may “approve” and publish their 

own notifications. Notifications are not required to be administratively reviewed.  

2) The Latent Examiner accesses the “supervisor” (button toggles between officer and 

supervisor) section of MFR in Pistol. 

a) Locate the correct case in the report queue.  

b) Click on the case number for example to open that particular report/notification.  

c) Click on the button “supp narrative 1”, and a new page will open. 

d) Click on the “supp notes” button to open the narrative and review the report. 

e) After the report/notification has been reviewed, click “exit”. 

f) Click the “approve/deny” button. 

g) To approve the report/notification, click the green “approve/exit” button.  

h) It will ask “are you sure you want to approve?” click “yes”. The screen will close and 

system goes back in the reports queue.  

i) To deny the report/notification, go to the block section of the screen, and document the 

reason for the denial.  

j) After documenting the reason for the denial, click the red “deny/exit” button. 

k) The following question will then appear: “are sure you want to deny this report?” click 

“yes”. The screen will close and will revert back in the reports queue.  

l) The report will then be sent back to the Latent Examiner with an indication that the report 

was denied and what corrections are needed.  

 

3) If the report was approved, there will be a lag-time before the report will be available in 

RMS. 

 

4) Once the report/notification is available in RMS, the following must occur to turn the entire 

case report into a PDF file.  

a) On page two, ensure that the report/notification has successfully “crossed over” from 

MFR into RMS. Click on each supplement to open it in the viewer box.   

b) If the report/notification is there, the case may be turned into a PDF file.  

c) Exit out the supplement page, and go back to the main report page. 

d) Click the “report” button, which is the top right button.  
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e) A new screen will pop up: 

 
 

Click the buttons for: “with reporting officer narrative”, “print all case 

supplements”, and “print unedited report”. Then click “export to PDF”.  

 

 

5) Another screen pops up, asking where to deliver the PDF.  
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Here, the storage location MUST be changed, from what will say “SUNGARD” to 

\\Ftp01\ccbi. This is where the secured FTP server for agency folders is located. 

Clear out SUNGARD and replace it with \\Ftp01\ccbi.   

6) Click “OK”. The PDF file is being created. Once created, it will be “dropped” in to the FTP 

server area.   

7) **Sometimes, during the PDF creation process, the system will stop mid-way through and 

will ask to include a detailed list of the evidence or property items in the report. Click “yes”. 

8) When the PDF file has been created, a pop-up will appear and will ask “would you like to 

view the PDF file now?” Click “no”. 

9) Now, you must go to the FTP server, located at \\Ftp01\ccbi - there are a couple of ways to 

do this:   

1) You can try to get there by opening “My computer” on your desktop and 

changing the top line from “my computer” to “\\Ftp01\ccbi”.  

2) Another option is to go to “your network places”, and then click on the folder 

listed under “local network” that’s labeled “ccbi on v (ftp01)”.  

 



 
 

 Page 51 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: 7/14/14        Chapter: LPTP14 
Issued By: CCBI Director       Version: 2 

 

  
 

3) It may help to open the FTP server on your computer before starting the approval 

process, to allow for easy toggling back and forth from OSSI to the FTP server 

from the bottom of the screen. 

 

10) In the FTP server, below the agency folders, the PDF file is visible. It has been highlighted 

in blue. Right click on the PDF file, highlight it, follow the drop-down box to the “rename” 

tab, and click it.  

 

 

1) The case number for the report must be changed from the CCBI case number, to the agency 

case number. The case numbers should not include any symbols (dashes) or anything but 

the numbers.  See below: 
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2) After the case number has been changed, left click on the report to highlight it, and drag and 

drop it into the appropriate agency folder.  

3) Once dropped into the folder, the report is considered published.  

4) If a report with the same case number already exists in the agency’s folder, a pop up will 

appear asking if the report should be replaced. The report should not be replaced; instead a 

letter should be added to the end of the case number. Then re-drag and drop it into the 

agency folder.  

5) If the agency does not have a folder in the secured FTP server, the reports/notifications will 

have to e-mailed. Copies of the sent e-mails of reports/notifications are to be printed and 

placed in the case file.  
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Chapter 15: Procedures for Not Completing an Examination 
 

There exist some situations in which a request made to the Latent Print Unit may not be 

completed.  

Examples of such situations are: the request was cancelled by an investigator, or the case has 

already been cleared though court.  

In such scenarios, documentation of the cancellation must be recorded. The documentation must 

consist of:  

- The individual who is advising the request may be cancelled.  

- The date the request was cancelled. 

- The analyst who is documenting the cancellation.  

The documentation may be recorded on a communication log if the cancellation is received 

verbally. If a cancellation is received via e-mail, a copy of the e-mail must be printed.    

The above-mentioned documentation must be included in the case file as part of the examination 

records. 

See the Laboratory Administrative Procedures Manual, Chapter 12, page 51, section “Returned 

Unworked Notifications (RUW)”, and page 52, section “Stop Work”, and Chapter 19, “Review 

of Requests, Tenders, & Contracts”.  
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Chapter 16: Database Searching Latent Unit Workflow for SPEX 
 

As latent print cases are received by the Crime Scene Agents, the quality of the latent print 

impressions is assessed to determine whether or not the impressions may be of value to enter for 

searching in the SPEX database system.  

The determination of database searching value is at the discretion of the Latent 

Examiner/Forensic Technician reviewing the evidence.  

Latent print evidence of value for database searching is generally entered into the SPEX database 

system prior to entry to other database systems.  

As  The comparison of onscreen images is not considered as part of the latent print examination 

process, therefore, the candidate lists will not be maintained in the examination documentation.  

Rather, the database system maintains a record of each print searched so that, if necessary, a 

latent print image can be retrieved and its searching criteria evaluated. Should Fast-Fourier 

Transform digital enhancements be utilized occur for the purpose of adjusting or enhancing a 

latent print image, this information will be documented and maintained in the case file.  

If the immediate results appear negative, depending on case type and latent image quality, the 

latent print evidence may be entered into the State and Federal databases as appropriate.  

For every screening of the latent evidence in a case, a database search review note sheet is 

completed and a database search review notification is updated in the RMS reporting system.  

The database search review notification will not indicate the results of the search. It will advise 

that a case was screened for entry into the database and specifically which, or if, latent print lift 

cards contained latent print evidence that was submitted for database search, and the date of the 

screening/search.  

Latent evidence for property crimes will be retained in the SPEX system for the purposes of 

reverse searching for approximately five (5) years from the entry date. After such time, the latent 

searches for property crimes will be purged from the system. Certain property crimes cases may 

be retained at the request of the investigating authority and as authorized by the Forensic 

Supervisor or Lead Latent Examiner.  
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Latent evidence for person’s crimes will be retained in the SPEX system indefinitely, or unless 

advised by the investigating authority that certain cases may be removed from the system.  
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Chapter 17: SPEX Searching Steps 

 

SPEX is a database system that consists of known finger and palm print cards from Wake 

County and other regional agencies. Other law enforcement agencies who utilize this same 

database system connect into the database to allow for a sharing of known print record 

information between agencies. 

TENPRINT ENTRY INTO SPEX 

This feature is utilized when a set of known standards needs to be entered into the SPEX system. 

Examples of instances in which known standard entry in SPEX is necessary include entering 

elimination prints and/or fingerprints from historical records.  

 

Choose Ten-Print/Palm Text Record Input from the TEN-PRINT/PALM CARD PROCESSING 

menu. 

 

Enter the State Identification Number for the first two fields:  

 Ten-Print Card Number 
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 Contributing agency Case No 

Enter the appropriate information for the Name fields. 

 

On saving the descriptive information related to the tenprint card being entered, a request 

for scanning is generated. This request will be found on the list of scanning requests in the 

Scanning Window. 

 

To save the data you entered in the fields, do any of the following: 

• Click . The Text Data Entry window remains open with the fields emptied. 

 

• Choose Record File>Save and Generate Next Record if it is needed to retain all 

values in the fields to be used for the next tenprint card. 

• Click the  to save and move directly to the stage of image capture (scanning). 

 

 

TENPRINT IMAGE ACQUISITION 

Initiating the Image Capture Screen 

 

 
Choose Ten-Print/Palm Scanning/ Import from the TEN-PRINT/PALM CARD PROCESSING 

menu. 

 

A window like the one shown below appears presenting a list of requests, namely, a list of 

tenprints the descriptive information for which is already entered. 
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Select the tenprint you wish to scan and specify the type of images to be captured as described 

below. 

 

Scanning Procedure 

 

The following steps outline the order of scanning: 

• Fingerprint and Palmprint Images 

Rolled fingerprints (rolls) Palmprint (if any) 

 

At the beginning of each step, a message box appears notifying you of the next step and 

containing the descriptive data of the tenprint being in process of scanning. 

Note: The tenprint remains in the scanner until the message about the next step of scanning 

appears. 

At the last step of scanning, the  button (Ctrl+G) appears on the toolbar allowing you to 

proceed to the encoding stage. Clicking on this icon closes the Image Capture Window and 

opens the Encoding one. 

Scanning Fingerprint/Palmprint Images 

To start up scanning, choose the needed request from the list and click  or press Enter. 

 

A popup window appears informing you of the type of images to scan and showing descriptive 

data on the selected tenprint. Ensure that you have selected the needed request and put the 

tenprint card into the scanner as appropriate. Click OK or press  

 

Enter to initiate the scanning operation. 
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The scanner starts scanning according to the settings defined with Scanning Mode and TPForm 

Margin capturing the images from the preset point. If enabled in the settings is the Manual mode, 

use or press the Spacebar to duly capture the image 

 

 

 
 

 

Once all images of the same type are captured, terminate scanning with or by pressing 

Enter. The scanning stops and the captured images appear in the Cropping window. 

If you wish to start the scanning procedure once again, click or press Esc. If you need to 

return to the list of requests, use or F10. 

 

Cropping Images 

 

With the scanning operation completed, the system automatically defines the location of images 

and angles of fingers axes. Frames (marquee boxes) appear upon the images outlining regions of 

interest for the AFIS. The number of scanned images and their sequence are defined in 

compliance with the blank format specified with the TPCard Format menu item. 
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Verify that the finger images are outlined with marquee boxes properly. Each frame should be 

placed so that its left, upper and right sides to be right up to the impression and its lower side on 

the flexure line of the first phalanx. The line passing top-down through the marquee center, 

called an impression axis, should be parallel to the finger axis. 

 

The marquee box marked red is active. All actions described below refer to the active frame 

only. To make the frame active, just click it or press the numeric key on the keyboard, 

corresponding to the frame number. To go on to the next frame, use Tab. 

To move the frame: 

1. Move the mouse pointer to the upper left vertex of the frame; the pointer changes to . 

2. Hold down the left mouse button and drag the frame to a new place as needed (or use the 

Arrow keys of respective directions). 

To resize the frame: 

1. Move the mouse pointer to the lower right vertex of the frame; the pointer changes to  . 

2. Hold down the left mouse button and drag the corner handle inward to decrease the size or 

outward to increase its size. You can use also the following shortcuts: Ctrl+W to drag upward, 

Ctrl+<minus> – downward, Ctrl+A –to the left, Ctrl+D – to the right. 
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To rotate the axis: 

1. Place the mouse pointer at the center of the frame; the pointer changes to  . 

2. Hold down the left mouse button and rotate the axis as appropriate. You can use also Ctrl+> 

and Ctrl+>. 

 

The above-described sequence of operations is supported automatically: the mouse pointer first 

automatically moves from the upper left to the lower right corner, then to the center and after 

that, it jumps onto the next frame. 

 

If the captured images are of poor quality, use the following tools to adjust brightness and 

contrast and to customize the image quality only for making the process of cropping easier: 

 

Adjusts the brightness and contrast of images. 

Activates the window for manual brightness-contrast adjustment 

 

Saving Images 

After completing the cropping, press the Spacebar or click  . The framed images will be 

saved. The impressions at that will be re-oriented according to the angles of axes set in the 

marquee boxes. 

With the saving completed, a message appears noting the beginning of the next scanning stage. If 

that is the last stage, the list of scanning request will be displayed. 

 

Initiating the Tenprint Encoding Screen 

Choose Ten-Print Database Input from the TENPRINT/ PALM CARD PROCESSING menu: 

 

 
 

The following screen containing the list of tenprints subject to encoding appears: 
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If the tenprint card you have just scanned is not on the list yet, update the list using  

(Ctrl+R). 

Click  or press Ctrl+W to leave on the list only those tenprints that are entered by the 

current user. The icon changes to . 

 

Procedure of Encoding 

 

1. Select the tenprint on the list. If necessary, verify that the text data are correct 

using . 

 

2. Click to view the palmprints. Ensure that the palmprints are scanned and saved 

correctly. If they are misplaced, use to swap the images. 

 

3. Double-click on the selected string or press Enter. The Encoding window appears looking like 

this: 

 



 
 

 Page 66 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: January 1, 2013       Chapter: LPTP17 
Issued By: CCBI Director       Version: 1 

 

 
 

The images of rolled fingerprints are arranged in two rows according to their numbers. 

Each fingerprint has the pattern type defined and indicated, as well as the markers of focal 

points and flexure line positioned. The coordinate axes are also set on every image. 

 

4. Click on the fingerprint number button or press the respective numerical key to maximize its 

coding window. 

 

5. Verify that the following essentials are indicated correctly: 

• Focal points 

• Reference (Coordinate) axes 

• Flexure line 

• Pattern type 

Make necessary corrections if needed. To magnify the image, click . To zoom out, click 

the same icon again. 

 

6. Go on to the next rolled fingerprint using or pressing >Tab. Repeat steps 1 to 6 to check 

the results of automatic encoding. 
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7. Save the results of encoding and send the tenprint card to the database. 

 

Rules for Coding Rolled Impressions Checking the Coding of Focal Points 

 

The focal points, namely Deltas, Cores and Z-Whorls, should be labeled with special markers: 

 

Delta        

Core         

Z-Whorl  

 

If there is a discrepancy between the number of Deltas and Cores, a message will appear noting 

the problem. 

 

If no possibility to identify the location of the lacking focal point exists, click Yes. 

Otherwise, click No and set the missing marker or delete the false one manually. 

To move the focal point marker to another place, position the mouse pointer on the marker and 

drag it to a proper place holding down the left mouse button. Release the mouse button. 

 

For the Core, assign the direction. 

To delete the focal point marker, position the mouse pointer on it and right-click. 

Checking the Flexure Line Marker 
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The marker for the flexure line looks like a yellow line with a bubble in the middle. The marker 

should coincide with the fold between the nail and the middle phalanxes. 

 

To change the location of the flexure line marker, position the mouse pointer in the 

bubble: 

 

• Drag it to an appropriate place holding down the left mouse button. 

• Rotate it as appropriate holding down the right mouse button. 

If the fingerprint image is incomplete, i.e. no flexure fold is visible, drag the marker downwards 

as much as possible. 

 

Note: The AFIS program automatically shifts the flexure line marker downwards if trying 

to be positioned above the focal points. 

 

Checking the Axes Orientation and Position 

While processing, the AFIS automatically positions the origin of coordinate axes  

 

To change the position and orientation of the axes, place the mouse pointer on the 

button and do the following: 

• While holding down the left mouse button, drag the mouse to move the axes in a needed 

place. 

• While holding down the right mouse button, drag the mouse to rotate the axes in a 

needed direction. 

 

Note: The origin of coordinates must be above the flexure line mark 

 

Specifying Pattern Types 

The AFIS is capable of identifying automatically the fingerprint pattern class, based on the 

image quality and the type and positional relationship of focal points on the fingerprint, as 

follows: 

 

• Plain Arch – no focal points available 

• Tented Arch – 1 core and 1 delta, the core being down-directed towards the delta 

• Left Loop – 1 down-directed core and 1 delta, the core being on the left of the delta 

• Right Loop – 1 down-directed core and 1 delta, the core being on the right of the delta 

• Plain Whorl – 2 cores (or 1 z-whorl) and 2 deltas 

• Accidental Whorl – 3 cores (or 1 z-whorl + 1 core) and 3 deltas 

• Unefined pattern  
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Some fingerprints have the features of different types of pattern. This being the case, it is 

permissible to assign up to three pattern types for a single fingerprint sample. 

 

The appropriate pattern types are specified by enabling the respective buttons on the bar (to 

disable, click them again) as follows: 

 

If all of the focal points are indicated accurately, the AFIS determines pattern types correctly in 

most cases.  

 

In case of scarred fingers or poor-quality images, the AFIS would fail to recognize true pattern 

types. In these cases, the operator should manually indicate appropriate pattern types.  

DATABASE VIEWER 

 

The Database Viewer Workplace 

 

The Database Viewer session starts when the user chooses SEARCH RESULTS & DATABASE 

CONTROL from the PRINTQUEST Main Menu. The Database Viewer main screen shown 

below appears. Through this screen, access to all of the application is available to the user. Look 

through this section to familiarize yourself with some of the basics. 

 

Graphical User Interface 

The desktop includes the work area consisting of two panels, menu bar, toolbar, and other tools 

you need while you work. The panels – right and left – are the area where all the action with 

database objects (tenprints and latents) takes place: displaying lists of objects, images or 

reference information on an object. 
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The title of an active panel is always highlighted. All operations are only applied to those objects 

that appear on an active panel. To switch between the panels, press Tab or click anywhere within 

the panel you wish to activate. 

 

Exiting the program saves the status of the work area, which means that all information on the 

view panels, including the current record highlight, will be automatically recovered when you 

start the program again. 

 

Working with Lists 

 

To display any list on the left panel, use options from the Left menu, and use the Right menu to 

show lists on the right panel (for a more detailed discussion of commands, see Exploring the 

Menu Bar). 

 

Actually, any list is a table the lines of which formally represent database objects – tenprints or 

latents. The type/name of a selected list can be seen in the title area. 
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Every row of the list displays information on a single object: 

• For tenprint cards: last name, initials of the first and second names and tenprint card number 

• For latent prints: latent card number and latent print number (on the latent print 

layout sheet) 

 

Initially, the Len, Score and Status data columns are empty. These data will appear after the 

index information is generated,or after the list is collated by matching score values or by 

candidate list length. In the latter case, information on indexes is generated first, and then, the list 

is sorted. 

 

Located at the bottom is a data line. The left figures indicate the total number of records on the 

list. The list length depends upon the database segments involved in the operation.  
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Clicking it will show a total number of selected records, next clicking will change it to a current 

string number. 

 

The second part of the data line presents supplemental information on the current element on the 

list: 

 

• For tenprint card record: date of birth, fist name and second name (if any) of the 

person fingerprinted 

• For latent print record: database number, date of offence 

 

On selecting multiple records, the count data field is highlighted blue, showing the total number 

of selected records: 

 

 
 

To select a record, make it current and press Insert. Use the (+) key to select all records 

available on the list, and (-) to deselect them all. 

 

The Database Viewer provides tools for list management: 

• To view and to edit alphanumeric data on objects 

• To view images (acquired at the stage of scanning) 

• To view candidate lists produced by the AFIS as determined by the matching process 

 

The application commands for managing the database objects can be accessed through the menu 

options and through the toolbar. 

  

Left-clicking on the current record equals to pressing the Enter key. But the effects are different 

for different lists: 

 

• As applied to the lists of latents, tenprint cards or selected records, it invokes the images of 

prints associated with the selected object. 

• As applied to search/match reports and hit lists, it displays an appropriate candidate list for the 

selected object. 

• As applied to candidate lists, it displays concurrently two images, a searchprint and a candidate 

determined by the AFIS as a potential mate. 

 

 Viewing Images 

 

The Database Viewer allows the user to retrieve and display any image that was captured and 

saved to the database. 

To open images for a selected list record, use any of the following ways: 
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• Choose Image>Show Image. The pulldown menu appears presenting the 

list of image types: 

 

 
 

A dimmed menu item means that the image it corresponds to is lacking for the selected database 

object. 

 

• Use preset keys that correspond to needed images. 

For tenprint cards: 

1 – Right thumb 

2 – Right index finger 

3 – Right middle finger 

4 – Right ring finger 

5 – Right little finger 

6 – Left thumb 

7 – Left index finger 

8 – Left middle finger 

9 – Left ring finger 

0 – Left little finger 

F11 – Left palm 

F12 – Right palm 

F – Full face 

G – Half face 

O – Plain impressions (slaps) 

I – SMT photos 

P – Tenprint card image 
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For latent prints: 

1 – Original image 

2 – Skeleton image 

I – Evidence photo 

P – Latent print layout sheet 

 

 Click  on the toolbar or press Enter, or left-click on a highlighted (current) list line to 

open the “default” image. Default here is an image that was open last. For example, the 

operator viewed a full-face photo and closed the image window. If he selects another object 

on the list and clicks  (or press Enter), the full-face photo associated with this object 

will appear on the screen. To display previous or next images for a selected object, use  

or respectively on the toolbar. The  and  buttons display the same-type 

image of the previous/next object on the list. 

 

The image window contains an image proper, header presenting the object’s identifier and a data 

line. 
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The image window header duplicates, in fact, the text information available in the respective list 

line. The data line at the bottom presents the information related to the image: 

 

• Pattern type 

• Image number 

• Minutiae count 

• Image quality index (for tenprint card images) 

• Sequence number of the minutia at the cursor position 

 

The image view mode allows for display of minutiae and focal points (cores, deltas and z-

whorls), the system of coordinates (axes), etc. To display this or that feature, use appropriate 

options from the Image menu: 
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As the Minutiae option is chosen, all minutiae points identified by the system appear on the 

image. The minutia at the cursor position is marked red and its number is shown in the data line. 

 

If the image is zoomed in and it doesn’t fit inside the window, scroll bars appear allowing you to 

view other areas of the image. Located in the lower right corner of the window is  the button 

wherewith you can drag the image in any direction. On clicking this icon, the mouse pointer 

changes to ‘a hand’. Place it at any place on the image and, holding down the left button, drag 

the image in desired direction. To ‘release’ the image, rightclick, or press Esc, or click again. 

 

To zoom an image, use the following tools: 

 

opens a box where you can change the scaling ratio 

resizes an image to fit the window size 

displays an image in the 1:1 scale 

magnifies an image by 20% 

zoom out an image by 20% 

 

The Database Viewer Capabilities 

 

This section presents information on basic operations you’ll need to be familiar with to use the 

Database Viewer and to work with various database objects. 

Once an object (tenprint card or latent print) has been entered, the system initiates search and 

compares the searchprint against fileprints and produces a ranked candidate list of those 

fileprints, if any, most likely to be the mate. 

 

For every newly entered latent print, the following types of candidate lists can be produced: 

• Latent- to-Latent (Fingers) 
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• Latent-to-Tenprint (Fingers) 

• Latent-to-Latent (Palms) 

• Latent-to-Tenprint (Palms) 

 

For every newly entered tenprint card, the system can produce the following types of candidate 

lists: 

• Tenprint-to-Latent (Fingers) 

• Tenprint-to-Tenprint (Fingers) 

• Tenprint-to-Latent (Palms) 

• Tenprint-to-Tenprint (Palms) 

 

Finding Objects in the Database 

 

Invoke a list of objects. To do this, choose a needed type of objects from the Left or Right menu: 

 

• Ten-Print 

• Latent Print 

• Latent Palm 

 

Newly entered objects are always at the end of the list. To reach quickly the list end, use the 

vertical scroll bar. 

 

Note. The object, which you are searching for, might not appear on the list in the 

following cases: 

 

1. It is still being processed by the system matchers. If that is the case, refresh the list using 

after some time. 

2. The segments where the desired object may be stored are not running. 

If that is the case, activate the needed segments using Left (Right) > Segments. 

 

To find objects with specific properties, choose Edit>Find: or click on the toolbar. 

 

A pulldown menu appears offering the following options: 

 

 
 

Click the needed option and type in the desired value in a box that appears. 
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The cursor selects the first object (below the current one) on the list that matches your search 

criteria. To find another object with the same specified value, use Ctrl+F3 (if you search for 

objects that fit to specific last name), Ctrl+F4 (to find by tenprint card number) and Ctrl+F2 (to 

find by file number).  

 

Sorting the List 

To collate an active list, choose Edit>Sort or click  (Ctrl+F7). 

 

A pulldown menu appears with a list of sorting criteria: 

 

 
 

The list objects will be collated according parameters you choose. 

Choose Edit>Reverse Sort Direction to reverse the order of sorting. The 

respective icons on the toolbar reflect the sort order type: 

 

Ascending sort 

Descending sort 

 

Sorting by Indices 

 

Any of the Max Score, Length of Candidate List and Image Status sorting parameters enables the 

program to automatically generate information on the respective indices (if it has not been 

generated yet). Once the sorting criterion is selected, a popup menu appears allowing to choose 

the type of objects on candidate lists (for a more detailed discussion, see Generating Information 

on Indices). 

 

Sorting by Max Score arranges the objects on the list in descending order of their maximum 

matching scores in specified candidate lists produced by the system. If you collate a list by the 
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Image Status criterion, all objects will be arranged in the following order: first come objects with 

candidates marked by the operator as potential true mates (+), then follow objects that are not 

verified yet (marked with the asterisk *), and the last coming are objects verified and having no 

mark in the Status field. Within a single group, the objects are listed in descending order of their 

matching scores. 

 

Selecting Specific Objects from the List 

 

The Database Viewer program allows you to search for and select objects that match the criteria 

you specify. To do this, choose Left (Right) > Select. A pulldown submenu appears offering the 

following options: 

 

• Quick to select tenprint cards that match a specific template 

• Ten-Print to select tenprint cards with specific properties 

• Latent Print to select latent fingerprints with specific properties 

• Latent Palm to select latent palmprints with specific properties 

 

Once you choose a needed item (except Quick), the window appears allowing you to specify 

your search criteria: 

 

 

Fill in necessary data fields with data and click  (or press Ctrl+Enter). The program 

selects and lists the objects that fit your search criteria. To cancel, click  or press F10. 
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Specifying Alphanumeric Data as Selection Criteria 

 

The window for specifying selection criteria contains the names of fields that coincide with those 

completed when entering data into the PRINTQUEST AFIS, including those that are 

automatically generated by the system. 

 

For numerical fields, there is a capability to enter a range of values: 

 

 
  

To specify a range, type in the lower value in the left box and the upper value in the right box. 

To restrict the range on either side, you may specify only one value. E.g. to select the tenprints 

that were entered into the database after January 1, 2008, type in this value into the left box of 

the Date of Database Input field: 

 

 
 

The values typed in text fields will allow the system to select from the database the objects 

having the same values in the specified fields. 

 

To complete the text fields, it is allowed to use some reserved characters or so-called wildcards: 

 

Character         Description 

?      The question mark typed indicates that there may be any character in the 

given position. 

*      The asterisk indicates that there may be any number of any characters (or 

no characters at all) in the given position. 

$      The dollar sign at the end of line indicates the end of this line. If there is 

nothing but $ in the fields specified, selected will be only those objects that have the given field 

empty.  

&     AND. 

|      OR. 

!      NOT. 

\      The backslash cancels the special designation of the above-described 

characters. 

 

Example. Suppose there are some TP cards in the database under the following numbers: 

2, 103, 21031, 103102, 103103, and 103201. Then, the results of using the 

special characters will be as follows: 
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Specified Value         Selected Numbers 

*2 2,                        103102 

1031??                     103102, 103103 

*103 103                  21031, 103102, 103103, 103201 

The field for specifying card numbers (Latent Print Number or Tenprint Card Number) as 

selection criterion can be either numerical or text. If you specify two numbers in the said field, 

they will be compared as numerals at seeking (just as when sorting). If you specify only the first 

one, the system will treat it as text, and therefore the numbers will be compared as strings. 

 

The Selection Criteria window contains the Find String in Any Field and Find Date in Any Field 

fields allowing you to find objects the alphanumeric data of which include the specified text in 

any of the fields. 

 

At the end of the list, there are two strings enabling you to describe and specify values for new 

fields you wish to use as selection criteria but they are not enumerated on the list: 

 

 
 

Assign a field name on the left and a value to select by on the right. The first string is meant for 

text, the last is for dates. 

 

Values entered as selection criteria remain in the said window at its reopening. The fields with 

specified values will be placed at the beginning of the list. To purge the fields of these values, 

choose Record File>Clear All Fields. 

 

Selecting Segments 

 

All objects of the AFIS database are arranged in segments. Tenprint cards, latent fingerprints and 

latent palmprints are stored in segments of different types. Each segment has a definite size (for 

tenprints) or is restricted to a definite number of objects stored in it (for latents). 

 

When operating with large-sized databases, it is very helpful to use the system capability for 

disabling unneeded segments. To enable or disable segments, choose Left (Right)>Segments. 

The window presenting a list of all available segments appears: 
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For every segment, the following data are indicated: database number, segment number, flags 

and path to its directory. Flags are used to distinguish functions and statuses of the segments. 

 

Flag… Designates: 

F  Segments allotted for storing tenprint records. 

L  Segments allotted for storing latent fingerprint records. 

T  Segments allotted for storing latent palmprint records. 

X  Segments allotted for temporary storage of objects. Such segments are not involved in regular      

     searches. 

I   Segments allotted for storing solved latent fingerprints and palmprints. Such segments are not 

involved  

     in regular searches. 

2. Complete segments. No new objects can be inserted in such segments. 

Е  Empty segments, i.e. containing no objects yet. 

U  Segments that are temporarily excluded from the AFIS running. 

R  Segments in which editing of objects is prohibited. By default, deletion of objects from such 

segments    

     is allowed. 

 

The enabled segments are highlighted blue and typed in green on the list and, besides, they are 

marked with + in the On field. To enable/disable a segment, set the selector on it and press the 

Insert key or right-click on it. To select all segments on the list, press the gray plus on the 

keyboard. Use the gray minus to deselect all segments. 

 

Once you choose needed segments, the program offers you to update the list of records available 

on the active view panel. 

 

Information on Indices 

 

To check if the system has found or not any candidates for newly entered objects, it is necessary 

to output information on matching scores. Choose Edit>Indexes Info. 
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A pop-up menu appears offering the following option: 

 
 

If the searchprint is a latent that needs to be identified, choose By TP Cards. If you need to find 

out if the entered tenprint card has any mates among the unsolved latents, choose By Latent 

Prints. To view the results of Tenprint-to-Tenprint searches, choose By TP Cards, and to view 

the results of Latent-to-Latent searches, choose By Latent Prints. 

 

Thus, requested information will be generated and appear in the Len, Score and Statusfields of 

the current list.  

 

 
The Status field shows the object status. ‘S’ in this field indicates that the search on this object is 

in progress and not completed yet. Update the list after a time and output the information on 

indices once again. The asterisk (*) shows the search process has been successfully completed, 

but the candidates are not verified yet. 

 

Note. Besides the above-mentioned, the Status field may contain the following characters: 

• ‘b’ for notice that the candidate list contains some objects from different database (not the 

database of the searchprint) 

• ‘B’ for notice that all objects on the candidate list are from different database (not the database 

of the searchprint) 

 

The Length field shows the number of objects available on the candidate list as determined by 

the matching process. ‘0’ in this field means that no potential mates are found. Nonzero value 

induces a maximum matching score (i.e. matching score of a top candidate) to appear in the 

Score field. 

 

Verifying Candidate Lists 

 

The following steps outline how to view candidate lists. 

 

3. Ensure that the Length field presents a nonzero value for a specified object. Open its 

candidate list by choosing it from the Comparison pulldown menu. 
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The left panel will display the newly entered object, while the right one will present a list of 

possible matches produced by the AFIS. 

 
 

For every candidate, the following information is output: 

• Text data 

• fing (palm) – Number of the finger (palm) matched with the searchprint 

• score – Matching score. By default, all candidates are listed in order of the highest to the lowest 

probability of a match. Thus, the most probable mate is on top of the list. 

• pnts – Number of minutiae matched at comparing 

• stat. – Object status: asterisk * means that the candidate image has not been viewed yet. Once 

the image is viewed, the asterisk vanishes. 

 

2. Invoke two images to be concurrently displayed. To do this, click the candidate string or press 

Enter. The searchprint is displayed on the left and the candidate print is on the right.  

 
Minutiae outlined with circles are points that are matched at searches. If you move the mouse 

pointer to any of two matching minutiae, both minutiae will be automatically highlighted red. 

 

3. Examine two images side-by-side. Use tools available on the toolbar and the Image menu 

options to display minutiae, axes and other characteristics. To zoom, rotate or equalize the 

images, use commands available through Image>Tools. 
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Note. The application commands available through the Image>Tools menu and all operations 

accessible through the toolbar are applied to an active image 

only (its header is highlighted blue). 

To align the images, click . The image in the inactive window will be zoomed and rotated 

so as to make the distance between minutiae and their relative position the same as on the active 

image. 

4. If the candidate is not a true mate (No Hit), it must be deleted with the  button (the 

removal of a specified candidate can be carried out directly when viewing it). 

 

If the candidate image is declared a true mate (Hit), choose Edit>Mark. This makes the plus (+) 

appears in the Status field of this candidate. Any object marked with (+) cannot be deleted from 

the candidate list. To cancel (+), choose again Edit>Mark. 

 

5. Enable the next candidate image available on the candidate list. To move from one image to 

another, use  and   on the toolbar. 

 

6. After all candidates are verified and false ones are deleted from the candidate list, fix the 

declared identification of the searchprint and its true mate by highlighting the candidate, 

selecting the Comparison scroll down menu-  Send to Confirmed List. 

 

The program asks to confirm this hit information: 

 
 

Choose Yes. The candidate list automatically closes, the candidate being deleted from the 

candidate list. The pair of identified objects appears on an appropriate Hit List (Confirmed List). 

 

If the latent print was identified with an existing tenprint card (as a result of verifying the Latent-

to-Tenprint (Fingers), Latent-to-Tenprint (Palms), Tenprint-to-Latent (Fingers) and Tenprint-to-

Latent (Palms) candidates lists), the latent will be inserted to the segment allotted for storing 

solved latent prints. At that, this latent will be automatically deleted from the latent list and 

thereby excluded from any further searches. 

 

If the object was not identified, i.e. no true mate was found among candidates, then such object, 

after purging its candidate list, will remain in the database to be involved in all further searches 

against newly entered tenprints and latents. 
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Note. To research a latent print to be returned for re-coding, choose Edit>Save Latent Print for 

Reindex. 

 

Manual Marking and Charting of Matching Minutiae   (OPTIONAL) 

 

This split-screen verification and charting mode allows you to indicate matching minutiae in 

manual mode. A graphic chart of matching minutiae can be produced and then printed out. These 

images with charted minutiae can be saved in the database. 

 

Note. At exiting this mode, no minutiae markers placed manually will be displayed 

on the image. 

 

To initiate the mode of manual labeling/marking of matching minutiae, click  . The toolbar 

is reshaped. 

 

Originally, displayed on the image are markers of those minutiae which were determined by the 

system as matching. To hide them, click . 

 

To mark a pair of matching minutiae not identified by the system, left-click at the appropriate 

place on either of two images. Drag the mouse cursor to another image and left-click at the 

respective place. Two circles indicating two matching points appear on the images as shown 

below. 

 

To label a pair of matching minutiae found by the system, left-click on either of two matching 

minutiae. The second minutia will be labeled automatically. Acting that way, you can assign any 

required number of matching minutiae. 
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To delete any pair of labels, place the mouse pointer on any of the two minutiae and right-click. 

The pairing marker on the other image will vanish too. 

 

Use  to display a graphic chart of matching minutiae. 

 

To save the charted images for further operation and editing, click  . Both images with 

labeled minutiae pairs and their descriptive information will be saved and can be easily accessed 

through the Solved menu. 

 

Note. It should be noted that if a latent (fingerprint or palmprint) is identified with an existing 

tenprint, this latent will be automatically relocated to the segment of solved latent prints and 

won’t be accessible through Solved menu. If necessary to further retain charted images, they 

should be charted after they are declared mates and saved as a hit. The said mode can be also 

accessed in the hit list view mode. Hit lists can be invoked through the Confirmed menu options. 

 

 

 

Printing Out Database Object Images 
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The Database Viewer program allows printing of screen shots, tenprint cards or pairs of charted 

images. To specify a printing form and to change printing settings, use appropriate commands of 

the Print menu. 

 

To start with, invoke the Printer Settings window by choosing Print>Options. 

 

Select the printer type from a picklist attached to the Printer field. To view your document before 

its printing, specify Yes in the Preview field. 

 

 
 

To change other settings (print resolution, page format, number of copies, etc.), click on the Print 

Settings button. This brings up a window described in detail in Printing AFIS 

Reports in the General-purpose Operations section. 

Click on Save as defaults to save the printing parameters you have just changed. 

From the Print menu, choose the type of object you wish to print out: 

• Screen 

• Ten-Print Card (the program offers a choice of tenprint card forms) 

• Matched Images (active when two images are produced on-screen) 

To generate a hard copy of the specified object, choose Print>Print or click  . 

 

 

Operations with Search Reports 

 

Search report is a list of objects (latent prints or tenprint cards) which have potential mates in 

the database as determined by the matching process. For example, the Latent-to-Tenprint search 

report is a list of latent prints, each having a candidate list of tenprints selected by the AFIS as 

possible mates. Those latents that have no potential mates among tenprints in the database will 

not fall into the Latent-to-Tenprint search report. 

 

Search reports look like any other list of database objects. The only difference is that pressing the 

Enter key or clicking on any list item will open a candidate list for a selected subject. 

 

If too many candidate lists have been amassed in the system and not verified yet, the most 

convenient way to process them is to verify and purge search reports produced by the AFIS. 
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To do this, choose Left (Right)>Candidate List. The pulldown menu appears listing all available 

search reports. The same option is accessible through the Candidate menu. 

To operate with any search report, follow the steps described below: 

 

1. Choose a needed search report from the list available through the Candidate menu. 

 

4. Select the first record on the list of search inquiries that appears. 

 

 

5. Press Enter (or click the selected record). This brings up a candidate list referred to that 

selected inquiry. 

 

4.  Carry out all necessary operations with candidates (to declare a Hit or No Hit, i.e. to make 

identification or removal).  

 

5.  Refresh the search report. The search inquiry you have just verified will automatically vanish 

from the report. 

 

6.  Repeat steps 2 to 5 for every next record available on the selected search report until it 

becomes empty. 

 

Choose another type of search reports and carry out all the above-stated operations to verify and 

to empty it. 

 

Exploring the Menu Options 

 

Left/Right Submenus 
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The application commands available through these submenus are used to operate with any list 

displayed on the left and right panels respectively. 

 

• Ten-Print displays a total list of tenprint cards available in the database. 

 

• Latent Print displays a total list of latent fingerprints stored in the database. 

 

• Latent Palm displays a total list of latent palmprints stored in the database. 

 

• Ten-Print duplicate opens a list of tenprints having clones in the database. Select a needed 

tenprint and press Enter to view a list of its duplicates. 

 

• Select is used to find objects that match some selection criteria. 

 

• Candidate list displays a list of objects that have potential mates in the database as determined 

by the matching. 

 

• Confirmed list is used to access lists of identifications (Hit Lists). 

 

• Solved list is used to access lists of image pairs with graphic charts of matching minutiae. 

 

• Refresh List updates an on-screen active list. 

 

• Resent recovers any list that has been formerly enabled during the current session of the 

program. 

 

• Segments is used to select needed segments from the database. 

 

• Close closes the active list (left or right). 

 

Candidate Submenu 

 

 
 



 
 

 Page 91 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: January 1, 2013       Chapter: LPTP17 
Issued By: CCBI Director       Version: 1 

 
The options available through the Candidate submenu can be also accessed through Left 

(Right)>Candidate List. Use this submenu to display search reports of any type. 

 

Comparison Submenu 

 

 
 

The Comparison submenu allows you to view any list of candidates/respondents produced by the 

AFIS for the selected object and to explore all candidate lists wherein the given object gets 

included. 

 

• Latent to Latent opens a candidate list of latent prints selected by the AFIS as potential mates 

for a particular latent fingerprint. 

 

• Latent to Ten-Print Card opens a candidate list of tenprints selected by the AFIS as potential 

mates for a particular latent fingerprint. 

 

• Ten-Print Card to Latent opens a candidate list of latent fingerprints selected by the AFIS as 

potential mates for a particular tenprint. 

 

• Ten-Print Card to Ten-Print Card opens a candidate list of tenprints selected by the AFIS as 

potential mates for a particular tenprint. 

 

• Chain of Duplicates opens a list of duplicates for a particular tenprint. 

 

• Latent Palm to Latent Palm opens a candidate list of latent prints selected by the AFIS as 

potential mates for a particular latent palmprint. 

 

• Latent Palm to Palm Card opens a candidate list of tenprints selected by the AFIS as potential 

mates for a particular latent palmprint. 
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• Palm Card to Latent Palm opens a candidate list of latent palmprints selected by the AFIS as 

potential mates for palmprints available on a particular tenprint. 

 

• Palm Card to Palm Card opens a candidate list of tenprints selected by the AFIS as potential 

mates for palmprints available on a particular tenprint. 

 

• Cards hits on this Latent displays a list of tenprints which have the selected latent 

fingerprint on their candidate lists. 

 

• Latent hits on this Card displays a list of latent fingerprints which have the selected tenprint 

card on their candidate lists. 

 

• Card hits on this Latent Palm displays a list of tenprints which have the selected latent 

palmprint on their candidate lists. 

 

• Latent Palm hits on this Card displays a list of latent palmprints which have the selected 

tenprint on their candidate lists. 

 

• Send to Confirmed List is used to docket two fingerprints/palmprints after they have been 

declared mates by inserting them to a list of identifications (Hit List). The same command can be 

also accessed through  on the toolbar of the candidate list window. 

 

Confirmed Submenu 

 

 
 

The options available through the Confirmed submenu can be also accessed through Left 

(Right)>Confirmed List. Use this submenu to display a list of identified objects. 

 

The said submenu offers also some options that become active when viewing a pair of images: 

 

• Minutiae Marking enabling a manual mode of labeling and charting matching minutiae pairs. 
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• Send to Solved List used to save a pair of images with labeled and charted matching minutiae. 

 

Solved Submenu 

 

 
 

The options available through the Solved submenu can be also accessed through Left 

(Right)>Solved List. Use this submenu to display a list of matching images with manually 

labeled minutiae pairs. 

 

Edit Submenu 

 

Presented below is a brief description of each menu option: 

 

 
 

Edit Demographic Data lets you edit alphanumeric descriptive data associated with ten-print 

cards or latents. After changes are made, the list should be refreshed. 

 

• Show Demographic Data shows descriptive data on a selected tenprint or latent print. 

 



 
 

 Page 94 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: January 1, 2013       Chapter: LPTP17 
Issued By: CCBI Director       Version: 1 

 
• Close Demographic Data exits the alphanumeric descriptive data window. 

 

• Save image as is used to save a current image in a file of TIFF, JPEG or BMP format. If the on-

screen print image has a minutiae plot displayed, the last one will be also saved. 

 

• Save Tenprint as Tiff is used to save each fingerprint available on a selected tenprint card in a 

separate TIFF file. 

 

• Save Ten-Print for Re-index makes a copy of a selected tenprint card and sends it for re-

encoding. 

 

• Save Latent Print for Re-index makes a copy of a selected latent print and sends it for re-

encoding. 

 

• Export enables export of selected objects to another database. Choosing this menu item brings 

up a list of databases-recipients. 

 

• Delete record from database purges a current object or a group of selected objects from the 

database. This command can be also accessed through the  toolbar button. 

 

• Find… searches for objects with specific properties. This command can be also accessed 

through the toolbar button. 

 

• Sort is used to collate a current list according to various sorting criteria.  This command can be 

also accessed through the toolbar button. 

 

• Reverse Sort Direction reverses the sort order. 

 

• Mark is used to preliminarily sign a candidate as a true mate. This initial identification needs 

reexamination to determine and ensure that it was correct. The candidate marked as such cannot 

be deleted from the database. To cancel this marking, deselect the same menu item. 

 

• Link is used to forcedly bind two tenprint cards in a group of duplicates. 

 

• Delete Candidate is used to remove erroneous idents from candidate lists. This command 

can be also accessed through the  button available on the candidate list toolbar. 
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• Resubmit search for selection initiates a repeated search for potential matches with a current 

object or a group of objects. 

 

• Indexes info generates information on matching scores and statuses for a current list of objects. 

 

• Write list to file allows you to save to file either demographic data of a current object/selected 

objects or a list displayed on an active panel. Information on indices if already generated will be 

also saved. 

 

• Mouse Pointer provides tools for changing color and size of the mouse cursor. 

 

Image Submenu 

 

This submenu provides options to be used when working with images: 

 

 
 

Show image displays a list of all available images for a selected object. 

 

• Tools gives you access to all operations that can be applied to an active image: 

 

o Zoom enables the Zoom box with some options for image scaling. This command can 

be also accessed through  . 

 

o Rotation enables the Rotation box with some options for image rotation. This 

command can be also accessed through  . 

 

 

o Brightness/contrast enables the Brightness/Contrast box with some options for 

adjusting the imagery. This command can be also accessed through  . 
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o Target area turns on/off the display of tolerances for position and orientation of the 

coordinate system on latent print images. 

 

 

o Equalize enables image equalization. To cancel, press Ctrl+Q. 

 

 

o Auto brightness enables automatic adjustment of brightness/contrast. This command 

can be also accessed through . 

 

 

o Fit in window zooms images to the panel size. This command can be also accessed 

through . 

 

 

o Image scale 1:1 sets the image scale as 1:1, i.e. zoom to the size it was based. This 

command can be also accessed through . 

 

 

o Position harmonizes two images, i.e. it arranges the inactive image so that the 

distance between its reference points and their mutual orientation is the same as it is 

on the active image. This command can be also accessed through on the 

candidate list toolbar. 

 

 

 Image info displays information on a selected image. 

 

 Minutiae shows/hides the minutiae plot. When viewing images of candidates, this option, 

being replicated by on the toolbar, enables/disables the display of unmatched minutiae. 
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 Reference center shows/hides the coordinate system and tolerances. The  button 

appears on candidate list screen. 

 

 

 Core/delta shows/hides the core and delta markers (  ). 

 

 

  Discarded area shows/hides the unusable area mask (  ). 

 

 

 Links shows/hides lines of ridge counts for a specified minutia. Positioning the mouse cursor 

on the minutia brings up green lines for ridge counts and yellow lines for ridgewise relations. 

This option is unavailable if the minutiae markers are disabled. 

 

 

 Flows shows/hides a ridge flow plot. Ridge flows are presented in the form of short segments 

aligned along friction ridges. 

 

 Show/hide image enables /disables the image (  ). 

 

 Settings gives access to operations relevant to image setup: 

 

o Auto positioning turns on/off automatic scaling and rotation of images when viewing 

candidate lists. 

 

o Auto-equalize enables automatic equalization of images. 

 

 

o Background images enables the system to load the next image in background mode 

when you view candidate lists. This option is very helpful when low-speed data 

transfer channels (e.g. wire telephone lines) are used. 
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o Background palms is an application command similar to Background images but 

applied to palmprint images. 

 

o Display Minutiae Matching Line couples together two matching minutiae on the 

search and file prints using a line segment. 

 

o Show Candidate Images enables the mode of automatic display of image pairs when 

opening a candidate list. 

 

o Thick tag lines changes the thickness of charting lines in manual mode of labeling 

and charting minutiae (when activated, the lines are thick, when disabled, the lines are 

thin). 

 

 

o Tag lines color opens a box for changing the color of charting lines used in manual 

mode of labeling and charting minutiae. 

 

 

 

Print Submenu 

 
 

The Print menu provides options for assigning printing parameters and information type to be 

printed out: 

 

• Options brings up the Printer Settings window. 

 

• Clear Print Queue purges tasks from the print queue. 

 

• Screen is used for printing out screen shots. 

 

• Ten-Print Card is used for printing out tenprint cards. 
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• Matched images is used for printing out a pair of matching images. 

 

• Print invokes printing. 

 

Tools Reference 

 

The tool kits of the Database Viewer vary enabling you to access commands that are relevant to 

the active list or the operation you’re currently performing. 

 

Main Toolbar 

 
 

Tool   Description 

Refreshes the list. 

Displays alphanumeric data associated with a tenprint or latent selected. 

Allows the user to edit alphanumeric data. 

Collates an active list. 

Used to find a needed record on the list. 

Deletes a record from the database. 

Initiates printing. 

Displays the previous image. 

Displays the next image. 

Displays the image of current list element. 

Displays the image of previous object. 

Displays the image of next object. 

Opens a dialog box for adjusting brightness-contrast of an active image. 
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Initiates automatic adjustment of brightness-contrast values. 

Changes the angle of image rotation. 

Used to adjust the image scale. 

Zooms an image to the view panel size. 

Displays an image at 100%, 1:1(as it is stored in the database) 

Zooms in by 20%. 

Zooms out by 20%. 

Exits the application. 

 

 

Candidate List Toolbar 

 

 
 

The following table provides a brief description of those icons that appear on the candidate list 

screen in addition to the above-described. 

 

Tool     Description 

 

Initiates manual mode for labeling and charting matching minutiae pairs. 

Used to delete erroneous idents from the candidate list. 

Marks the searchprint and candidate images as true mates. 

Harmonizes two images, i.e. it arranges the inactive image so that the distance between its 

reference points and their mutual orientation is the same as it is on the active image. 

Shows/hides a fingerprint/palmprint image. When disabled, only minutiae plot remains on 

the screen. 
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Shows/hides the unmatched minutiae markers. 

Shows/hides the focal point markers. 

Shows/hides the coordinate system and tolerances. 

Shows/hides the unusable area mask. 

Shows/hides the markers of all characteristics. 

 

 

Toolbar for Manual Marking of Minutiae 

 

 
 

The following table provides a brief description of those icons that appear on the toolbar 

alongside with the above-described. 

 

Tool    Description 

 

Exits the mode of manual labeling and charting of matching minutiae. 

Turns on/off the display of matching minutiae pairs. 

Shows/hides the charting lines for labeling minutiae. 

Saves the pair of images with labeled and charted matching minutiae. 

 

 

Printing Out Database Object Images 

 

The AFIS facilities enable the printout of both images and descriptive alphanumeric information 

relating to tenprints and latents stored in the AFIS database as well as latent print data directly 

from the encoding application before they are dispatched to the database.  
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The printing operation is initiated through the relevant menu option or the toolbar (the 

button). The preview window appears to give you a visual representation of the pages that 

will be printed out. If it is a multipage document, any page can be displayed for viewing. 

 

The table below details the tools available on the Printing window toolbar. 

              

Hotkey 

 

Home 

Display the first page.  

End 

Display the last page.           

PgUp 

Display the previous page.         

PgDn 

Display the next page.           

Ctrl+S 

Change the printout settings.          

Ctrl+P 
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Launch the printing process (to record a postscript or a graphic file).  

Ctrl+F  

Turn on/off the filtering mode that allows for the change of image quality in the preview 

window. The enabled filtering process slows down the operation in the preview window.   

Esc 

Cancel the printing operation and exit.         

 

Changing the Printout Settings 

Clicking the  button brings up the following window: 

 

 
 

The document displayed in the preview window can be printed out using a printer, or saved to a 

file of .ps (postscript) format or saved as an image of .jpg format.  

To generate a hard copy, choose Printer from the list in the Print field. Specify the printer type 

in the Printer field, if several printers are attached to your computer. Set the print resolution 

value in the Resolution field. 

 

To print the document to a postscript-file or to a jpg-file, specify File or Image respectively 

in the Print field. Then, in the Output Directory field, specify a path to the directory where to 

save the file. 

 

The following options are also accessible for print setup: 
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• Page format – Used to change the page format. The picklist available offers the following 

values: A4, Letter (216x296) and New for specifying arbitrary values of the page width and 

height. 

 

• Landscape – Should be enabled to print the document in Landscape mode. 

 

• Sheets – Used to specify sheets to be printed. To print out particular sheets, disable the All 

check box and then, in the Sheets numerical box, specify the numbers of the first and the last 

sheet you wish to print. 

 

• All – Indicates that all pages will be printed. 

 

• Copies – Used to indicate the number of copies to be printed. 

 

• Duplex Printing – Used to initiate the dual-page printing, if your printer is capable of this 

function. 

 

• Print backside –Used to print out both sides, face and back, of a tenprint card. 

 

• Print Blank – When activated, text and image data will be printed on a standard card of the 

AFIS format. When not activated, the data will be printed on a clean sheet though in their 

predefined arrangement. 

 

• Color print – Used to print out a color image or save it in file. 

 

• Use filter – Turns on the program filter enhancing the print quality. 

 

• Use rastr – When activated, the image points are printed out according to an ad hoc algorithm 

(diffusion). If not, the image is filled up with points in a standard way. As a result, the images 

printed with these two techniques differ in fine details. 

 

Once you change the print settings, you can act in one of three ways: 

 

• Click Print to dispatch your document for printing. 

 

• Click OK to apply the settings you changed and to exit the print setup window. Your document 

appears in the preview window having been changed according to the adjusted settings. 

 

• Click Cancel to exit the print setup window and not to apply any change to the document. 

 

LATENT PRINT ENTRY  
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Upon the receipt of latent print evidence, the Forensic Technician or Latent Examiner will screen 

the evidence and determine whether or not there are impressions of searchable value. When 

latent print evidence is of value for SPEX database searching, the following searching steps will 

apply.  

 

 

Initiating the Text Data Entry Screen 

Choose Latent Text Record Input from the LATENT PROCESSING menu: 

 
 

The following screen appears: 

 
 

Completing the Fields 

 

Enter information related to the case into the fields 
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 Case Number (##-####-#-XX) 

o 2 digit year-CCBI last 4 or 5 digits of case #- Crime type Index- Examiners 

Initials 

 (Example:  12-1234-6-TL  or  12-12345-6-TL)  

 (If only a 3 digit case number, precede case number with 0) 

o Crime Index Is as follows: 

 1- Homicide 

 2- Robbery (any type) 

 3- Assualt (Including battery) 

 4- Rape/Sexual Assault 

 5- Kidnapping/ CarJacking 

 6- Burglary 

 7- LFA/RMV 

 8- Drug/Weapons Violations 

 9- Other Death Investigations 

 0- Other category (to include DTP, Hit and Run, Larceny, Found 

Property, Fraud, Threats, and Request for Service) 

 

 Contributor Case Ident. No  {Victim’s name  (Last, First)} 

Optional field entry:  Note:  (any pertinent data such as envelope number) 

 

Prioritizing Latent Inquiries 

Use   or F6 to assign a highest priority for the latent print to be urgently entered into the 

AFIS. The `urgent’ prints will be processed and inserted into the database sooner than the others 

having no priority (Normal Inquiries). The searches for `urgent’ latent prints will be also highly 

prioritized. 

 

Saving Requests 

On saving the descriptive information related to the latent print card being entered, a request for 

scanning is automatically generated. This request can be found on the list of scanning requests 

available at the stage of image acquisition. 

 

 

To save the data you entered in the fields, do any of the following: 

• Click  or Ctrl + Enter. The Text Data Entry window remains open with the fields 

emptied. 

• Choose Record File>Save and Generate Next Record if it is needed to retain all values in the 

fields to be used for the next latent print card. 



 
 

 Page 107 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: January 1, 2013       Chapter: LPTP17 
Issued By: CCBI Director       Version: 1 

 

• Click or F2 to save and move directly to the stage of image capture (scanning). 

 

 

LATENT PRINT IMAGE ACQUISITION 

 

Choose Latent Scanning/Acquisition/Import from the LATENT PROCESSING menu: 

 
 

A window like the one shown below appears presenting a list of requests, namely, a list of 

latent print cards the descriptive information for which is already entered. 

 

 
 

Scanning Procedure 

The following steps outline the order of scanning: 

 

6. Scan the latent print lifts onto which latent print images are affixed (up to 100 images). 

 

7. Scan a single latent print from the latent print lifts. 

 

8. Steps 2 must be repeated until every latent print, of value for database searching, on the latent 

lifts are scanned  

 

Switching to the next step is automatic. 
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At the beginning of each step, a message box appears notifying you of the next step and 

containing the text data on the latent print card being in process of scanning. 

 

Image Capture Options 

 

To specify image types to be captured (latent fingerprint or latent palmprint) and sources of 

image data, use the appropriate items from the Options menu. 

 

Choosing Image Type 

Each forensic specimen subject to scanning must be assigned an image type: latent fingerprint 

or latent palmprint. 

 

Define the type of the first impression on the latent print layout sheet and enable the appropriate 

icon on the toolbar:  . The type of the latent print can be changed during 

the capture process. 

 

 

Scanning Latent Print Cards 

To start up scanning, choose the needed request from the list and click  or press Enter. 

A popup window appears informing you of the scanning step and showing descriptive data on 

the selected latent print card. Ensure that you have selected the needed request. If a flatbed 

scanner is specified and used as a source of images, put the latent print card into the scanner as 

appropriate. Click OK or press Enter to initiate the scanning operation. 

 

Prescanning Latents 

The scanning operation is comprised of two steps: prescanning and main scanning. During 

prescanning, the user must outline a usable area of the latent print by setting a frame, set the axes 

of coordinates, establish tolerances and adjust the image brightness/contrast. 

When a flatbed scanner is used for capture, click or press Enter when the needed image 

appears on the screen. This automatically brings up the Cropping window. 
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If you wish to start the scanning operation once again, click  or press Esc. The program 

allows you to change the source of images. 

If you need to return to the list of requests, use or F10. 

 

Cropping Images 

 

Once the prescanning is completed, a rectangular frame (marquee box) appears upon the image 

captured. This frame is used to outline a region of interest for the AFIS, in other words, to crop 

the latent print image cutting away unwanted areas. 

 

To outline the usable image, place and adjust the marquee box so that to meet the following 

requirements: 

• The entire pattern visible on the screen, including legible and illegible areas referring to 

the given latent, should be inside the frame. 

• Leave 5-10% space between the edge of legible pattern and the frame. It is conditioned 

by restrictions in use of encoding tools when applied close to the margins. 

• The center of the pattern area, though invisible, should be within the marquee box. It is 

required by the rule of positioning the origin of coordinates. 

 

To control image magnification in the window of scanning, use ,  and  

. 
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To move the frame: 

 
 

9. Place the mouse pointer at the upper left corner of the rectangular frame; the pointer changes 

to  . 

 

10. Hold down the left mouse button and drag the frame to a new place as needed (or use the 

Arrow keys of respective directions). 

 

 

To resize the frame: 

 

11. Move the mouse pointer to the lower right corner of the frame; the pointer changes to  . 

 

12. Hold down the left mouse button and drag the corner handle inward to decrease the size or 

outward to increase its size. You can use also the following shortcuts: Ctrl+W to drag 

upward, Ctrl+<minus> – downward, Ctrl+A – to the left, Ctrl+D – to the right. 

 

 

To rotate the axis: 
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13. Place the mouse pointer at the center of the frame; the pointer changes to . 

 

14. Hold down the left mouse button and rotate the axis as appropriate. You can use Ctrl+> and 

Ctrl+> also. Direct the axis along the assumed finger axis towards the fingertip. The 

resultant image will be later re-orientated according to the axis you set. 

 

The above-described sequence of operations is supported automatically: the mouse pointer first 

automatically moves from the upper left to the lower right corner and then to the center. 

 

 

Setting the Coordinate System 

 

The Scanning application allows for setting the axes of coordinates (a frame of reference), 

assigning tolerances for position of the origin and for orientation of the axes. To enable the mode 

for manipulation with the axes and tolerances, click on the toolbar or press Insert. A blue 

circle (to specify the tolerance value for the origin position) and a sector (to specify the tolerance 

value for the axes orientation) appear on the image. The pointer changes to and automatically 

shifts to the upper left vertex of the frame. 

 

Note: The mode of positioning and orientating the axes enables you also to adjust the size 

of the frame outlining the image. Therefore, you may carry out both actions in the same 

mode. 

 

To position the origin of coordinates 

 
 

15. Place the mouse pointer in the center of the marquee box. The pointer changes to  . 

 

16. While holding down the left mouse button, drag the mouse. The origin will move in the same 

direction as the mouse movement. Alternative methods for positioning the origin include 

the following key combinations: Ctrl+I – upwards, Ctrl+K – downwards, Ctrl+J – to the left. 

Set the origin at the center, visible or assumed, of the fingerprint pattern. 

 

To rotate the vertical axis, drag the mouse while holding down 
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the right mouse button, or use the PageUp key (to rotate counterclockwise) 

or PageDown (to rotate clockwise). 

 

 

To change the tolerances for the origin position 

 
 

17. Move the mouse pointer to the lower left vertex of the marquee box. The pointer changes to 

 . 

 

18. While holding down the left mouse button, drag the mouse. Resize the circle so that all 

possible positions of the origin are enclosed within it. You can use alternatively Ctrl+O to 

downsize the circle, or Ctrl+P to enlarge it. 

 

To change the tolerances for the axis orientation 

19. Move the mouse pointer to the lower left vertex of the marquee box. The pointer changes to 

. 

 

20. While holding down the right mouse button, drag the mouse. Resize the sector so that all 

possible directions of the vertical axis are enclosed within it. Alternatively, use the Home 

and 

End keys. 

 

In this mode, the pointer automatically changes according in the following succession: 

 =>  =>  => . 

 

Adjusting Brightness-Contrast 

 

If the captured images are of poor quality, use the following tools to adjust brightness and 

contrast: 

 Adjusts brightness and contrast automatically (recommended for legible latent prints 

that are normally contrasting and medium-dense). 

Activates the window for manual brightness-contrast adjustment. 
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Used for black level correction of dark faint images. 

Used for gray level correction of gray faint images. 

Used for white level correction of white faint images. 

 

To adjust the brightness and contrast of a latent print image manually, use  (F11).  

 

The Brightness-Contrast regulator box appears: 

 

 
 

To change the brightness-contrast values, drag the dagger in the regulator box using the mouse, 

arrow keys or sliders (vertical and horizontal). The horizontal movement of the dagger changes 

the image brightness, and the vertical one changes contrast. 

 

Use to invert the image and  (Spacebar) to save the customized values. 

 

Scaling the Latent Print Image (photos) 

 

The program provides the operator with some tools to specify the scale of the latent print image: 

• measuring segment that should be set on images that contain a photo evidence ruler 

 

• scaling bar that should be set pointing the friction ridges on images containing no photo 

evidence ruler 
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• button  that be used for latent print images snapped at their actual size 

The measuring segment is displayed blue. To scale the image using the measuring segment, do 

the following: 

 

21. Move the mouse cursor to the point on the photo evidence ruler from which to measure the 

segment, and left-click. The segment will shift to the indicated point while the mouse pointer 

will shift to the other end of the segment. 

 

 
 

22. Move the mouse cursor to the point on the photo evidence ruler, where the measuring 

segment will end, and left-click again. 

 

23. Click on the toolbar (or press Ctrl+S) to invoke the Scale Settings box, and specify therein 

the units of measurement and the length of the measuring segment.  

 

 
 

 

If no photo evidence ruler available on the latent print image, use the scaling bar to define the 

image scale. To do this, click . The measuring segment changes to a scaling bar. 

 

24. Find on the image an area with the average density of friction ridges. 

 

25. Place the mouse pointer onto one of the ridge lines and left-click. The bar will shift to the 

indicated point while the mouse pointer will shift to the other end of the bar. 
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26. Set the bar across the ridge flow so that every point is on an appropriate ridge line as shown 

below, and left-click again. 

 

 
 

To make the ridge pattern more legible, enhance the image using the tool  (Ctrl+E). 

 

Saving the Latent Print Image 

 

Before you save the latent print image, verify that the image type – latent fingerprint or latent 

palmprint – is indicated correctly, and that the latent is numbered properly. The type and the 

number of the latent are shown in the header. 

 

To change the type, enable an appropriate icon on the toolbar:  . 

 

When scanning the latents successively, the program automatically numbers them according to 

the sequence of their scanning. If any of the latent prints is rescanned, the numeration is violated. 

 

To save the latent print image, click   or press the Spacebar. 

 

Once the latent print image is saved, the system prompts you to scan evidence photo provided 

that the icon  is enabled on the toolbar. Otherwise, the window for cropping the next latent 

image appears. 

If you need to proceed to encoding, click on the toolbar. The Image Capture window 

closes and the Encoding window opens displaying the captured latent print image. At that, the 

latent card remains on the list of scanning requests. 

 

Export of Latent Prints 
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If it is needed to export the captured latent print images to other AFISs, it is required to specify 

the names of recipients and the format of the files subject to transmitting. To do this, click 

or press F11. This brings up the window like shown below: 

 

 
 

Select a needed database on the list of possible recipients and right-click (or press the Insert 

key). 

To specify the format of files used by the accepting AFIS, enable the appropriate check box: 

 

• SPEX native 

• FBI format 

• Interpol 

 

The last two are the ANSI/NIST standard formats. 

 

If the export parameters herein specified differ from the default ones, the Export Properties 

window will appear each time you scan a new latent print. Verify that the export parameters are 

correct and click OK. With the scanning completed, the latent print will be forwarded to a 

database specified. 

 

If Native DB is not selected or the SPEX native format is not specified, the captured latent print 

will not appear in the Encoding window. To make the latent remain in your database, include the 

Native DB into the list of recipients and enable the respective format check box. 

 

LATENT PRINT DATA ENCODING 
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Initiating the Latent Print Encoding Screen 

Choose Latent Patterns & Minutiae Extraction from the LATENT PROCESSING menu: 

 

 
 

The following screen appears containing the list of latent print records subject to encoding: 

 

 

If the latent print image you have just scanned is not on the list yet, update the list using  

(Ctrl+R). 

 

Select a needed record on the list and press Enter (or double-click). This brings up the window 

like this: 
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The encoding window might open automatically at launching the Encoding application. This 

happens when the last executed operation of encoding was not duly completed, and the program 

was exited directly from the Encoding window. 

 

The Encoding window opens automatically also when the latent is entered into the AFIS step by 

step: 

after completing the scanning operation, the  button was clicked to proceed to encoding. 

To return to the list of encoding request, click  (or press F5). To exit the Encoding 

application, use  (F10). 

 

Encoding Procedure 

 

Latent print images that the operator usually deals with differ in quality of distinguishable 

pattern. In the general case, the encoding procedure includes the following steps: 

 

1. Specify a pattern type (for finger impressions only). 

 

27. Specify a finger mask and the maximum number of candidates to be included on the 

candidate list (candidate list length), if necessary (default is usually set at 20). 
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28. Mark focal points, assign the system of coordinates and tolerance zones. 

 

4. Outline identifiable area of the print pattern. 

 

5. Launch the filtering operation (automatic process). 

 

6. Verify that the skeleton image is derived correctly. Amend it if necessary. 

 

7. Verify that the minutiae points are indicated correctly (available in the mode of skeleton 

editing). 

 

8. Send the encoded latent print image to the database. 

 

The above-stated sequence of operations may be violated if the latent print is of a very poor 

quality. The program allows for the manual drawing of a skeleton. If that is the case, steps 4 and 

5 can be skipped. 

 

To access the encoding operations, use the following icons of the toolbar, arranged in their 

execution sequence: 

 

 
 

A highlighted icon means that the operation it corresponds to is executed. 

 

Clicking the icon invokes the respective step. Each step has a toolbar enabling you to access 

commands that are relevant to the operation you’re currently performing. To save the results of 

your actions, click  (F2). When exiting the application at any step but before all the steps 

of encoding are completed, the results of the actions that you’ve already carried out are saved. 

 

Data can be corrected at any step while the encoding is in progress (i.e. before you send the 

latent print to the database). 

 

The encoding steps can be also accessed through the Latent Image menu: 
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Those steps that are executed will be ticked. 

 

Specifying Pattern Types 

 

Note: No pattern type is to be assigned for latent palmprints. 

 

To assign a pattern type to the latent fingerprint, click  The icons representing all types of 

the accepted classification appear: 

 

 
 

Specify those types that might be inherent to the pattern under investigation. It is permissible to 

assign up to 4 pattern types for one latent print specimen. If it is impossible to identify the 

pattern type, or the latent bears characteristics of more than 4 pattern types, it is recommended to 

assign Undefined Pattern, which is a defaulted value that the system automatically assigns to 

every incoming latent print image. 

 

Specifying Search Parameters 

If needed to limit the number of candidates to be included on the Latent-to-Latent candidate 

list, or being fully aware which finger or which palm left the latent print, you can 

change the preset search parameters. To do this, click . 

 

To change the candidate list length, use a slidebar that appears over the image: 
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The default limitation preset in the system is 20 candidates. That means that the AFIS will put on 

the list no more 20 candidates with the highest matching scores from all selected. If necessary, 

specify another value. 

 

Use also the Search Mask Setup box to specify search criteria: 

 

 
 

The icons with digits 1-10 correspond to fingers, the icons with R and L designation – to the 

right and the left palms respectively. The highlighted icon means that the object it corresponds to 

will be involved in the matching process. 

 

Marking Focal Points and Setting the Coordinate System 

To assign focal points available on the latent print image and to set the axes of coordinates 

system and tolerance zones, click . 

 

One should mark only those focal points – Cores, Deltas and Z-Whorls – that are really visible 

on the image. 

 

To assign focal points, do any of the following: 

• Place the mouse pointer within the area of the focal point you wish to mark and press on the 

keyboard one of the following keys: 

 

D for Delta 

C for Core 

W for Z-whorl 

 

• Select the appropriate icon on the toolbar from the following: 

for Delta 

for Core 

for Z-whorl 
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and place the mouse pointer in the area of the focal point and left-click. 

 

As you assign the Core focal point, a line appears behind the cursor. Drag the mouse in the 

direction of the ridge flow to indicate the direction of the Core and left-click. 

 

If the focal point marker is set inexactly, you may change its position by dragging it to a new 

place holding down the left mouse button. 

 

To delete a marker erroneously set, click it with the right mouse button. 

 

To set the axes and tolerances, use the following icons on the toolbar: 

 

 
 

The red indication shows that no axes and tolerances are assigned yet. If these elements were 

specified at the stage of scanning, they will appear on the image at the stage of encoding. 

 

The system of coordinates is two axes intersecting at the right angle. Their crosspoint is 

considered an origin of coordinates. 

 

To position the origin of coordinates 

 

 

1. Place the mouse pointer on the  icon. 

 

2. While holding down the left mouse button, drag the axes to the center of the pattern or to a 

place of the assumed center in case of its absence. If the down-directed Core or Z-whorl was 

assigned, the origin of coordinates will be automatically set exactly at this focal point. 

 

 

To rotate the axes 
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1. Place the mouse pointer on the  icon. 

 

29. While holding down the left mouse button, drag the mouse so that the vertical axis coincides 

approximately with the finger axis. 

 

 

It is also required to preset tolerances for position of the origin and for orientation of the axes of 

coordinates. In most cases, the ridge pattern is only partially reproduced in the latent print; 

moreover, the ridgelines might be smeared or blurred. The tolerance allows for the outlining of 

an area wherein all possible positions of the coordinate origin on the mate’s image might appear. 

 

The tolerance for the origin is specified as a circle. The center of the circle coincides with the 

origin of coordinates. 

 

To set the tolerances for the origin position 

 

 
 

1. Place the mouse pointer on the  icon. 

 

30. While holding down the right mouse button, drag the mouse to resize the circle so that all 

possible positions of the origin are enclosed within it. 

 

 

Note that the radius of the tolerance circle should be at least 2-3 thicknesses of a friction ridge 

for loop and whorl patterns, and at least 4-6 – for arch patterns. 

If the origin position cannot be defined, even with large tolerance, click  to specify the 

origin position as uncertain. The tolerance zone in this case looks like a square. 
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The tolerance for the orientation of axes is set in the form of a sector confined with two rays. 

 

To set the tolerances for the axes orientation 

 

31. Place the mouse pointer on the  icon. 

 

32. While holding down the right mouse button, drag the mouse to resize the sector so that all 

possible directions of the vertical axis are enclosed within it. The minimum opening of the 

sector is 40 degrees (from -20 to +20 degrees). 

 

If the axes orientation cannot be defined, even with large tolerance, click  to specify the 

axes rotation as uncertain. The tolerance zone in this case looks like a square. The rays of the 

sector will be directed downwards. 

 

 

Outlining Usable Areas 

 

To mark on the latent print image only areas with legible pattern subject to encoding, click  

on the toolbar. The program automatically crops the usable zone by filling the unwanted 

areas with color. 

 

“Bad” areas, unusable, should be separated from “good” ones with a closed curve and filled with 

color as follows: 

 

 
 

Those areas on the latent print image that have no visible pattern or this pattern is poorly 

distinguishable or refers to another print should be considered `bad’. As bad can be treated the 

areas where the ridge flows have great curvature (i.e. in vicinity of focal points). 

 

PRINTQUEST provides multiple tools for drawing: 
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• To draw a broken line (polyline), position the cursor where you want the line to start. 

Left-click and drag to the next place. As you drag, a line appears connecting to the 

previously placed point. Left-click again. The endpoint is fixed. This connect-the-dots method 

lets you outline a usable area on the latent print image quickly and easily. To finish, click the 

right button. 

 

• To draw a curve, position the cursor where you want the curve to start. Holding down the left 

mouse button, drag along the desired path like a pencil on paper. Release the button. To finish, 

click the right button. 

 

• To erase a potion of the line, drag along the line you wish to erase holding down the right 

mouse button. 

 

• To fill bad areas, it is necessary first to outline the usable area by drawing a curve that begins 

and ends at the same point forming a closed shape. Otherwise, the whole image will be filled. 

Position the cursor at any place of the bad area and left-click holding down Ctrl. 

 

• To cancel the filling, hold down the right mouse button and Ctrl while you drag to mark the 

area you want to clean from color filling. 

 

• To undo the last operation, click . The last action you performed is reversed. 

 

The process of filtering is launched with . During filtering, those areas that were marked 

as good at the previous step are now automatically processed and coded. As a result, a skeleton 

image is generated, and on its basis, minutiae points are assigned. 

 

At starting the filtering process, the following options appear: 

 

 
 

Select… To… 

Start with bad areas detection- Let the system find bad areas (where the ridge pattern is 

undefinable) automatically and generate a skeleton image. 

Start without bad areas detection- Form a skeleton image of the area already outlined as usable 

on the latent print image. 
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Cancel –Skip the step of filtering as the latent print is of a very poor quality, and to plot a 

skeleton image manually. 

Editing the Skeleton Image 

To change (draw) the skeleton image, click . 

 

Editing the skeleton implies in fact drawing and erasing its portions. Taking into account these 

changes, the program adds or deletes minutiae points and changes the boundaries of “good” area 

identifiable on the image. 

 

To edit the skeleton, use the following tools provided in the system: 

 

• To position the cursor precisely (“targeting”) on the skeleton line, just move the mouse 

pointer to this line; the cursor changes to a crosshair positioning the point on the line where you 

want a new line to start. Moving away from the line changes the cursor back. In the lack of the 

crosshair, the line starts immediately under the cursor. 

 

• To draw a broken line (polyline), position the cursor where you want the line to start. 

Left-click and drag to the next node. As you drag, a line appears connecting to the previously 

placed point. Left-click again. The endpoint is fixed. This connect-the-dots method allows you to 

draw the skeleton lines quickly and easily. To finish, click the right button. 

 

To draw a curve, position the cursor where you want the curve to start. Holding down 

the left mouse button, drag along the desired path like a pencil on paper. Release the button. To 

finish, click the right button. 

 

• To erase the line, drag along the line you wish to erase holding down the right mouse button. 

 

• To erase a portion of the line between two minutiae, hold down the right mouse button 

together with the Alt key pressed. The cursor changes to a crosshair. Move the crosshair to the 

line portion you want to erase. The selected portion automatically changes its color. Release Alt. 

The selected portion of the skeleton vanishes. Release the mouse button. 

 

• To erase a portion of the skeleton image, hold down the left mouse button together with the 

Ctrl key pressed. In this case, the area being selected will have an oval shape. If instead of the 

left you use the right mouse button, the selected area will shape a rectangle. Drag the eraser over 

the image to outline the area on the skeleton to be erased. Release the button. 

 

• To undo the last operation, click . The last action you performed is reversed. To redo 

the undone command, click . 
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PRINTQUEST allows you to hide the skeleton image in order to examine thoroughly the latent 

print proper. To hide the skeleton image, do the following: 

• Press left Shift to hide the entire skeleton image. 

• Press the Space bar to hide only a portion of the skeleton under and around the cursor position. 

Viewing Minutiae Plots 

 

To check the location and orientation of minutiae contained in the latent print, use  

Graphically, minutiae are labeled with the following markers: 

 

Bifurcation                                        

Ending                                                

Ending with undefined orientation    

 

The vector coming out from the center of the marker indicates the direction of the friction ridges 

at the minutia point. If minutiae are detected at the point of greater curvature of the ridge flow 

(usually, close to Cores and Deltas), the program does not define their orientation treating them 

as “minutiae with undefined orientation”. 

 

 

Making a Copy of the Latent 

 

If it is questionable what kind of latent print it is, finger or palm, make a copy of this latent print 

to enable the system to search it against the database twice, one time as a fingerprint and the 

second time as a palmprint. To do this, choose Latent Image > Copy Record Image or click 

.  

 

The following window appears: 
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Select the type different from the currently specified. The copy of the latent appears on the list of 

encoding requests. Encode the latent again but as a different-type print and send both to the 

database for matching. 

 

Saving and Initiating a Search of the Database 

 

Having ensured that the latent is properly coded, click to send the latent to the AFIS database for 

matching. Each time an image is saved, the system initiates an automatic search of the database. 

 

Once the latent has been saved, the Encoding window closes and the list of encoding requests 

appears. 

 

Image Enhancement 

 

The AFIS provides tools for image enhancement, including scaling, to clarify and better define 

poor quality ridge detail for searching. 

 

Program Tools for Image Modification 

The tools for image enhancement can be accessed through the Image Enhancement 

menu: 

 

Enhancement Tool                                        What It Does 

Auto-Adjust Brightness/Contrast       Adjusts the brightness and contrast of the image 

automatically. 

 

Adjust Brightness/Contrast                 Enables manual adjustment of the brightness and contrast. 

 

Original Image                                           Returns the image back to the original settings. 

 

Enhanced Mode                                     Increases the intensity of the tones of the image. 

 

Equalization ON/OFF                      Enables or disables the mode of image equalization 

(equalization is used to  

achieve maximum contrast of the image). 
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Shadow Effect Mode                        Highlights the image from one side  

(the illumination regulator box appears). 

 

Border Mask ON/OFF                                    Displays/hides the bad area marking. 

Skeleton ON/OFF                                           Displays/hides the skeleton image. 

Binary Image ON/OFF                       Displays the image as binary having 

generated it from the original and skeleton 

images. 

 

If necessary to convert the image to display as negative, choose Latent Image > Negative Image. 

 

The menu option Latent Image > Enhance Image by ImagTool invokes an auxiliary application 

that enables you to apply additional transformations to the image. 

 

Changing the Image Scale 

 

To rescale the image, use the commands available through the View Setup menu: 

 

 
To adjust the magnification of the image, use the gray Plus key to zoom in and the gray. Minus 

key to zoom out. 

 

If the magnified image does not fit inside the Encoding application window, a selection box 

appears on the image. Drag this selection box to the region of interest. Click or press any of the 

following buttons: Enter, Esc, Spacebar. The selected fragment appears in the Encoding 

window. 

 

Rotating Images 

 

PRINTQUEST’s rotation tools can be accessed through the View Setup menu: View Setup > 

Rotation of Image. The Rotation of Image box appears: 
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Dragging the slider is the simplest and quickest way of rotating images. The Rotation angle box 

allows you to rotate images by a specific number of degrees. 

 

Rotating images with the tools of the View Setup > Rotation of Image menu has no effect on the 

image data that will be input in the database. If you wish to save rotated images, use Latent 

Image > Rotate Image by an Angle of 90 Degrees (to rotate images counterclockwise) and 

Rotate Image by an Angle of 180 Degrees (to rotate images clockwise). 

 

REFERENCES: 

 

PrintQuest AFIS, Operation Manual v. 2.5, SPEX Forensics, HoribaJobinYvon 
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Chapter 18: Database Searching Latent Unit Workflow for SAFIS 
 

Latent print impressions that did not produce positive identification results from SPEX database 

searching, may be entered into the North Carolina State AFIS (Automated Fingerprint 

Identification System).  

Similar to the process of screening latent impressions for entry into the SPEX system, the latent 

evidence is screened to determine its value to for SAFIS entry. The determination of entry of the 

latent print evidence is at the discretion of the Forensic Technician/Latent Examiner, based upon 

their training and experience.  

As The comparison of onscreen images is not considered as part of the latent print examination 

process, therefore, the candidate lists will not be maintained in the examination documentation. 

Rather, the database system maintains a record of each print searched so that, if necessary, a 

latent print image can be retrieved and its searching criteria evaluated.  

There are occasions when a case containing latent print evidence was submitted through the 

SPEX system for searching, but not through the SAFIS database system. There are a few reasons 

for such occurrences, those being: crime type and quality of the latent print images. 

As a general rule, crimes such as larceny from auto and recovered motor vehicle cases are not 

submitted for SAFIS searching.  

Property crimes such as larceny from auto, recovered motor vehicles, or damage to property 

cases are normally not searched through SAFIS. Residential and commercial burglary cases may 

occasionally be searched through SAFIS depending upon the quality of the image and at the 

discretion of the examiner.  

Also, due to the searching mechanisms of the SAFIS system, the threshold for its ability to 

search lower quality latent print impressions is higher than that for the SPEX database. 

Therefore, lower quality latent print impressions may be of value for entry into SPEX, but are 

not always suitable for SAFIS entry.    

When latent print evidence is searched through the SAFIS system, documentation is generated 

on a database search review note sheet, and SAFIS search information is also updated as a 

database search review notification in the RMS reporting system.  
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The database search review notification will not indicate positive or negative results of the 

search; rather, it will advise that a case was screened for entry into the database and specifically 

which, or if, latent print lift cards contained latent print evidence that was submitted for database 

search, and the date of the screening/search.  

Latent evidence for property crimes will be retained in the SAFIS system for the purposes of 

reverse searching for approximately five (5) years from the entry date. After such time, the latent 

searches for property crimes will be purged from the system. Certain property crimes cases may 

be retained at the request of the investigating authority and as authorized by the Forensic 

Supervisor or Lead Latent Examiner.  

Latent evidence for person’s crimes will be retained in the SAFIS system indefinitely, or unless 

advised by the investigating authority that certain cases may be removed from the system.  
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Chapter 19: SAFIS Searching Steps 
 

The State Automated Fingerprint Identification System is a state-wide database whose finger and 

palm print records are maintained by the North Carolina State Crime Laboratory.  

This procedure describes how to operate the State Automated Fingerprint Identification 

System/Advanced Fingerprint Identification Technology (SAFIS/AFIT). 

 

The State Automated Fingerprint Identification System (SAFIS) and the Advanced Fingerprint 

Identification Technology (AFIT) are designed to search unidentified latent fingerprints and 

palm prints which may be left on items of evidence or recovered at crime scenes. The SAFIS is 

also designed to search unknown deceased fingerprints as well as known inked ten prints.  

 

The State Automated Fingerprint Identification System (SAFIS) has the capability to search 

latent fingerprints and palm prints from arresting agencies throughout North Carolina and other 

states.  This database is maintained, and updated as necessary, by the Criminal Information and 

Identification Section (CIIS). 

 

The system is designed in a Microsoft Windows format and is efficient with respect to entries 

and verification packets. For further instructions, please refer to the Operations Manuals.   

 

Logging in and out of system: 

 In the WINDOWS  Login screen using the tab button , enter your assigned  user name 

and password , hit OK 

 To sign off the system, simply click the open door on the bottom right corner and the 

system will return to the initial status. 

 Workflow and Case Selection 

 

 Select  LATENT  on the menu located at the right hand bottom side and LATENT 

STATION 

 The main menu screen will appear and the latent information may be entered 

 Under CASE FILTERS, Enter & assign a new case ID by using  the following index 

format :    

 

                                                       SAFIS Searching Indices 

1. Case numbers must consist of a maximum of 11 digits 
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2. The first space must be an upper case “C”, this is CCBI’s identifier 

3. Space #2 is the crime type identifier, (see index below) 

4. The next two spaces are for the case # year. (i.e.  12 for 2012) 

5. The following five spaces are for our case number (old chief’s number).  

Be advised:  This number must take up five spaces, and if it does not, 

you must place zeros preceding the number.  (i.e. Case # 487 would be 

entered as 00487) 

6. The last two spaces are for the examiners initials 

An example is as follows: 

 

                                       C                       1               12          00487            RM 

                           Crime Index    / Crime ID   /  Year  /   Case #     /   user initials 

 

 

Crime Type Index: 

1-Homicide                                                           

2-Robbery   

3-Assault   

4-Rape/Sexual Assault (nature crimes)    

5-Kidnapping/Carjacking      

6-Burglary    

7-LFA/RMV 

8-Drugs/Weapons                                                                                                                                                                                                       

9-Other-Death Investigations, unknown deceased, suicide 

0-Other Category-includes DTP, Hit & Run, Larceny, Found Property, Fraud, Threats, 

Request for Services.  *Use this category for anything else that is not listed above. 

 In CASE DESCRIPTORS, enter the Victim name and hit CREATE. 

 

IMAGE SELECTION 

 

 

Use this option when you want to locate a previously entered latent for re-submission.   

 

 Click on Case images and select latent to encode 

 Image will appear in SELECTED IMAGES. 

 Hit LOAD IMAGES in the lower right hand corner. 
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    IMAGE CAPTURE 

 LATENT FINGERPRINT /PALMPRINT ENTRY 

 To enter/locate a case, enter the appropriate format as listed above in CASE ID block 

 Enter the name of victim associated with the case in the Descriptors Area and click Create 

 Choose SCANNER or CAMERA option to capture latent image & file to be encoded. 

 

   If using CAMERA OPTION, place the latent print on the round glass 

surface under the digital camera with the print facing up.  Turn on the 

camera lights and adjust lighting to optimal level using knobs on the desk.   

A live image of the latent will appear in the view area of Image Capture 

window.  The optional camera settings icons can be applied   based on the 

quality of the latent and at your discretion.  Use the 

brightness/contrast/gamma buttons.  Click CAPTURE. 

   If using SCANNER OPTION (larger images-palms), select scanner 

from the device list and align the top of the image flush left against the top 

right side of the scanner glass.  Hit the SCAN button.  (this may take a 

minute or two) 

  

 The image will appear on the view area of the computer monitor. 

 EDIT the image using one of the crop icons to narrow the specific area to be 

searched. 

 Use the ROTATE icon             to position the latent in the proper orientation. 

 Hit the SAVE IMAGES tab at bottom of screen. 

 

UNDER IMAGE SETTINGS: 

 Choose the  appropriate descriptors to include fingerprint or palm print 

 For latent fingerprints:  Select CLASS/PATTERN TYPE, FINGER #1-10, and if 

applicable, choose a reference and /or alternate for each. 

 For palm prints, select hand and region.   Select Unknown if applicable. 

   

IMAGE ENCODING 
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 Extracting Features/ Plotting Minutia 

 

IMAGE SETTINGS: 

 Choose the  appropriate descriptors to include fingerprint or palm print 

 For latent fingerprints:  Select CLASS/PATTERN TYPE, FINGER #1-10, and if 

applicable, choose a reference and /or alternate for each. 

 For palm prints, select hand and region.   Select Unknown if applicable. 

           FEATURES 

Choose either EXTRACT EXPERT FEATURES         for auto Plotting.  

or ADD MINUTIA        ϙ    icon for manual plotting 

  *Be advised that Extract Expert Features/AUTO Plot has a tendency to plot false minutia 

and is not always accurate.   

   *To delete false minutia:   Use the middle mouse button and create a box around minutia to 

be removed.  Release finger off of mouse button.     

 Plot CORE using    О   icon   and DELTA             of Image using respective icons.  

(optional) 

 

ENHANCEMENTS 

 

 Enhancements are optional.  Select from the following:  brightness, contrast. B/W 

reversal, rotate image, LR reversal and histogram.   Advanced options available.  Use at 

your discretion to optimize clarity and quality of latent. 

 Create search button at bottom                                                                 

 

 

SEARCH SUBMISSION 

 

 

SUBMIT SEARCH TO STATE DATABASE 

 Under LOCAL SEARCH DATABASE, choose from TPF, (Ten print) or Palm.  An 

additional searching option is the Unidentified latent finger or palm databases, ULP/ ULF, 

(latent to latent) 

 For Palms, Click on SEARCH PALM SELECTION, appropriate type/hand. 
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 Click on SAVE AND SEARCH 

 

LATENT SEARCH VERIFICATION 

 Go to Home Page      Select  LATENT tab 

 From the list , find and click on your searches referencing your case number 

 Manually compare and or verify each  image/respondent from the  viewing screen  

 Use the icons at the top of the screen to facilitate your ACE and verification if applicable. 

 For palms comparison, click on palm segment to isolate viewing area. 

 After comparing all respondents enter a disposition by clicking on upper right hand 

corner. 

 If results are negative, disposition the case as a NON-IDENT. 

 If results are positive, disposition the case as an IDENT, and print two 

copies of the screen, one for your notes, one for the case agent.  (see below 

for details regarding printing) 

 Hit SAVE and EXIT 

     

PRINTING SAFIS MATCH REPORTS:   

 Display MATCH REPORT on SAFIS Verification Screen 

 Click on Print button 

 Choose PRINT AND SELECT , drop down menu,  printer WAKE CO and FBI Car 

 

 

TEN PRINT CARD RETRIEVAL: 

 

 Go to FIND tab in lower right corner, and, TEN PRINT screen on the SAFIS. 

 In the first block titled PERSON ID, enter the SID number or additional info. 

 Click search. 

 In the middle of screen, under ID, the ten print card information requested should appear 

bearing data that can be accessed by clicking on the folder     icon located on the left side. 

 Select the tenprint record of your choice.  There may be multiple.  If palms are on file the 

tab will be highlighted in grey at the top of screen. 

 On the left upper side of screen, select PRINT CARD.   

 Card Format should be SBI or SBI PALMPRINT as type of card and choose WAKE CO 

for printer location 

 

CHECKING THE REVERSE QUE: 

 Go to Home Screen 
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 Go to LATENT, second tab on upper left side of screen. 

 In the AGENCY block, enter NC_C.   (this is CCBI’s identifier) 

 Leave the rest of the blocks empty. 

 Reverse candidates pending will show an “rv”under the State column. 

 Proceed to each case to access respondent for viewing. 

 There will be only one respondent for each case 

 

Obtaining a copy of a 10-print card:  

Fax # for the NCSCL: 919-661-4890 

-Submit a written request via fax. Provide the name, birthdate of the individual, any particular 

arrest date (if necessary), and the State Identification Number (SID). Include a mailing address, 

or reference whether the known print standards will be picked up at the facility located at 3320 

Garner Rd, Raleigh, NC 27626. Include the name of the requesting person and contact 

information on the faxed request. Contact 919-662-4509 ext 6313 if any problems are 

encountered.  

REFERENCES: 

 Motorola Printrak, Version 9.9, Latent Station User’s Guide, May 2007 
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Chapter 20: Database Searching Latent Unit Workflow for IAFIS 
 

Latent print impressions that did not produce positive results from either SPEX or SAFIS 

database searching may be entered into the IAFIS (Integrated Automated Fingerprint 

Identification System).  

The Latent Examiner will review the latent print evidence to determine its suitability for entry 

into IAFIS.  

IAFIS searches are generally reserved for higher priority crimes, such as robberies, assaults, and 

homicides. Occasionally, property crimes are searched through IAFIS. A property crime search 

through IAFIS is generally the result of a request for federal database search by an investigating 

authority in the case.  

The IAFIS system does not currently have the ability to search palm print impressions, nor does 

the Latent Print Unit utilize any reverse search capability on the software.    

As comparison of onscreen images is not considered as part of the latent print examination 

process, the candidate lists will not be maintained in the examination documentation. Rather, a 

record of each print searched is maintained in the user’s “archive folder” so that, if necessary, a 

latent print image can be retrieved and its searching criteria evaluated.  

When latent print evidence is searched through the IAFIS system, documentation is generated on 

a database search review note sheet, and IAFIS search information is also updated as a database 

search review notification in the RMS reporting system.  

Since a reverse search capability on the IAFIS system is not utilized, the database search review 

notification will indicate either a positive or negative result. 

If a positive result occurs, a full latent print examination report will be produced.   
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Chapter 21: IAFIS Searching Steps 
 

The Integrated Automated Fingerprint Identification System is a national fingerprint database 

whose records are maintained by the Federal Bureau of Investigation.       

IAFIS PROCEDURES (MORPHO TRAK WORKSTATION) 

This procedure describes how to submit a latent print to be searched through the Integrated 

Automated Fingerprint Identification System. 

IAFIS Entry 

Open the latent print function in the MorphoTrak SAFIS system. See SAFIS procedures for 

opening a previously entered latent print in SAFIS.  The latent print should have already been 

searched through the Local and State databases prior to conducting an IAFIS search. 

The print must be a latent fingerprint. Latent palm prints cannot be searched through IAFIS. 

Once the selected print is opened, either re-plot the minutiae or add or subtract the minutiae that 

you desire for the latent print to be searched. 7-14 minutiae should be used for best results. 

Click on "Create Search". 

In the next screen, check the box "IAFIS-Ten Print". 

Click "Save and Submit Search" The ULW software will now open. 

Click "zoom" to increase the size of the latent print to be searched. 

Click on the box between "Reject minutiae & Accept minutiae" 

Click on "count ridges" and fill in the proper ridge count then click on "edit next" and again 

count the ridges and fill in the proper ridge count. 

Continue this process until all of the ridge points have been counted. There must be a ridge count 

of at least one (1) between each ridge. If there are no intervening ridges between points, then use 

"1" as the proper count. 

When finished, select a finger position for your search. Multiple fingers can be selected or 

"unknown” can be selected however the "saturation" level must be below 30%.  
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Click on "transaction data". 

Click on "designation agency ID" and chose "WVIAFIS0Z" from the list. 

Click on "case information" and select "3" as the case priority. 

Click on "No" under "add to unsolved". 

Click on "File", then click on "save ULW.LFFS [with image]" (or you can hit ctl+S). 

Click on "File" again, then click on "save as" and go to the folder on the desk top called "IAFIS 

Latents". Open this folder and save there. 

Close out the Universal Workstation. 

You can monitor the progress of your search by opening the home page. Click on the latent tab. 

Your search will show up as "sending-trans-to-fbi" When this disappears, your search is finished 

and the results are ready to be viewed. 

Viewing IAFIS Results 

Go to the ULW Latent queue icon on the desktop and open. 

Double click on the search result (the file name will start with "SLR-") 

The ULW software will open and display the respondent images. 

Go to the folder on your desktop called "IAFIS Latents" containing the searched latent image and 

open it by double clicking. 

Go back to the ULW software and under the "Window" tab, select "tile vertically". 

Click on the first image entry under "Fingerprint Image" (the entries will be listed by their score, 

from the highest to the lowest). 

Both the latent image and the respondent image will now be side by side on the screen. Size each 

window and adjust the zoom level so each image is the same size. 

Click each respondent image and compare it to the latent image. There will be (20) total 

respondent images.  

When finished, close out of the ULW software. 
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Each Latent Print Examiner will have an archive folder within their user desktop in which to 

place completed searches submitted to the ULW. This will record the searching criteria used.  

Obtaining a Copy of the 10-Print Card 

In the event of an apparent positive result, contact the FBI to obtain a copy of the 10-print card. 

Contact the Special Processing unit (via FAX) at (304) 625-5587.  

The request must be on official CCBI letterhead and must include the following information: 

Name 

DOB 

FBI # 

Also include the requestor’s name and contact information. 

Indicate how the response is to be sent; to the address on the letterhead via first-class mail, or to 

the CCBI fax number. 

The Special Processing Unit is available 24 hours a day, 7 days a week. The turnaround time is 

approximately one (1) day. 

REFERENCES: 

  

 Universal Latent Workstation (ULW) Training manual, FBI
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Chapter 22: Database Searching Latent Unit Workflow for SICAR 
 

The Shoeprint Image Capture and Retrieval (SICAR) is a footwear searching database that 

allows the searching of questioned footwear impressions for the possible determination of the 

model and/or brand of the known shoes. 

SICAR is a non-individual characteristic database that contains thousands of known models and 

brands of footwear outsoles. 

Person’s crimes questioned footwear impressions are automatically submitted for SICAR search; 

a request for database search is not required. Property crimes are submitted for SICAR database 

search by request.    

Person’s Crimes:  

1) Person’s crimes footwear cases are generally received via the Main Evidence 

Vault. However, occasionally there may be a direct transfer of evidence. In all 

instances, it is important to document evidence transactions on the chain-of-

custody.  

2) Person’s crimes cases with footwear evidence of value to be searched (as 

determined by a Latent Examiner) will be submitted into the SICAR database for 

searching.  

3) Case notes are generated, and the reporting system is updated with a notification 

advising of the database search.  

4) The footwear evidence is turned over to the contributing agency via the Evidence 

Technician, following proper evidence transfer procedures.  

Property crimes:  

1) Property crimes footwear Footwear cases are only searched through the SICAR 

database system at the written request of an investigating authority.  

2) The written request is submitted on an evidence submission form at the CCBI 

Evidence Unit, along with the questioned footwear items.  

3) The request and questioned footwear items may then be directly turned over to the 

Main Evidence Vault, or can be submitted directly to a Latent Examiner. In all 

instances, it is important to document evidence transactions on the chain-of-custody.  

4) Once the questioned footwear evidence items and request are received by a Latent 

Examiner, their value for database searching will be assessed.  

5) Property crimes cases Cases with footwear of value to be searched (as determined by 

a Latent Examiner) are submitted into the SICAR database for searching. 
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6) Case notes are generated, and the reporting system is updated with a notification 

advising of the database search.  

7) The footwear evidence is returned to the contributing agency via the Evidence 

Technician, following proper evidence transfer procedures.  

 

All documentation created as a result of a review of evidence for SICAR searching must be 

organized in a case file and turned over to central records for storage.  
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Chapter 23: SICAR Searching Steps 
 

Obtaining footwear impression evidence: 

 Questioned footwear evidence is generally submitted to the Main Evidence Vault where 

it can be accessed by a Latent Examiner.   

 Collect the footwear impression evidence (to include evidence items and/or call cards, for 

photo only cases, and chain-of-custody forms) from the appropriate evidence locker.  

 Update the chain-of-custody form.  

Entering footwear impression evidence into SICAR: 

 Double click the SICAR icon on the desktop. 

 New Record 

 Type the case number in the following format: 11-1234 or 12-0322 

o It should include two numbers for the year followed by a dash and then four 

numbers. 

 Go through the first FOUR tabs: 

o Detail tab: 

 Fill out all areas. 

 Check “Do Not Delete” 

o Categories tab: 

 Check appropriate Crime Type Index: 

 1- Homicide 

 2- Robbery 

 3- Assault 

 4- Rape/Sexual Assault 

 5- Kidnapping/Carjacking 

 6- Burglary 

 7- LFA/RMV 

 8- Drugs/Weapons Violations 

 9- Other Death Investigations 

 0- Other Category (Includes DTP, Hit & Run, Larceny, Found 

Property, Fraud, Threats, Request for Service, etc.) 

o Images tab: 

  “Scan…” to scan in a lift. 
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 Save the image name as either the Item # or Image ID #. 

o Item #1 or Image ID #123456 

 “Add…” to import a photo from the CrimeScene photo manager. 

 See section: Importing a photo into SICAR from CrimeScene. 

 “Rename…” to change the file name to either the Item # or Image ID #. 

o Notes tab: 

 Type in either the evidence item number(s) or image ID number(s) and 

appropriate lift/photo locations as follows: 

 Item #1 – Lift card (or gel lift) from Ext. POE door.  

 Image ID #123456 – Photo from Ext. POE door. 

o Click “OK”. 

Importing a photo into SICAR from CrimeScene: 

 Open CrimeScene. 

o This is CCBI’s photo management system.  

 Sign in with operator’s username and password. 

o Each account is set up by CCBI’s Forensic Photographer. 

 Record 

 Find 

 Type the CCBI case number in the Case ID field using the following format: 11001234 

or 12000322. 

 Enter 

 Click on case when it appears in the upper right side of the screen. 

 Select “Multiple Images” tab to view all photos. 

 Determine the photo(s) to be exported. 

o Click “Zoom” on right side to view the picture(s) larger. 

 Write down the Image ID number which is found on right side of the screen. 

o If all images are of no value, select one image and document that Image ID #. 

This documentation will be needed for notes and reports. 

 Select image. 

 Click “Export” 

 Save image in EXPORT folder on desktop. 

o If only one photo is being exported, save the image as the case #: 11-1234 or 12-

0322.* 

o If two or more photos are being exported, create a folder as the case #. 

 Save the pictures in the folder as 11-1234jj1, 11-1234jj2, etc.* 
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o *Note: All images’ names will be changed to the appropriate Image ID # in 

SICAR. 

 Save/Close Crimescene. 

Searching footwear impressions in SICAR: 

 Select the image to be searched by using the drop down menu at the top center of the 

window. 

 To edit/enhance the image: 

o Click on the second to left button, “Adjust Image Controls” 

o Adjust as needed and then click “OK”. 

 To zoom in/out: 

o Click on the third to left button (four arrows), “Select Zoom Style”. 

 To magnify a specific area: 

o Click the fourth to left button (magnifying glass), “Image Magnifier” and click on 

the image in the area needing magnification.  

 To add shapes: 

o Click on plus button (+) next to box that states “Add SHAPE Coding Steps Here”.  

 This brings up all of the codes that can be used. 

 Scroll through all of the shape families, making sure to click specific icons 

and reading the descriptions before applying it.  

 There is an image of a shoe outsole below the icons. Once an icon is 

selected, click the area of that shoe in which the design is seen in the 

unknown footwear impression (the area selected should now be 

highlighted), and select “Add Step”. 

 To add a logo: 

o Click on the plus button (+) next to the box that states “Add LOGO Coding Steps 

Here”. 

 This brings up all of logos in the SICAR database. 

 If the name of the logo that is being searched is already known the first 

letter of that brand name can be pressed on the keyboard and the box will 

automatically go to the logos that begin with that letter.  

 For example, if the logo is a Levi’s logo, press the “L” key on the 

keyboard and the box will go to all the logos that begin with an 

“L”. 

 The filter option at the top of the logo box allows filtering by what may or 

may not see in the unknown impression.  
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 For example, if the logo is an animal but the operator isn’t sure 

what type, all logos that aren’t animals can be filtered out. 

 Once a logo is selected, either select “Add” or “Definite”. 

 Selecting “Definite” specifies that all results must include the logo, 

whereas selecting “Add” gives results including that logo and 

those similar. 

 To add text: 

o Click on the plus button (+ next to the box that states “Add TEXT Coding Steps 

Here”. 

 Either scroll through the list provided or simply type what may be seen in 

the unknown impression. 

 For example, if the three consecutive letters “non” are seen in the 

unknown impression, type in those letters and all texts including 

those three consecutive letters will appear. 

 Once the text is selected, either select “Add” or “Definite”. 

 Selecting “Definite” specifies that all results must include that text, 

whereas selecting “Add” gives results including that text and other 

similar text. 

 Make sure “Reference Library” is selected in the drop down menu. 

 Search 

Searching a specific shoe type in SICAR: 

 This option can be used to search a specific shoe type (sandal, boot, trainer, etc.). 

 In the top left corner of the screen, click the second button the left, “Browse the Local 

Databases” 

 Select “Reference” (in yellow). 

 The fourth box down on the left side, use the drop down menu to select “Categories”. 

 To the right of the box the word “has” will follow with another drop down menu to select 

the shoe type. 

 Once the shoe type is selected, click “Search”. 

 Tools 

 Save Match List 

o Complete List of Matches 

 Now, once the coding steps are complete, use the drop down menu and select “Saved 

Match List”. 

 Search 
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Reviewing results: 

 In the top left corner of the results window, click “View List or Images” button. 

o This arranges the results into a list view, which allows for quicker reviewing. 

 Click on the second to left button (Green with arrow and number 10) to increase the 

number of results you are viewing to 200. 

o The current number of results being viewed are just above this button, to the right 

of “Search Results” (ex. 200 of 12,200). 

 Select the top result and then using the down arrow on the keyboard scroll through all the 

results. 

 Mark Groups: 

o If “Mark Group!” is seen in the results list this means that different brands have 

used the same outsole design, or that a brand has used the same outsole on more 

than one shoe.  

o To view the Mark Group, double click the selection and then click the button 

“Show Links from this Record” (single chain link). 

 A new window will open listing all of the shoes in that Mark Group. 

Linking an unknown to a known: 

 If a potential “hit” is generated: 

o On right side of screen, above the unknown impression, select the button with 

chain links and a yellow asterisk (*) above. 

o Click on the potential known in the results list on the left side of the screen. 

o A box will pop up, type HIT in the “Reason” box and type the brand name 

(example: NIKE) in the bottom box. 

o Click “OK”. 

Printing a links report: 

 To print out the links report: 

o On right side of screen, above the latent/photo, select the button with only the 

chain links. 

o This brings up the case information and brand/model information. 

o Print. 

Searching for a specific case in SICAR: 

 In the top left corner of the screen, select the third button from the left “Open File” (file 

folder). 
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 Either type in the case number, or browse the recently opened files using the scroll bar.  

 Once the case number is typed in or found in the list, select “OK”. 

 To view any Tentative Identities, select the button “Show links from this record” (single 

chain link). 

o Any Tentative Identities will be listed below the case number. 

Any printed documentation created as a result of a SICAR search must be retained in the case 

file and sent to central records.  

Updating SoleMate Software and SICAR License: 

 Updating the software: 

o Double click the SICAR Administrator icon on the desktop. 

o A box will prompt for the SICAR Owner ID, type in 289. 

o Click the plus button (+) to the left of “Owner 289”. 

o Click the plus button (+) to the left of “Databases”. 

o Click on SoleMate##. 

 The number displayed will be the previous update. 

o Open the CD drive and enter the new update.  

o Click “Install” button on the right side of the box. 

o Exit once update is complete.  

 Updating the license: 

o This will occur once a year. 

o Double click the SICAR Administrator icon on the desktop. 

o A box will prompt for the SICAR Owner ID, type in 289. 

o Click the plus button (+) to the left of “Owner 289”. 

o Select “Licences” 

o Open the CD drive and enter the new update.  

o Click “Install” button on the right side of the box. 

 A box will open; select the only file on the disc. 

o Click “OK”. 

 License will now update. 

o Click “Finish” and then exit once the update is complete. 

 

REFERENCES: 

 

Foster + Freeman, SICAR 6, Shoe-print & Tyre-track Storage, Matching & Recognition 

System, User Manual  
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Chapter 24: Known Print Standards Generated as a Result of Database 

Searching 
 

When latent print database searches indicate positive results, obtaining the known print standards 

for a latent comparison is required.  

The known print standards can be obtained by several methods, and there There are two known 

standard repositories directly available to the Latent Print Unit.  

One such repository is located in the records section and contains historical known finger and 

print standards. The known print standards in this area are referenced as “hard copies” or 

“originals” since they are not digitally retained.  

A second repository exists in the NIST database archive. This database contains known print 

standards in digital format, and one single record can be printed multiple times if necessary. 

When known print standards are accessed to determine whether or not a database a search result 

is indeed positive, the standards may be treated as reference materials.  

If the result is positive the known print standards, or a copy of the known print standards, is 

included as part of the technical documentation of the case file. 

If the Latent Examiner accesses the known print standards and ultimately determines the results 

of the database search to be negative, the known print standards (or copies) do not have to be 

retained as part of the case file.   

In the event that a database search yields an apparent positive result from an out of jurisdiction 

source, and CCBI does not have a record or access to the record in any repository, the Latent 

Examiner may contact the North Carolina State Crime Laboratory or the Federal Bureau of 

Investigation to request a copy of the known print standards.  

Once the record is received, it must be referenced as an evidence item and handled as such.  

After the latent examination is complete, the Latent Examiner must send the known print 

standards to the contributing agency as an evidence item. A copy of the known print standards is 

included as part of the technical documentation of the case file.  
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Chapter 25: Requests for Comparison for Latent Print and Footwear 

Cases 
 

A request for comparison is one in which a police officer, investigator, detective, or district 

attorney submits known suspect information on a submission form to the Latent Print Unit in an 

effort to determine if a particular suspect or known shoe is the source of the latent or questioned 

impressions recovered from a crime scene. A Latent Examiner will conduct an examination of 

the latent print or questioned footwear evidence against the known standards supplied as per the 

request.   

Requests must be in writing and can be submitted in-person, faxed, or emailed directly to the 

records section Latent Print Unit.  In certain situations (as described below) requests for print 

comparison may be received via the latent print evidence locker #69.Verbal requests will not be 

accepted. Requests must be received on a Laboratory Examination Request form.  Any “rush” 

request received must be approved by the Deputy Director of the Crime Laboratory, the Director, 

or the Technical Leader of the Latent Print Unit.   

Comparison requests will be date stamped when received by records personnel, and an attempt to 

determine if there are other pending or duplicate requests under the same case number should be 

conducted.  

A search of the records management system will be conducted to determine if CCBI has 

collected any print evidence in the case to which comparisons may be made.  The subject’s 

known standards will be retrieved from the records section and the request form and the known 

standards shall be prepared into a folder and will remain in the LEC until ready to be assigned to 

a Latent Examiner for analysis. in records until it is ready to be assigned to the Latent Print Unit 

If the subject’s known standards needed for the comparison are not maintained in a CCBI known 

standard repository, the requesting authority will be required to provide a copy of the known 

standard to be used for comparison. The known standards will be received by CCBI as an 

evidence item in the case, and will be handled according to evidence submission protocols. 

Likewise, footwear evidence will be turned over to the Latent Print Unit following all 

appropriate evidence handling procedures.  

The Latent Examiner will place the original request for comparison form in their case file upon 

its completion, which will be forwarded to the records section after the case has been 

administratively reviewed.  
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The Latent Examiner will submit a copy of the completed request for comparison form for 

management and statistical purposes. Accreditation Manager for statistical purposes.  

In situations when a requestor has submitted a request to have evidence items examined 

(processed) for latent print evidence, and any developed latent evidence compared against 

individual/s listed on the request form, the following protocol will apply:  

1) Once the request for processing is received, the Crime Scene Agent who is assigned the 

case will conduct their forensic examination. If no latent print evidence is developed as a 

result of the evidence processing, the portion of the request for latent print examination 

will be considered null, and will not be received by the Latent Print Unit.  

 

2) In the event that latent print evidence is developed and collected as a result of the 

evidence processing, the Crime Scene Agent will make a copy of the request form and 

shall attach it to the latent evidence chain-of-custody form, and will turn the forms and 

the latent evidence over to locker #69 as per normal protocol. The original form will be 

used to submit the evidence items that were processed, back to the agency.  

 

3) When the request is received, it shall follow the same procedures as previously 

referenced.  
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Chapter 26: Latent Print Examination Procedures, Friction Ridge Image 

Enhancements, and Receipt of Digital Images 
 

Method of Friction Ridge Examinations: Analysis, Comparison, Evaluation and Verification 

(ACE-V)  

Analysis:  Analysis is the assessment of a friction ridge impression to determine suitability for 

comparison. 

Factors considered include the following: 

 Quality (clarity) and quantity of detail 

 Level one detail 

 Level two detail 

 Level three detail 

 Anatomical source (finger, palm, foot, toe) 

 Factors influencing quality include: 

 Residue/matrix 

 Deposition 

 Surface/substrate 

 Environment 

 Development medium 

 Preservation method 

 Condition of the friction skin 

 

Comparison: Comparison is the direct or side-by-side observation of friction ridge detail to 

determine whether the detail in two impressions is in agreement based upon similarity, sequence 

and spatial relationship. 

Evaluation: Evaluation is the formulation of a conclusion based upon analysis and comparison 

of friction ridge impressions. Conclusions which can be reached are: 

1. Individualization (Identification):  Individualization is the result of the comparison of two 

friction ridge impressions containing sufficient quality (clarity) and quantity of friction 

ridge detail in agreement.  Individualization occurs when a Latent Print Examiner, trained 

to competency, determines that two friction ridge impressions originated from the same 

source. 
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2. Exclusion:  Exclusion is the result of the comparison of two friction ridge impressions 

containing sufficient quality (clarity) and quantity of friction ridge detail which is not in 

agreement. Exclusion occurs when a Latent Print Examiner, trained to competency, 

determines that two friction ridge impressions originated from different sources.  

 

3. Inconclusive:  Inconclusive evaluation results when a Latent Print Examiner, trained to 

competency, is unable to individualize/identify or exclude the source of an impression. 

Inconclusive evaluation results must not be construed as a statement of probability. 

Probable, possible or likely individualization/identification conclusions are outside the 

acceptable limits of the friction ridge identification science. 

 

Inconclusive results should be documented in case notes utilizing the following descriptions: 

 

Cannot exclude:  A “cannot exclude” result will occur when the latent print has detail consistent 

with the exemplar or known print; however, it is insufficient to identify the source because of the 

quality or quantity of the latent print. The selectivity of the available corresponding data is not 

strong enough to disregard the possibility that another source could have left the print. If the 

examiner reaches the “cannot exclude” result, the subject’s name and anatomical region should 

be clearly indicated in the notes and the notes should also reflect why the examiner could not 

exclude the person.  

 

Incomplete: An “incomplete” result will occur with the exemplar prints are inadequate in 

quantity and/or quality. The latent print may or may not have limited detail consistent with the 

exemplar prints. Additional exemplar prints will be required. For each latent print compared with 

“incomplete” results, the notes should reflect the subject’s name, whether any detail was found 

consistent with the exemplars, and the additional exemplars needed to complete the comparison. 

 

Not Compared: If a latent print contains an anatomical region that is not recorded in the 

exemplar prints, or there are no exemplar prints available, then no comparisons are possible. For 

exach latent print not compared, the notes should reflect the name/s of the subject/s not 

compared and the exemplar prints needed to perform a comparison. 

 

 

Value determinations: Latent Prints of Value 

The comparison and identification process is not one based solely upon quantity of friction ridge 

area characteristics. A “Latent Print of Value” is a latent print which possesses sufficient 

individual friction ridge area information to be identified or excluded.  

 

This determination is made by the Latent Examiner based on the latent print and the Examiner’s 

experience and training. 
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There is no valid scientific data which dictates a specific amount of friction ridge area 

information necessary to determine if a latent print is “of value”. 

 

Should friction ridge images require computer software enhancement for examination purposes, 

documentation of the enhancement will be printed and maintained in the technical 

documentation of the case file. Current enhancement software provided to the latent print unit for 

this purpose is CSI PIX Comparator version 3.0. 

 

For friction ridge impression images received digitally a Latent Print Examiner will review the 

photo log printed by the Forensic Photographer.  The Latent Print Examiner will note on the 

photo log which images are needed for examination and the format requested:   

 SPEX  

o Image is scaled 1:1, labeled with the CCBI case number and the Latent Card 

number and copied as a TIFF file to the SPEX Latent Share folder 

 USB 

o Image is scaled 1:1, labeled with the CCBI case number and the Latent Card 

number, copied as a TIFF file to a clean USB drive and provided to the requesting 

Latent Print Examiner 

 Print 

o Image is scaled 1:1, printed, labeled with the CCBI case number and a derivative 

Latent Card number, sealed in a Latent Envelope marked with the CCBI case 

number and the derivative item number and transferred to the requesting Latent 

Print Examiner via chain of custody 

 Enhance 

o photograph or scan is scaled 1:1, enhanced per Chapters 10 and 11 of the Forensic 

Photography Unit Technical Procedures, and one of the following: 

 Labeled with the CCBI case number and the derivative latent card number 

(Latent Card x-1-1) and copied as a TIFF file to the SPEX Latent Share 

folder 

 Labeled with the CCBI case number and the derivative latent card number 

(Latent Card x-1-1) and copied as a TIFF file to a clean USB drive and 

provided to the requesting Latent Print Examiner 

 Printed and labeled with CCBI case number and the derivative latent card 

number (Latent Card x-1-1-1), sealed in a Latent Envelope marked with 

the CCBI case number and the appropriate derivative item number and 

transferred to the requesting Latent Print Examiner via chain of custody 
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The Latent Print Examiner will verify the CCBI case number and Latent Card number prior to 

transferring images for database searching.  Upon completion of the transfer of images for 

database searching, the Latent Print Examiner will delete all files on the USB drive and return it 

to the Forensic Photographer.  
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Chapter 27: Verification Procedures 
 

Verification is the independent examination by another qualified Examiner resulting in the same 

conclusion. All identifications must be verified.  

Verification occurs when a second, and sometimes a third, qualified Latent Examiner conducts 

an independent ACE process on a latent print identification, and comes to the same conclusion as 

the primary Latent Examiner. 

Those qualified to perform verifications must be: 

1) Certified Latent Print Examiners by the International Association for Identification.   

And/or 

2) Latent Examiners who have been authorized by the Director to conduct technical 

reviews.  have conducted latent examinations, full-time, for a minimum of 7 years, and 

have been tendered, in either state or federal court, as an expert in latent print analysis.  

3) Proficiency tested. 

4) Authorized by the Director to perform verifications. 

Cases being transferred from one Latent Examiner to another for the purposes of verification 

must follow the below protocol: 

1) All evidence transfers must be documented on the chain-of-custody form. For the 

purpose of verification, the verifier will indicate a verification by placing a V within a 

circle near the print identified, their initials, and the date the verification occurred. This 

documentation must be recorded on both the latent lift card and the known standards.   

2) If a verifier is not immediately available to accept a case, the primary Latent Examiner 

must sign the chain-of-custody of the items over to the LEC room, and place the case in 

their “in box verification” area.   

3) The verifier will retrieve cases that are ready to be verified from the LEC room. Upon 

receipt of those cases, the verifier must document the transfer of custody from the LEC 

room to the verifier on the chain-of-custody form.  
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4) Once completed with the case verifications, the verifier may turn the items directly over 

to the primary Latent Examiner, if available, and the chain-of-custody must be updated 

accordingly.  

5) If the primary Latent Examiner is not available, the verifier must turn the verified cases 

back over to the LEC room and document this transaction on the chain-of-custody form. 

6) Verified cases will be placed in the area designated as “verification out boxes” area. The 

primary Latent Examiner will then retrieve their cases from the “verification out box” 

area, and update the chain-of-custody accordingly.  

7) The verifying Latent Examiner will not be required to write a formal report or create 

notes for the identifications being verified, but must place their signature and the date on 

the case notes of the primary Latent Examiner .  However, the verifying Latent Examiner 

may be called to testify in the case in the absence of the primary Latent Examiner. 

8) The latent envelopes and/or other pertinent case evidence items do not have to be sealed 

and unsealed for purposes of verification, as the case is considered to be in progress.   
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Chapter 28: Verification Conflicts  
 

If two Latent Examiners do not come to the same conclusion regarding a possible latent print 

identification, the following protocol shall apply: 

If the identification is erroneous, the supervisor shall notify the Forensic Science Quality 

Manager and the CCBI Corrective Action Policy will apply.   

 

If the identification appears legitimate but a verifier cannot reach the same conclusion as the 

primary Latent Examiner, the impression may be submitted to another qualified Latent Examiner 

for verification. 

 

If the second verifier likewise cannot reach the same conclusion as the primary Latent Examiner, 

the consultations and results thereof of consultations shall be documented in the primary Latent 

Examiner’s case notes appropriately. However, the impression will not be considered or reported 

as a latent print identification. 

 

The result of such an instance will be regarded and documented as an inconclusive result of 

analysis; as the identification did not satisfy the criteria for verification.   

 

The reason for the inconclusive result must be documented in the primary Latent Examiner’s 

case notes.  

 

In the cases where a consultation is requested, if the impression in question does not appear to be 

an erroneous identification, no corrective actions will implemented.   

 

The Latent Examiner who conducts a consult may also verify the identification.  

 

 



 
 

 Page 173 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: 7/14/14        Chapter: LPTP28 
Issued By: CCBI Director       Version: 2 

 

 
 

Revision History 

 

Effective Date 

 

Version 

Number 

 

Reason 

1/1/13 1 Compliance with ASCLD/LAB requirements 

7/14/14 2 Update 

   

   

 

 



 
 

 Page 174 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: 7/14/14        Chapter: LPTP29 
Issued By: CCBI Director       Version: 2 

 

Chapter 29: Latent Print Case Notes and Documentation 
 

Latent examination case analysis data should be documented on the appropriately defined note 

sheets, available in Smart Works, dependent upon the case type.  

The case notes shall include which prints were what evidence was analyzed, compared, 

evaluated and conclusions reached. If there is any latent print evidence in a case that was not 

examined, the existence of that evidence shall be documented in the examiner’s case notes and a 

notation as to why it was unexamined must be documented.  

Each page of the case notes should be numbered, display the initials of the Latent Examiner as 

well as the CCBI case number. The total number of pages must be documented on the first page 

of the technical documents section of the case file, on the Administrative Review form. Double-

sided pages will be counted as two.  

The case notes will be forwarded to the records section in an organized case file folder. 

See Chapter 37 “Case File Organization”  
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Chapter 30: Examination Consultations 
 

A consultation is an interaction between qualified Latent Examiners regarding one or more latent 

print impressions in question. 

The purpose of documenting a consultation is to record information or guidance obtained as a 

result of the consultation.  

Consultations shall be documented and will include: 

- Specific impression(s) reviewed 

- Nature and result of the consultation (e.g., impression in question) 

- Initials of examiner assisting in the consultation.  

- Date of the consultation 

 

Information regarding consultations will be documented on the primary Latent Examiner’s case 

notes.  

A consultation may be conducted by a fully-trained and qualified case working Latent Examiner. 

Forensic Technicians and Latent Examiner Trainees are not qualified to offer opinions in 

consultation cases.  

 

REFERENCES  

 

 

ASCLD/LAB-International Supplemental Requirements for the Accreditation of Forensic 

Science Testing and Calibration Laboratories, American Society of Crime Laboratory 

Directors/Laboratory Accreditation Board, Garner, NC, 2011.  

 

ISO/IEC 17025-General Requirements for the Competence of Testing and Calibration 

Laboratories, International Organization for Standardization, Geneva, Switzerland, 2005.  

 

SWGFAST, Scientific Working Group on Friction Ridge Analysis Approved Guidelines & 

Friction Ridge Examination Methodology for Latent Print Examiners  

 

SWGFAST, Standards for Examining Friction Ridge Impressions. 
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Chapter 31: Limited Identification Case Examinations 

 

In an effort to efficiently utilize the resources of the Latent Print Unit, the Limited 

Identification Program has been established. The following protocol will be 

followed for the Limited Identification Program: 

1) All property crime latent prints of searchable value shall be entered 

in the local, and if applicable, state and federal search databases.   

 

2) Normal protocol for latent print evidence in property crimes subjects 

it to the Limited Identification Program. If advised by the 

investigating authority, limited identification may be used in a 

person’s crime.  The limited identification program is applicable to 

all cases in which a latent print search has yielded a potential 

identification to an individual. 

 

3) If a potential identification is made to an individual, the Latent 

Examiner will attempt to identify the subject to a latent print 

providing the most useful investigative and/or prosecutorial benefits, 

and are applicable to the Principals of Best Evidence (interior 

location vs. exterior location, point of entry vs. non-point of entry). 

 

4) Only one latent print identification shall be made per individual 

generated by database searching in each investigation. 

 

5) A limited identification report will be completed. 
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Chapter 32: Completion of Limited Identification Case Examinations 
 

 

Any investigator who requires having the remainder of the latent prints examined from a Limited 

Identification case must submit a request for completion on a CCBI Laboratory Examination 

Request form.  

 

1) The completion request will be forwarded to the Latent Print Unit. central records. 

A copy of the incoming request must be submitted for management and statistical 

purposes.  

 

2) When possible, the Latent Examiner who completed the limited identification will 

be assigned the completion of the case. 

 

3) The entire case shall be compared and a completion report will be generated. 

 

4) Upon its completion, a copy of the request must be submitted for management and 

statistical purposes.  

 

5) In instances when a completion request is received, and additional names of 

individuals to be compared are listed, all individuals will be compared and a full 

case report will be produced. The report for this scenario will be a full case report; 

however, elements of the completion report will be utilized in an effort to prevent 

duplicate identification information from being reported.  

 

 

See appendix for Full Case note sheet, Completion Report template. 
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Chapter 33: Full Latent Print Case Examinations 
 

Full latent print case examinations will be completed by the Latent Examiners in person’s crimes 

cases (unless otherwise requested by the investigating authority) and cases in which a request for 

comparison was received to compare the latent prints collected against the known prints of 

specific individuals. 

1) A full case examination entails the complete examination of all latent prints in a case to 

all requested (and available), or database generated, known prints.  

2) If any Latent Examiner has previously made an identification and produced a report in a 

case, the assignment for additional analysis should, when possible, be returned to the 

original Latent Examiner.  

3) Once the case has been completed, the Latent Examiner will produce a full case report.  

See appendix for Full Case note sheet and Full Case report template.  
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Chapter 34: Notification Procedures  
 

Rapid notification:  

Rapid notification will be sent to investigators advising of latent print identifications effected and 

verified by the Latent Examiners in cases typically involving residential burglaries and person’s 

crimes. Notifications of latent identification for other crime types may occur depending on the 

circumstances of the investigation.  

1) When possible, written notifications will be sent to the investigating agency advising of 

latent print identifications.  

2) Such notifications should be sent via electronic mail, and a copy of the notification will 

be retained in the CCBI case file.  

3) If notification is made by telephone, a communication form sheet should be completed 

and maintained in the case file.  

4) These rapid notifications, however, are not and should not be considered as reports. 

5)  The purpose of the rapid notifications is to provide expedited information to 

investigating agencies, thereby eliminating a potentially long wait-time for the publishing 

of the latent print reports.  

The procedure for the dissemination of rapid notification information is as follows:  

1) The original latent examiner submits the case to the verifier.  

2) The verifier conducts the review. 

3) Upon completion of the review, the verifier creates the e-mail notification.  

4) The verifier forwards the e-mail notification to the original examiner.  

5) The verifier returns the case to the original examiner.  

6) Once the original examiner receives both the rapid notification email and the case file 

from the verifier, the original examiner will check the accuracy of the information 

contained in the rapid notification email.  

7) If all information is correct, the original examiner may forward the rapid notification 

email to the appropriate law enforcement agency. 
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The rapid notifications should not exceed one case per email. Additionally, the verifier must 

create the email immediately upon the completion of the verification, and forward it to the 

original examiner before beginning a verification for another case.  

 

Monthly notification:  

Monthly, an excel spreadsheet is generated that provides latent print identification information to 

investigators for intelligence and investigative purposes.   

1) The spreadsheet is generally e-mailed to Law Enforcement Agencies during each 

calendar month.   

2) The monthly spreadsheet includes information for all individuals whose prints were 

identified in a case.  

Cases listed on the monthly spreadsheet have already been administratively reviewed, and those 

reports have been published. 
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Chapter 35: Communication Documentation  
 

Communication between Latent Examiners and investigators is a common part of the general 

work process. However, communications involving specific case information, details, 

instructions, or significant case information must be documented as part of the Latent 

Examiner’s case file.  

Examples of instances for which communication must be documented include, but are not 

limited to:  

- Rapid notification by e-mail 

- Rapid notification via telephone or in person 

- Specific case instructions by an investigator, prosecutor or any pertinent communication 

(i.e., the use of Limited Identification Case Examination for a person’s crime). 

- Verbal discussions  

All communication information should include: 

- The date and time of the communication  

- The person with whom the Latent Examiner communicated  

- An overview of the context of the communication 

- The method of communication, if not readily apparent  

The communication documentation will be placed in the Latent Examiner’s case file, and 

organized as part of administrative documents.  

 

 

REFERENCES 

ASCLD/LAB-International Supplemental Requirements for the Accreditation of Forensic 

Science Testing and Calibration Laboratories, American Society of Crime Laboratory 

Directors/Laboratory Accreditation Board, Garner, NC, 2011.  
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ISO/IEC 17025-General Requirements for the Competence of Testing and Calibration 

Laboratories, International Organization for Standardization, Geneva, Switzerland, 2005.  
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Chapter 36: Creating Known Footwear Standards for Examination  
 

There is no single best process for the creation of known footwear standards, since results 

depend to an extent upon the particular items and conditions of the case. 

Since the various methods are non-destructive and not sequence dependent, the Latent Examiner 

may choose one by personal preference, and continue to apply additional techniques as necessary 

to maximize results. These variations in processing techniques typically do not influence the 

validity of the test procedure.  

The following is a list of methods for the creation of footwear standards: 

1) The outsoles of the known shoes may be photographed, and the photographic 

representation of the outsoles can be used for illustrative purposes of an elimination 

against the questioned impressions.  

2) Biofoam may be used to create a three-dimensional representation of the known shoe. 

Biofoam is a material which can be compressed by the known shoe creating an 

impression in the foam. Then, dental stone, or some other casting medium (such a 

Mikrosil) is poured/applied to the indented portion of the Biofoam, and is allowed to dry. 

Once dry, the cast is removed and can be utilized as a known standard for comparison 

against the questioned impressions.  

-To mix Dental Stone, place Dental Stone powder in a gallon-sized plastic bag. 

Use as much Dental Stone powder as you think is necessary to fill the impression. 

Mix with just enough water to make the Dental Stone the consistency of pancake 

batter. Gently pour the Dental Stone into the Biofoam impression. Carefully 

agitate the top layer of Dental Stone to try and remove any air bubbles. The 

Dental Stone needs at least one hour of drying before it should be handled, and 

may require as many as 24 hours to dry thoroughly. After the Dental Stone is dry, 

remove the cast from the Biofoam and gently clean the cast.   

-To mix Mikrosil, mix the putty and catalyst on a mixing card with a spatula and 

apply it to the surface being cast.  

3) The Identicator Kit is an inkless recording system that allows for the recording of 

impressions for known standards. The outsoles of the known shoes are pressed against a 

pad containing an inkless chemical residue. Once the outsoles are coated with the residue, 

they are pressed against a white backing card and the images of the outsoles appear.  
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4) Fingerprint powder and lifting tape is a commonly used method of creating known 

standards for footwear examination. A thin coat of fingerprint powder is applied to the 

outsole of the known shoes, and then the adhesive side of lifting tape is placed over the 

entire surface of the outsoles. The tape is slowly peeled off the outsole, revealing an 

image of the outsole. The tape is then placed on a white backing card. It is important to 

note from exactly which shoe the image was collected, as the known standards will 

appear the reverse of the actual item. Once the known standards are generated, 

photocopies on clear acetate sheets are made to create over-lays.  

5) Occasionally, the sole of the known shoes may be coated with Vaseline, or a similar 

transfer medium, and the shoe is pressed against a white backing card. Then the white 

backing card is processed with fingerprint powder revealing the impression of the 

outsole. The impression is then covered with clear tape to protect and preserve the 

impression.  

6)  A method similar to using fingerprint powder and lifting tape is the use of ink/fingerprint 

powder and white contact paper. A thin coat of ink or fingerprint powder is applied to the 

outsoles of the known shoes, and then the adhesive side of the white contact paper is 

placed over the entire surface of the shoe’s outsoles.  The contact paper is peeled away 

from the outsole revealing the impression. A protective, transparent sheet of plastic is 

placed over the impression. 

The Latent Examiner may decide to use any of the above-listed methods, or any variation of 

the above-listed methods, to create the known standards for footwear examination  

The known standards must be an exact replication of the outsole of the known shoe to allow 

for a conclusive examination with the questioned impression the known standards must be 

free of artifacts that could affect the examination process.  

All known standards created for case examination are considered and handled as evidence 

items, and will be released to the custody of the contributing agency upon the completion of 

the footwear examination.  

REFERENCES: 

Recommended Course of Study for Footwear &Tire Track   Examiners, International 

Association for Identification 

 

Footwear Identification, Michael J. Cassidy, 1980 

 

Footwear Impression Evidence: Detection, Recovery, and Examination, 2nd Edition, 
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William J. Bodziak, 1999 

 

SWGTREAD, Guide for the Preparation of Test Impressions from 

Footwear and Tires 
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Chapter 37: Footwear Examination Procedures 
 

The Latent Print Unit will provide footwear examination services to the Wake County law 

enforcement community.  Latent Examiners assigned to a footwear examination function shall 

have received appropriate training and qualifications commensurate with such duties.  CCBI 

shall rely on generally accepted documentation and methodology, ACE-V, when conducting 

footwear examinations. 

Latent Examiners performing footwear examination functions shall adhere to the following: 

Documenting Questioned Impressions 

The Forensic Latent Examiner receiving footwear impressions shall document the received 

impression to include the evidence item number, particularly describing details of the impression 

and the type of surface or medium on which the impression was submitted, and shall mark each 

item with the Examiner’s initials and date in manner not to hinder the evidentiary value of the 

impression.   

Documenting Known Shoes 

Known shoes submitted to the Latent Print Unit shall be done so according to CCBI evidence 

submission policies.  Upon examination of such items, the Latent Examiner conducting the 

examination shall document the shoe information to include brand, size, outsole design, 

condition, any other particularly describing details and whom the shoe was collected from, if 

known. 

Creating Known Standards 

The examining Latent Examiner will prepare known standards from all submitted known shoes 

that will be used for examination purposes.  The preparation of known standards from known 

shoes submitted for examination that are not believed to be necessary for the completion of the 

examination, and will be done at the discretion of the Latent Examiner. 

Known standards collected/prepared will be considered evidence, and will be documented and 

transferred accordingly.  The Latent Examiner preparing the known standards will 

photographically document the original condition of the known shoe prior to creating the known 

standard, when deemed necessary.  Subsequent documentation should be collected describing the 

procedure and method used to prepare the known standard.   
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See chapter 34 “Creating Known Standards for Footwear Examination”  

The Footwear Examination 

The ACE-V methodology will be used in all footwear examinations.  

Analysis, Comparison, Evaluation and Verification (ACE-V)  

Analysis: analyze the questioned impression of evidence for information regarding the quality, 

quantity, clarity and comparative potential. 

 

Factors considered include the following: 

 

 Quality (clarity) and quantity of detail 

 Factors influencing quality include: 

 Residue/matrix 

 Deposition 

 Surface/substrate 

 Environment 

 Development medium 

 Preservation method 

- Consider enhancement potential when conducting the above-mentioned analysis 

- Note the presence or absence of class characteristics 

- Note the design, physical size, physical shape and wear features. 

- Analyze the known impression for the same information. 

 

Comparison: a direct or side-by-side observation between the questioned and known 

impressions to the corresponding/non-corresponding information.  

- Note design, physical size, and physical shape correspondence/non - correspondence   

between the questioned and known impressions. 

- Note the position and degree of general wear correspondence/non correspondence 

between the unknown and known impressions.  Document and evaluate possible wear 

changes between date of crime and date shoes were recovered. 

- Note the presence or absence of individual characteristics (cuts, scrapes, wear pattern 

that causes unique tearing, etc.).  Such characteristics should be noted according to 

their position, size, shape, orientation and clarity. 

 

Evaluation: Evaluation is the formulation of a conclusion based upon analysis and comparison 

the known shoe and unknown shoe impressions.  The following are opinions that can be 

rendered:  
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Results 

The following standards shall be used for reporting the results of a footwear examination: 

 Identification:  A definite conclusion of identity.  This is the highest degree of 

association expressed in footwear examination.  This opinion means that the 

particular shoe made the questioned impression to the exclusion of all other shoes. 

 Probably made:  A very high degree of association.  This opinion means that the 

evidence is very persuasive that the shoe made the impression, yet some critical 

feature or quality is lacking and/or missing so that an identification is not in order. 

 Could have made:  A significant association of multiple class characteristics.  

This opinion means that the design and physical size correspond, and there may 

also be some correspondence of the general condition of wear.  However, it must 

also be noted that the unknown impression could have been made by that shoe or 

another shoe with the same class characteristics. 

 Elimination:  Definite exclusion.  This is the highest degree of non-association 

expressed in footwear examinations.  This opinion means that the particular shoe 

did not make the questioned impression. 

 Unsuitable:  Lacks sufficient detail for meaningful comparison.  This opinion 

means that insufficient detail was present in the questioned impression to enable 

any meaningful comparison with any known shoe. 

 

Lacks sufficient detail 

No comparison was conducted: the examiner determined there were no discernible questioned 

footwear impressions or features present. This opinion applies when there is insufficient detail to 

conduct any comparison. In the opinion of the examiner, an impression was either not present or 

the impression lacked sufficient detail for any comparison. A comparison was conducted: the 

examiner determined that there was insufficient detail in the questioned impression for a 

meaningful conclusion. This opinion only applies to the known footwear that was examined and 

does not necessarily preclude future examinations with other known footwear. In the opinion of 

the examiner, the impression lacked sufficient detail for a meaningful conclusion regarding the 

particular known footwear outsole. 

 

 

Exclusion  
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This is the highest degree of non-association expressed in footwear and examinations. Sufficient 

differences were noted in the comparison of class and/or randomly acquired characteristics 

between the questioned impression and the known footwear. In the opinion of the examiner, the 

particular known footwear was not the source of, and did not make, the impression. 

Indications of non-association  

The questioned impression exhibits dissimilarities when compared to the known footwear; 

however, the details or features were not sufficiently clear to permit an exclusion. In the opinion 

of the examiner, dissimilarities between the questioned impression and the known footwear 

indicated non-association; however, the details or features were not sufficient to permit an 

exclusion. 

Limited association of class characteristics  

Some similar class characteristics were present; however, there were significant limiting factors 

in the questioned impression that did not permit a stronger association between the questioned 

impression and the known footwear. These factors may include but were not limited to: 

insufficient detail, lack of scale, improper position of scale, improper photographic techniques, 

distortion or significant lengths of time between the date of the occurrence and when the 

footwear was recovered that could account for a different degree of general wear. No 

confirmable differences were observed that could exclude the footwear. In the opinion of the 

examiner, factors (such as those listed above) have limited the conclusion to a general 

association of some class characteristics. Other footwear with the same class characteristics 

observed in the impressions is included in the population of possible sources. 

Association of class characteristics  

The class characteristics of both design and physical size must correspond between the 

questioned impression and the known footwear. Correspondence of general wear may also be 

present. In the opinion of the examiner, the known footwear is a possible source of 

the questioned impression and therefore could have produced the impression. Other footwear or 

tires with the same class characteristics observed in the impression are included in the population 

of possible sources. 

High degree of association  

The questioned impression and known footwear must correspond in the class characteristics of 

design, physical size, and general wear. For this degree of association there must also exist: (1) 

wear that, by virtue of its specific location, degree and orientation make it unusual and/or (2) one 
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or more randomly acquired characteristics. In the opinion of the examiner, the characteristics 

observed exhibit strong associations between the questioned impression and known footwear; 

however, the quality and/or quantity were insufficient for an identification. Other footwear with 

the same class characteristics observed in the impression are included in the population of 

possible sources only if they display the same wear and/or randomly acquired characteristics 

observed in the questioned impression. 

Identification  

This is the highest degree of association expressed by a footwear and tire impression examiner. 

The questioned impression and the known footwear or tire share agreement of class and 

randomly acquired characteristics of sufficient quality and quantity. In the opinion of the 

examiner, the particular known footwear was the source of, and made, the questioned 

impression. Another item of footwear being the source of the impression is considered a practical 

impossibility. 

 

Review/Verification 

1) All footwear cases/footwear identifications are to be reviewed and/or verified by 

another competent an Examiner authorized by the Director to conduct technical 

reviews and/or verifications.  Therefore, after the primary Latent Examiner has 

completed the examination, the case will be turned over to another Examiner for 

an independent review of the case. 

2) The primary Examiner and the verifier will maintain chain-of-custody for 

evidence transfer as noted in applicable CCBI evidence policies. 

3) The primary Examiner’s note sheet will display the date of receipt of the 

evidence, the results of the independent analysis, and the date of return of the 

evidence.  If the evidence remains in the custody of the primary Latent Examiner 

while the review/verification process occurs, then it is not necessary to transfer 

custody of the evidence items.  Rather, a notation that the review/verification 

occurred in the presence of the primary Examiner should be recorded in the case 

notes. 

4) The verifying Examiner will not be required to write a formal report in the case.  

However, the verifying Examiner may be called to testify in the case in the 

absence of the primary Latent Examiner. 

 

REFERENCES 

 

 

Footwear Impression Evidence: Detection, Recovery, and Examination, 2nd Edition, 
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William J. Bodziak, 2000 

 

Shoe Outsoles as Applicable in Footwear Impression Comparisons. Journal of Forensic 

Sciences September 1988; 33(5). 

 

Recommended Course of Study for Footwear &Tire Track   Examiners, International 

Association for Identification 

 

SWGTREAD, Guide for the Examination of Footwear and Tire Impression Evidence 

 

SWGTREAD, Scientific Working Group for Shoeprint and Tire Tread Evidence, 

Published Standards 

 

SWGTREAD, Range of Conclusions Standards for Footwear and Tire Impression 

Examinations (03/2013) 
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Chapter 38: Footwear Case Notes and Documentation  
 

Written or otherwise documented information (including footwear photographs) created by a 

Latent Examiner in regards to case work is to be considered as case notes, and must be turned 

over to records upon the completion of the case work.  

Notes can be in the form of handwritten or typed observations, annotated photographs with 

arrows, lines or other symbols to mark the details used to render a conclusion, overlays of known 

standards attached to the photographs of questioned impressions, and any other suitable ways to 

document observations. 

Footwear examination case analysis data should be documented on the footwear examination 

note sheet. All information should be documented in such a manner as to be legible and 

comprehensible by another person.  

The case notes shall include which questioned impressions were analyzed, compared, evaluated 

and conclusions reached. If there is any footwear evidence in a case that was not examined, the 

existence of that evidence shall be documented in the Examiner’s case notes and a notation as to 

why it was unexamined must be documented.  

Each page of the case notes should be numbered, display the initials of the Latent Examiner as 

well as the CCBI case number. The total number of pages must be documented on the first page 

of the technical documents section of the case file. Double-sided pages will be counted as two.  

The case notes will be submitted to the records section in an organized case file folder. 

 

REFERENCES 

 

Footwear Impression Evidence: Detection, Recovery, and Examination, 2nd Edition, 

William J. Bodziak, 2000 

 

SWGTREAD, Scientific Working Group for Shoeprint and Tire Tread Evidence, 

Published Standards 

 

SWGTREAD, Standard Terminology for Expressing Conclusions of Forensic Footwear 

and Tire Impression Examination 
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SWGTREAD, Standard for Terminology Used for Forensic Footwear and Tire 

Impression Evidence 
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Chapter 39: Case File Organization 
 

 

The Latent Examiners will create case files for every new case analysis conducted.  

 

Technical records consist of the following:  

 

- Note sheets of any types 

- Draft copies of reports 

- Database generated case information 

- Known standards or copies of known standards 

- Technical review forms 

- Administrative review sheet (case notes cover sheet)  

- Copies of items received in evidence packages (i.e., non-testimonal orders, known 

standards received as evidence items, etc) 

- Any other documents created during the examination process (i.e. photographs, 

charts, enhancements, etc).  

 

Once the case file documentation has been complied in a manila folder, and after the 

Administrative Review, it may be turned over to the records section for filing.  

 

See Laboratory Administrative Procedures Manual, Chapter 11, page 43, section “Laboratory 

Case Record Contents, Management, and Retention”.  
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Chapter 40: Reports  
 

At the conclusion of a comparative latent print analysis, the Latent Examiner is required to 

author a report which clearly indicates the results of their examination.  

Standard reports generated by the Latent Print Unit include:  

- Full case examinations  

- Limited identification reports 

- Completion of limited identification reports 

- Identification of Unknown/Unknown Deceased Individuals 

- Ten Print Examination reports 

- Footwear examination reports 

- Technical field assistance reports (i.e. OCME/crime scene response, etc) 

- SICAR reports 

 

Specifically concerning results involving latent print analysis, the Latent Examiner must 

articulate the results of the analysis utilizing the following statements in full case examinations 

and completion of limited identification reports:  

 

Latent Unit report statements 

1) IDENTIFICATION STATEMENTS: 

 

Finger # __ (reference finger) of ___________ was identified ______ (#) time/s. 

The _____ palm of __________ was identified _________ (#) time/s.  

 

2) EXCLUSION STATEMENTS (subjects excluded as the source/s of the latent print 

evidence on specific latent print lift cards): 

 

For a portion of a lift card: 

 

 _________was/were excluded as the source of the remaining latent print impression/s on this lift 

card. 
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For an entire lift card: 

__________was/were excluded as the source of the latent print impression/s on this lift card. 

 

3) INCONCLUSIVE STATEMENTS (the result of the analysis for the latent prints on 

specific latent print lift cards is declared inconclusive). 

 

For a portion of a lift card: 

 

The examination results of the remaining latent print impression/s on this lift card against the 

known standards of (list names) are inconclusive due to (poor quality known standards, 

incomplete known standards, poor quality latent impressions, etc).   

 

For an entire lift card: 

The examination results of the latent print impression/s on this lift card against the known 

standards of (list names) are inconclusive due to (poor quality known standards, incomplete 

known standard, poor quality latent impressions, etc). 

 

4) INSUFFICIENT STATEMENTS: 

 

For a portion of a lift card: 

 

The remaining latent print impression/s on this lift card contains insufficient ridge detail for 

comparison or identification. 

For an entire lift card: 

The latent print impression/s on this lift card contains insufficient ridge detail for comparison or 

identification.  

5) NO REMAINING LATENT PRINTS  STATEMENT:  

There were no remaining identifiable latent print impressions on the lift cards as listed in this 

report. 
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Modifications to report statements 

 

In situations when there are more than two report statements applicable to any one lift card, the 

phrase “any additional remaining” may be added to the last report statement to provide clarity. 

 

Utilizing the words “Any other” on a third report statement of a lift card can also serve to 

eliminate the word “remaining” from being used redundantly. The “Any other” statement would 

read, in the example of an insufficient report statement, as follows: 

 

Any other (“The remaining” having been replaced) latent print impression/s on this lift 

card contain insufficient ridge detail for comparison or identification. 

  

For new reports referencing previously reported latent print identifications 

 

In the event that a new analysis is being conducted in a case which has previous latent print 

identifications, the following statement should be utilized to prevent misinterpretation by the 

reader, and duplication of information. Whenever possible, efforts should be made to prevent the 

reporting of duplicate latent print identification information.  

 

A previous identification was made to NAME OF PERSON; see latent print 

supplemental report dated 010114 (reference the date that report was approved as part of 

the administrative review), by Forensic Examiner ****** (only if previous identification 

was made by a different Examiner).   

 

This previously identified individual’s information should not to be added to the new report 

heading, and should therefore only exist in this statement in the body of the latent report. In this 

manner, the reader will be guided to the previous latent reports published for that case.  

 

Any additional modifications must be documented on an exception to policy form; see Chapter 9 

“Exceptions”, of the Laboratory Administrative Procedural Manual. deviation to the above 

referenced report statements must be approved by the Forensic Supervisor or Lead Latent 

Examiner, and any changes will be considered on a case by case basis.  

 

For amended reports, see the Laboratory Administrative Procedures Manual, Chapter 12, page 

53, sections “Amendments and Modifications”, and “Modifications”.  

 

See appendix for report templates. 
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Chapter 41: Symbols and Standard Notations for Latent Print Marking. 
 

For purposes of being able to identify lift cards used in analysis, the standard markings on the 

latent print lift cards by the Forensic Technician/Latent Print Examiners should consist of, at a 

minimum: 

- the unique CCBI case number  

- the individual’s initials 

These markings should exist on lift cards for which any examination was conducted.  

For example, the first individual to open a latent envelope and examine the latent evidence for 

database quality purposes will be required to mark all lift cards with the unique case number and 

his/her initials.  

If the case requires a partial examination,  for a Limited Identification case, the Forensic 

Examiner will need to  add his/her initials to the markings created by the first Forensic 

Technician/Examiner (if different) who examined the latent evidence for database search, on 

only the lift cards evaluated as part of the comparative analysis.  

In the case of a full examination, all lift cards should contain the unique agency case number as 

well as the initials of the individual/s (if different) who screened the prints for database search 

and conducted a full case comparative analysis. The Forensic Examiner conducting the full case 

can simply add their initials to the pre-existing markings.   

 

Latent impressions of value for identification 

To indicate a latent fingerprint of value for identification, place a semi-circle over the top of the 

print. The semi-circle should be placed over the top of the latent fingerprint as noted below, to 

illustrate the correct anatomical position of the finger.  
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To indicate a latent palm print of value for identification, place a bracket at the base of each 

latent palm print as noted below, to illustrate the correct anatomical position of the palm.  

  

 

To indicate joints or other unknown impressions of value for identification, place parallel lines 

alongside the impressions, as illustrated below.  

 

Joints:      Unknown friction ridge impression (finger, joint, 

palm): 
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If the anatomical position of the impression cannot be ascertained, place a “imp?” on the lower 

right side of the markings, as referenced below:  

Imp? 

Identification marking 

When indicating an identification on the latent lift card, place the identification symbol , Ø, near 

the print that was identified. The following information must also be present: finger 

number/palm, person identified, date the identification was effected, and the initials of the 

examiner. The identification markings should be as close as possible to the latent print identified 

as to allow for the markings to be permanent. See the below example. 

 

Ø #5 of John Smith 

RH 12/12/12 

 

Verification marking 

When a latent print identification is being verified, the verification information should be marked 

as closely to the print as possible to allow for permanent marking. The following verification 

information must be present:  finger #/palm, first initial and last name of person identified, Ø , V 

encircled, verifier’s initials, and the date of the verification. See the below example: 
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 Ø #5 J. Smith V RM 12/12/12 

Ø #5 John Smith RH 12/12/12  

  

 

Known standard marking 

The known standard finger/palm print card must also be marked to indicate the approximate 

location of area utilized for the identification. The ten-print card marking for the identification is 

as follows: the Ø symbol, the examiner’s initials, and the date of the identification. Verification 

marking generally requires the same information, with the additional V encircled, preceding the 

verifier’s initials. An example is provided below:  

 

                 #5 J. Smith Ø RH 12/12/12      

 Ø #5 J. Smith V RM 12/12/12 

  

 

 

 

Markings to indicate latent prints Not not of value for comparison or identification. marking 

If there are no latent prints of value to identify, indicate such by placing “NV” at a corner of the 

lift that is being referenced as no value. An example is provided below. 



 
 

 Page 214 of 257 
All copies of this document are uncontrolled when printed 

Raleigh/Wake City-County Bureau of Identification 
Latent Print Unit Technical Procedures Manual 

 
Issued: 7/14/14        Chapter: LPTP41 
Issued By: CCBI Director       Version: 2 

 

NV

    

 

When latent print impressions have been entered into a database system for searching, use the 

following markings to indicate which prints were entered into which database system: 

 Local Search = a dot is placed over the top of the print  

 State Search = “SS” is placed over the top of the print, near the dot 

 Federal Search = “FS” is placed over the top of the print, near the “SS 

                                                    SS, FS  
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Simultaneous impression marking 

Simultaneous impression marking consists of connected semi-circle formations placed over the 

top of the impressions. The markings will indicate the correct anatomical position for the prints. 

See the below example:  

                                              

 

The simultaneous markings should only be placed over the impressions when the latent prints are 

being identified to an individual, and not as part of the analysis process.  

REFERENCES: 

SWGFAST, Standard for The Documentation Of Analysis, Comparison, Evaluation, And 

Verification (Ace-V)(Latent) 
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Chapter 42: Post-mortem Print Collection/Major Case Style Print Collection 
 

There are occasions when a Latent Examiner may need to collected major case style prints, or 

bare foot prints, as part of an investigation.  

Such scenarios include, but are not entirely limited to:  

- Responding to the Office of the Chief Medical Examiner (OCME) for the purpose of 

collecting major case style post-mortem prints. 

- Collecting major case style prints as requested by an investigator in response to a 

court order. 

- Collecting major case style prints as requested by an investigator for by consent as 

part of an elimination process.  

- Collecting major case style prints due to inconclusive examination results caused by 

insufficient known standards. 

In every scenario, the major case style impressions are collected as evidence items and will be 

handled accordingly. At the time the items are received as evidence items, a request for print 

comparison is also received, unless there is a specific reason for why an investigator would not 

need a comparison performed (no latent evidence collected from the scene, for example).  

At the conclusion of the comparative print analysis, the impressions will be turned over to the 

contributing agency via proper evidence handling protocol.  

Major case style impressions are defined as the collection of all the friction ridge skin 

impressions on the hands/feet. This includes the tips of the fingers/toes, joints, sides of the 

fingers/toes, and all the surfaces of the palms of the hands and/or soles of the feet.   

At the request of the Deputy Director of the Crime Lab or the Forensic Supervisor of the Latent 

Print Unit, the Latent Examiners may be directed to respond to the office of the Chief Medical 

Examiner (OCME) for the purpose of collecting post-mortem major case style impressions from 

the hands, and/or feet, from deceased individuals.  

The impressions will be collected as evidence items in the case, and a Technical Field Assistance 

report will be generated. Case notes will be added to the case file and turned over to central 

records. The impressions should be sealed in an evidence envelope and submitted to the 
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Evidence Receiving Unit for acceptance to the laboratory unless outside normal business hours 

and there are exigent circumstances that warrant immediate examination.  In this case, the Latent 

Examiner may submit the known impressions directly into the latent unit (following appropriate 

protocol); however, they must still be submitted and received in a sealed condition. 

See the Laboratory Administrative Procedural Manual, Chapter 8, for further information 

regarding the receipt of evidence items by latent unit staff members outside of regular work 

hours.   

If impressions are not needed by the Latent Print Unit for comparison purposes, they will be 

forwarded to the contributing agency per normal evidence transaction procedures.  

Should the impressions be needed by a Latent Examiner for a comparative analysis, the items 

will be submitted to the case-assigned Latent Examiner, or placed in the Latent Print Evidence 

Control room to pend until the case is assigned to a Latent Examiner.  

Diligence should be taken by any Latent Examiner responding to the OCME, to remain 

cognizant of the biohazard materials with which the Latent Examiner will be in contact. Personal 

protective equipment shall be utilized by the Latent Examiner in an effort to reduce or eliminate 

contact with any biohazard materials. Personal protective equipment may include the following: 

- Disposable latex gloves 

- Protective lab coat or protective gown 

- Eye protection 

- Footwear covers 

Additionally, any items that have come in contact with biohazard materials should be 

appropriately discarded, or thoroughly cleaned with a disinfectant cleaning agent, such as a 10% 

bleach solution.  

The post-mortem prints, as well as their evidence package, should be clearly labeled as 

“biohazard”. 

Methods for the collection of major case style impressions, including post mortem impressions, 

are listed below. 

 

Apply fingerprint powder evenly to all the surfaces of friction ridge skin. The powder is best 

applied with cotton swabs, and best recorded using contact paper.  
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The contact paper is affixed directly to the areas of the skin coated with powder, and then slowly 

peeled away revealing the friction ridge impressions. The contact paper is then applied to clear 

acetate sheets or clear plastic sleeves to preserve the images.  

 

This procedure may not be advisable, however, in instances where there are signs of 

decomposition, slippage or tearing of the skin.  

 

If fingerprint ink is applied, it is best applied to the skin using an ink roller, or by pressing the 

friction ridge skin against an ink pad. Once the friction ridge surface is coated in ink, the skin is 

pressed lightly against a white or light colored paper or fingerprint card to capture the 

impressions.  

 

The post-mortem print spoon and slivers of paper may be used to capture fingerprint impressions 

recorded with ink.  

 

These methods can be used multiple times in an attempt to capture the best possible impressions. 

They may also be used in conjunction with one another.  

 

It is important to thoroughly document from where each impression was collected, even if 

multiple impressions from the same area were created. Ensure that all impressions are properly 

marked with the finger/palm from which they originated.  

 

See Laboratory Administrative Procedures Manual, Chapter 20.  

 

REFERENCES 

 

Buckingham, A. “The Use of Plastic Receiving Surfaces in the Fingerprinting of 

Mummified Finger.” Journal of Forensic Identification. Vol. 44,3:251-253 (June 1994)  

 

Cutro Sr., Brent T., The Fingerprint Sourcebook, Chapter 4, Recording Living and 

Postmortem Friction Ridge Exemplars, International Association for Identification, et al., 

2001, pages 4.3-4.17.  

Cowger, J.F., Taking Inked Prints, Friction Ridge Skin, Comparison and Identification of 

Fingerprints, CRC Press, Boca Raton, Florida, 1993, pages 9-33.  

 

“FBI Problems and Practices in Fingerprinting the Dead.” FBI Law Enforcement 
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“Proper Procedure for Taking Major Case Prints.” FBI Law Enforcement Bulletin, (July 
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Chapter 43: Processing of Hands/Feet of Deceased Individuals. 
 

When a Latent Examiner processes the hands/feet of deceased individuals in the CCBI lab, the 

following protocol will apply:  

 

Equipment and materials which may be necessary during the processing include: 

- Gloves (numerous pairs) 

- Face shield visor, surgical mask, and/or safety goggles 

- Lab coat or apron 

- Scalpel handle/s, scalpel blade/s 

- Fingerprint powder (dark) 

- Fingerprint brush/wand/cotton 

- Fingerprint ink 

- Ink slab 

- Postmortem printing spoon 

- White contact paper 

- Fingerprint cards, white paper, clear acetate sheets, clear plastic sheets 

- Soft bristled brush 

- Digital camera 

- Measuring device (scale)  

 

Reagents 

- Tissue builder & syringe/s 

- Isopropyl alcohol 

- Mild soap/detergent  

- 10% bleach solution 

 

This work should be conducted in the CCBI wet lab (C1379).  The vehicle examination bay may 

also be used, if necessary.  

 

Prepare the work area using a clean paper liner in the fume hood and on the counter space. 

Organize all necessary equipment and supplies accordingly.  

 

Wearing personal protective equipment, place the container with the hands/feet in the sink. 

Remove the items from the container, and if soiled, rinse gently with water and mild detergent. If 

any residues remain on the friction ridge areas of the items, a soft bristled brush may be used to 

attempt to dislodge the debris from the friction ridge surfaces. After the items have been rinsed, 

remove the moisture using disposable paper towels, and then allow the items to air dry in the 

fume hood. The container, lid, and any other substances contained within (i.e. fluids), may 

remain in the sink.  
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Once dry, inspect all surfaces thoroughly for areas of significant friction ridge detail.  

 

Apply either fingerprint powder or fingerprint ink to any significant friction ridge skin areas.  

 

If fingerprint powder is applied, it is best applied with cotton swabs, and best recorded using 

contact paper. The contact paper is affixed directly to the areas coated with powder, and then 

slowly peeled away revealing the friction ridge impressions. The contact paper is then applied to 

clear acetate sheets or plastic sleeves to preserve the images.  

 

This procedure may not be advisable, however, in instances where there are signs of 

decomposition, slippage or tearing of the skin.  

 

If fingerprint ink is applied, it is best applied to the skin using an ink roller, or by pressing the 

friction ridge skin against an ink pad. Once the friction ridge surface is coated in ink, the skin is 

pressed lightly against a white or light colored paper or fingerprint card to capture the 

impressions.  

 

The post-mortem print spoon and slivers of paper may be used to capture fingerprint impressions 

recorded with ink.  

 

These methods can be used multiple times in an attempt to capture the best possible impressions. 

They may also be used in conjunction with one another.  

 

It is important to thoroughly document from where each impression was collected, even if 

multiple impressions from the same area were created. Ensure that all impressions are properly 

marked with the finger/palm from which they originated.  

 

For post-mortem collections during the processing of removed hands/feet, if the remains are 

shriveled, but ridge detail is still present, the remains may be soaked in a tray of tap water in an 

attempt to rehydrate, or a commercial tissue builder may be injected into the fingers or palms 

using a syringe. Inject tissue builder into the tips of the fingers or the side of the palm so as not to 

destroy any ridge detail. Inject enough tissue builder to add pliability and restore the finger/palm 

to the approximate original state.  

 

If the tissue builder injection or soaking is successful, the remains may then be inked or 

powdered as described above.  

 

If unsuccessful, carefully clean the ink/powdered from the remains using a soft bristled brush 

and alcohol. The remains may be rinsed and patted dry as needed.  

 

Using a scalpel handle and blade, carefully and slowly remove the layers of skin containing ridge 

details as one solid sheet or large pieces. Ensure that each piece of skin is placed is in a container 
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and is labeled as to its origin. In some instances, the remains may be in such a state of 

decomposition that the finger/palm skin may be removed without an attempt first being made to 

take the impressions with the skin attached to the hands.  

 

Each piece of skin will then be photographed with a measuring device, inked, and/or powdered 

as referenced in the procedures mentioned above.  If necessary, the skin may be placed over the 

gloved fingers and/or hands of the Latent Examiner to assist in the capture of the best possible 

impressions.  

 

The collected impressions shall be considered as evidence items, and must be properly marked 

and handled as such.  

 

Once the best possible impressions have been collected, the remains and any additional items 

produced as a result of the processing (i.e. skin and/or palm pieces) may be returned to the 

original container. The container should then be sealed appropriately. Place the container in the 

refrigeration area designated as the “Evidence Refrigerator 1” for storage until it can be returned 

to the Office of the Chief Medical Examiner, or a representative of the contributing agency.  

 

The method/s used to obtain impressions from human remains shall be determined by the Latent 

Examiner. Each set of remains shall be examined independently and various methods of 

collecting impressions as described above may be utilized.  

 

In some cases, it may not be possible to collect friction ridge impressions due to the poor quality 

of the remains. The amount of deterioration to the remains will dictate whether or not the attempt 

to collect post mortem impressions will be successful.  

 

It is important that the appropriate personal protective equipment be used by the Latent Examiner 

during the processing of human remains. Additionally, the processing of such items must be 

conducted in the fume hood, or in the vehicle garage utilizing the ventilation air tube devices.  

 

Extreme caution shall be exercised to protect yourself and others from infection. Every accident 

must be immediately reported to a supervisor. 

 

Properly discard all used materials in marked biohazard bags. Clean all work surfaces and used 

instruments thoroughly with a 10% bleach solution.  

 

The consumption of food and/or drinks is prohibited during the processing of human remains.   
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Chapter 44: Identification of Unknown or Unknown Deceased 

Individuals, and Submission of Fingerprints to ICE for Database Search 
 

In instances in which an unidentified individual is involved in a criminal investigation in Wake 

County, the Latent Print Unit may be requested to submit the fingerprints of this individual into 

various databases in an attempt to render identification. These cases shall be considered a 

priority.  

If an apparent positive database search result is produced, the Latent Examiner will access the 

known print standards, if possible, and conduct a fingerprint analysis to determine the validity of 

the database information.  

Once the fingerprints have been identified to a known source, the case must be submitted to 

another Latent Examiner for the verification process. After verification, the investigator/s may be 

notified, preferably via e-mail so a copy of the sent message can be printed and maintained in the 

case file.  

A latent report for the identification of the unknown individual (or unknown deceased 

individual) must then be produced by the Latent Examiner who conducted the examination.  

If there is no identification to the unknown individual, and at the request of the investigating 

authority, the Latent Print Examiner may be asked to contact the U.S. Immigration and Customs 

Enforcement (ICE) to have the fingerprints submitted into the ICE fingerprint database system.  

The fingerprints must be submitted to ICE officials in a general 10-print format, including, if 

possible, the lower slap finger impressions.  

Photocopies of post-mortem prints, or fingerprints not collected on a standard file fingerprint 

card, can be made and the fingerprint impressions can be cut out and taped to a standard file 

fingerprint card. ICE database system cannot accept fingerprint impressions for database search 

in any other format. 

Copies of any paperwork generated by ICE officials and released to the Latent Examiner, and/or 

any notes created by the Latent Examiner, will be retained in the case file.   

Should a fingerprint identification be effected by ICE, the identification information will be 

forwarded directly to the requesting investigator.  
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If, however, the investigating authority requests a fingerprint examination to “verify” the 

identification information generated by ICE, the Latent Examiner may conduct the examination 

if a known print standard is available, have the identification verified by a Latent Examiner 

authorized by the Director to conduct verifications, and then produce a report.  

Documentation, case notes, and copies of the known fingerprint records, will be maintained in 

the case file.  

If there is no record in CCBI known fingerprint repositories for the individual in question, it will 

be the responsibility of the investigator to obtain and provide a set of known fingerprint 

standards to the Latent Examiner, following the evidence submission guidelines and procedures. 

Upon the completion of the comparison, and after the report has been published, the evidence 

items will be returned to the contributing agency.  

The ICE facility is located on Ground level 0 of the Wake County Detention Center at 3301 

Hammond Rd, Raleigh, NC, in rooms S0110 and S011A.  

Contact information for ICE: 

The phone number for the general ICE office is 919-255-7200. 

The phone number for the ICE supervisor is 919-255-7206. 

The phone number the Wake County Sheriff's Office ICE Sgt. is 919-255-7209.  
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Chapter 45: Comparison Process for the Identification of Unknown 

Individuals / Unknown Deceased Individuals; and Ten Print 

Examinations 
 

When the Latent Print Unit is requested to assist in the identification of an unidentified or 

unknown individual, deceased or alive, the following protocol will apply: 

1) The Latent Examiner will conduct a comparative analysis, utilizing the ACE 

methodology, and verified by a Latent Examiner. 

2) Copies of the fingerprint records utilized for the comparison must be maintained in the 

Latent Examiner’s case file.  

3) Full case notes will be generated by the Latent Examiner.  

4) The original fingerprint impressions of the unknown individual, if received as an 

evidence item, shall be returned to the contributing agency.  

5) The fingerprint record of a known individual, generated as a result of a database search 

and accessible through the CCBI fingerprint repositories, will be documented as 

reference materials.   

6) In instances when both fingerprint records, (the impressions recorded from an unknown 

individual and the impressions of a known individual) are received for comparison as 

evidence items, copies of the records will be retained in the case file and the items will be 

returned to the contributing agency upon completion of the examination.  

7) The results of the comparative analysis should be communicated to the requesting agency 

or authority (via verbal communication, or rapid notification e-mail, for example). The 

communication should be documented and retained in the case file accordingly.  

8) A latent report must be generated.  

Ten Print Examinations 

Ten Print Examination is not currently included in the Raleigh/Wake City-County Bureau of 

Identification laboratory scope of accreditation and shall not be presented as such in any manner.  
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In the event that a latent examiner is requested to complete a ten print examination, the following 

guidelines will apply: 

1) A request for ten print examination may be received either by the CCBI latent request e-

mail address, fax, or in person.  The request must be received in writing on the ten print 

exam request form. The request must be documented on the Laboratory Request and 

either the Habitual Felon Fingerprint Request form or the Firearm by Felon Fingerprint 

Request form, whichever of the two is most applicable.   

 

2) A unique CCBI case identifier must be assigned to each request. 

 

3) If the known standards are being supplied by the requestor, they must be received as 

evidence items via Evidence Receiving Unit.   

 

4) Upon receiving the request, the latent examiner must conduct their forensic analysis 

using the same methods and procedures as are utilized for latent print analysis and 

verification.  

 

5) A copy of the request must be forwarded to the appropriate individual, both before and 

after completion, for statistical purposes. 

  

6) Evidence transactions for records submitted to CCBI for analysis will follow the current 

evidence transfer protocols.  

 

7) Administrative and technical documentation must be organized as per normal case file 

procedures.  

 

8) Notes must be documented on the Ten Print Examination Note Sheet. Level 1 detail must 

be reviewed for each of the ten prints for consistency purposes. Documentation of level 2 

information must exist for a minimum of one (1) finger. If an exclusion occurs, 

exclusionary conclusions based on either (or both) levels 1 and 2 detail must likewise be 

documented.    

 

9) Upon completion of the examination, a “Ten Print Examination” report must be 

produced.  
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10) 100% of Ten Print examination cases will be technically reviewed. The technical review 

may be completed by an authorized verifier after verification, if the verifier has been 

authorized by the Director to perform technical reviews.  

 

11) The case file will be submitted for administrative review once verification and technical 

review on the case have been completed.  
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Chapter 46: Re-Examination of Latent Print Evidence by an Independent 

Examiner 
 

In cases where an independent Latent Print Examiner has been contracted by defense attorneys 

for a re-examination of latent print evidence, the following protocol will be followed: 

1) A court order advising of the re-examination of the print evidence must be received by 

CCBI with sufficient notice prior to the arrival of the Independent Examiner. The court 

order may be received by the Deputy Director of the Crime Laboratory, or the Forensic 

Supervisor of the Latent Print Unit.  

2) The Assistant District Attorney assigned to the case must be notified of the request for re-

examination of the latent print evidence.  

3) The court order will be turned over to the records division to be included in the case file.  

4) The Independent Examiner must schedule a date and time with the Forensic Supervisor, 

to come to CCBI for this purpose. 

5) The Independent Examiner will be provided with the latent print evidence (following 

chain-of-custody protocols) or a high quality copy of the latent print evidence (chain-of-

custody protocols not applicable in this scenario) and a copy of the known 10-print card 

of the defendant, or other individuals, in question. If a copy of the latent print evidence is 

created to give to the Independent Examiner, a receipt indicating the transaction shall be 

created. The original receipt will also be sent to the records division to be placed in the 

case file, and a copy of the receipt will be provided to the Independent Examiner.  

6) Though technically the latent print evidence is in the custody of the Independent 

Examiner, the evidence items may not be removed from CCBI. 

7) The Independent Examiner may not mark on the latent print evidence, nor may they 

adjust, alter or change any marking previously made by CCBI personnel.  

8) If the known 10-print card is an original hard copy, it must be returned to CCBI upon the 

completion of the re-examination. If the known 10-print card is a record captured 

electronically, in which many copies can be produced, it may be kept by the Independent 

Examiner.  

9) Unless directed to do so by a court order, the Independent Examiner shall not be provided 

with any copies of case notes or reports. 

10) The Independent Examiner will not be provided with any Wake County materials or 

equipment for said examination. 

11) The Independent Examiner will be allowed to conduct their comparative analysis in an 

environment that is suitable for such an examination. A room furnished with a desk, 
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chair, and adequate lighting will be provided. Additionally, under no circumstance will 

the Independent Examiner be allowed to work in an area that contains any CCBI 

evidence, case information, or records storage. 

12) It is not necessary to have a CCBI employee act as a custodian of the evidence and 

remain with the Independent Examiner throughout their examination.    

13) Upon the completion of said examination, the Independent Examiner will return the 

latent evidence to an appropriate CCBI representative (i.e. Forensic Supervisor or Latent 

Print Unit designee). The evidence package should be received in an unsealed condition, 

thereby allowing the accepting individual the ability to inventory the evidence items prior 

to its acceptance. Once the evidence has been inventoried, and it has been determined that 

the evidence is being returned in an unaltered condition, the Independent Examiner may 

then seal the evidence package, sign the seal, and return the latent print evidence per 

chain-of-custody protocol. However, if any evidence is found to be altered or missing, a 

supervisor must be immediately notified prior to the CCBI employee accepting the 

evidence in question. 
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Chapter 47: Erroneous Identifications 
 

An erroneous identification occurs when a friction ridge surface or pattern impression 

comparison is made, and it is determined that the two impressions originated from the same 

source when in fact they did not originate from the same source. 

In the event of an erroneous identification decision by a Latent Examiner and/or Verifier, the 

Corrective and Preventative Action Policy will apply.  

 

See the Laboratory Administrative Procedures Manual, Chapter 4, page 12, section “Corrective 

and Preventive Action”.  

 

 

REFERENCES 

 

SWGFAST, Terminology (Latent/Tenprint)  
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Chapter 48: Testimony 
 

Subpoenas for court cases are generally served to the members of Latent Print Unit by the 

Executive Secretary to the Director, or by a member of the Support Services Division.   

It is highly recommended that upon the receipt of any subpoena, the Latent Examiner 

immediately make contact with the party for whom the Latent Examiner was subpoenaed and 

discuss the details of the testimony. If possible, a pre-trial conference should also be scheduled. 

During this contact with the attorney, if necessary, the Latent Examiner should share an updated 

curriculum vitae (CV) and a set of qualifying questions and answers for expert qualification. 

Members of the Latent Print Unit will likely be required to testify in court regarding their 

participation in a case. The majority of the time such testimony will require qualification as an 

expert in latent print analysis and/or footwear analysis.  

The Latent Examiner should review and be familiar with the case, notes, report and shall be 

appropriately prepared to testify as to their work. They should be dressed professionally, and 

display their court badge attached to the clothing on the left side of the chest, approximately over 

the heart.  

A courtroom evaluation form must be completed for at least one testimony yearly by the 

Forensic Supervisor, Assistant Forensic Supervisor, Quality Manager, Deputy Director of the 

Crime Laboratory, or a court official. a supervisor or district attorney. Upon its completion, the 

evaluation information reported on the form will be reviewed with the Latent Examiner by the 

Forensic Supervisor, Assistant Forensic Supervisor, Quality Manager, Deputy Director of the 

Crime Laboratory, or Technical Leader. the Forensic Supervisor or designee.  

See Laboratory Administrative Procedures Manual, Chapter 21, page 76, section “Testimony 

Review”.  
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Chapter 49: Instrumentation/Equipment 
 

The instrumentation and equipment listed below are not considered critical, however supplies 

listed may affect the quality of testing. See Chapter 7 of the Laboratory Administrative 

Procedural Manual for direction regarding the receipt of below-listed supplies and equipment.  

Documentation pertaining to the equipment and supplies will be kept to ensure that the items 

ordered were in fact the items received, and the condition of the items once received will be 

noted. The documentation shall consist of copies of a requisition or ordering form, and the 

packaging slip. Once the items are received, notations as to condition the items were received 

will be noted on these forms.  

Any documentation created as a result of the ordering and receipt of such equipment will be 

maintained in the Latent Print Unit by the Technical Leader.  

Databases (4):  

- SPEX 

- SAFIS  

- IAFIS 

- SICAR 

Lamps – Various lighting sources, generally with a bendable lighted end that provides extra 

illumination to a Latent Examiner for use during a latent print comparative analysis.  

Magnifiers – optical magnification devices that magnify surfaces from approximately 4X to 6X. 

These are common tools utilized by Latent Print Examiners in the comparative analysis process.  

Ridge counters – pen-like devices with sharp points or tips, used for the tracing and counting of 

the minute detail located within the friction ridge structures during a latent print comparative 

analysis.  

Sharpie markers – markers needed for marking evidence lifts with important information in a 

permanent manner.  

Comparators - The FX8B is a large magnification device that contains two projectors for a full-

screen, side-by-side display of two images without image overlap. A matched pair of color-

corrected, side-by-side f/3.5 objective lenses provide 6.5X and 10X magnification.  
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CSI PIX Comparator version 3.0 – This digital enhancement software that is utilized in addition 

to, or in place of, the FX8B comparators. The software allows for the enhancement of images, 

while providing side-by-side views of images being compared.  

Digital light station - The Sirchie Forensic Digital Optical Desktop Video Magnifier, Catalog 

No. FXE350 facilitates viewing small details with its moveable viewing table and fully 

adjustable magnification up to 50X. The FXE350 features a wide range of color correction, 

brightness and contrast on the oversize 22-inch LCD, high-resolution (1680x1050 pixels) 

viewing screen.  

Photoshop software – software utilized to assist with the visual enhancement of impression 

evidence.  

Copy machine – General office equipment, utilized by the Latent Examiners for the producing of  

footwear overlays on acetate film sheets.  

Acetate film sheets - Transparent sheets, 8.5” X 14”, utilized for the creation of footwear overlay 

standards in footwear examinations.  

Fingerprint powders – Powders used for the visualization and development of latent print 

impressions, or the capture known finger/palm impressions.   

Lifting tape – Transparent tape used for the collection of impression evidence made visible by 

used of powders or other chemicals.  

Backing cards – White card-stock type paper items, of various sizes, utilized as a placement 

setting for various types of impression evidence lifted by transparent tapes.  

Contact paper – White adhesive sheets utilized for the collection of known finger/palm 

impressions.  

Mikrosil – casting material utilized for the capture of minute details on textured surfaces.  

Printer’s ink - Specially formulated for fingerprint work only, this densely-black ink is free 

flowing, easily rolled and dries quickly on paper—but will remain soft and usable on a slab for 

days. This ink is not adversely affected by extreme temperature changes.  

Cotton – basic cotton pieces utilized for the uniform application of fingerprint powders to 

various surfaces.   

Digital Camera- Nikon D3000 
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Tripod 

Card reader 

Memory card 

Personal protective equipment  

- Disposable latex gloves 

- Protective lab coat or protective gown 

- Eye protection 

- Footwear covers 
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Chapter 50: Vendor Communication Log 
 

Any time a vendor must be contacted due to technical issues with equipment that can have a 

significant impact upon the quality of the work product, the communication must be 

documented.  

A Vendor Communication Log serves to document any communications with vendors 

concerning issues with equipment.  

The log must be updated with every contact, though only a brief notation detailing the issues and 

resolutions is necessary.  

The Vendor Communication Log is accessible to the Forensic Technician/Latent Examiners on 

the S drive, and is located in the folder titled “Latent Unit Note Sheets”.  
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Abbreviation List 

 

Prints: 

 

F Finger 

P Palm 

JT Joint 

LP Loop 

RL, \ Right slant loop 

LL, / Left slant loop 

WH Whorl 

CPLW Central pocket loop whorl 

DLW Double loop whorl 

AR Plain arch 

TA Tented arch 

IDL Interdigital palm  

TN Thenar 

HTN Hypothenar 

CPD Carpal delta 

WP Writer’s palm 

SD Extreme side of a finger/digit 

TP Tip of a finger 

SCR Scar 

CRS Crease(s) 

ONL Outward nose loop 

INL Inward nose loop 

VES Vestige  

?PT Unknown/questionable pattern type 

?          Unknown/undetermined marking or impression 

R         Right 

L         Left 

 

  

Latents: 

 

LFP Latent fingerprint 

LPP  Latent palm print 

LRD Latent ridge detail 

LFT Latent foot print 

LJT Latent joint 
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Knowns: 

 

KFP Known fingerprints 

KPP Known palm prints 

KS Known standards 

MCS Major case style prints 

Elims Elimination prints 

PMP Post mortem prints 

PMF Post mortem fingers 

PML   Post mortem palms 

KFT Known foot prints 

KRF Known right foot 

KLF Known left foot 

LVS Live scan 

Ink Inked impressions 

  

 

Analysis: 

 

PR Pressure 

DEP Deposition  

SM Smearing 

MV Movement 

LAT Lateral  

DST Distortion 

LT Light 

DK Dark 

TX Textured surface 

HR Horizontal reversal 

TR Tonal reversal 

PH Photo 

GL Gel lift 

MKS Mikrosil lift 

MST Moisture 

FRG Fragmented 

RD Ridge detail 

NV No value 

OV Of value 

CHM Chemically developed – other than powder 

PDR Developed by powder 

GD Good 

PO Poor 
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 QU Quality 

QA Quantity 

L1 Level  1 detail 

L2 Level 2 detail 

L3 Level 3 detail 

SML Simultaneous impressions 

AGG Aggregate impression(s) 

OVL Overlapping impressions 

DBL Double tap 

Imp? Latent impression w/ orientation in question 

MIN Minimal 

CLR Clarity 

NFR Non-friction ridge skin 

ENR Ending ridge 

BIF Bifurcation 

ENC Enclosure 

INR Incipient ridges  

DOT Dot/s 

RDG Ridges 

DIS Disagreement 

AGR  Agreement 

DLT Delta 

CRE Core 

TGZ Target zone 

RGC Ridge count 

CRO Crossover 

TRI Trifurcation 

SPR Spur 

HOK Hook 

SHR Short ridge 

OPS Opposing ridges 

RDF Ridge flow 

MNT Minutiae 

DSR Disassociated ridges 

POR Pores 

EDG Edges 

ART Artifact 

APP Appendage 

BRG Bridge 

REC Recurve 

FUR Furrows 

DSC Discrepancy 

DEV Deviation (ridge path deviation) 
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 PAT Patent Print 

FAL Fault line  

BTW   Between 

CMP   Compression  

INT     Intervening 

CHD   Child 

SMA   Small 

PRT    Partial  

ABV   Above 

BLW   Below 

MLT   Multiple 

VOD   Void 

SUP    Supports  

HVY   Heavy 

MED  Medium 

AMP Amputation  

DIT  Distal Transverse (Crease)  

PXT   Proximal Transverse (Crease)   

RAL  Radial Longitudinal (Crease)  

CNE   Cannot exclude 

ICP     Incomplete 

NCP   Not compared 

RVS   Reverse 

DIG   Digital image 

FR      Fair 

SUF    Sufficient 

CST    Cluster 

EXP    Excess Powder 

BRM    Brush Marks 

 

 

 

Results:  

 

VER  Verified  

ID  Identified/individualized  

NID  Not identified/individualized  

EXC  Exclusion  

INC  Inconclusive  

NBS  Need better standards  

NMC  Need major case style prints  

NPM  Need post mortems  

NTP  Need tips  
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 NBP  Need better palms  

NBF  Need better fingers  

NEG  Negative  

 

Databases / Searches:  

 

FS  Federal Search  

SS  State Search  

LS  Local Search  

DBS  Database search  

DBS-  Database search with negative result  

NIST  Nist archive  

LVS  Live scan  

SIC  SICAR  

NSQ Not SICAR quality  

NDQ  Not database quality  

 

Procedures: 

 

COC  Chain-of-custody  

TFT  Transferred to  

NTF  Notified  

REC  Received  

LPU  Latent Print Unit  

REQ  Request  

RPT  Report  

PND  Pending  

VFB  Verified by  

LEC  Latent evidence control room  

TCR  Technical Review  

 

Footwear Abbreviations: 

  

FWC  Footwear comparison  

QI  Questioned impression  

KI  Known impression  

DES  Derivative evidence standards (overlays)  

CST  Cast  

GEL  Gel lift  

SOL  Sole  

HEL  Heel  

TOE  Toe  

WEP  Wear Pattern  
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 FEA  Feathering  

SHA  Shallamach  

CUT  Cuts  

SRT  Scratches  

MAS  Manufacturer size  

PHS  Physical size  

PSS  Physical shape  

DSE  Design Elements  

IDC  Individual characteristics  

CLC  Class characteristics  

RTS  Right shoe  

LTS  Left shoe  

COR  Corresponds with  

DNC  Does not correspond with  

 

Results:  

 

PRM  Probably made  

CHM  Could have made  

ELM  Elimination  

UNS  Unsuitable 
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Revision History 

 

Effective Date 

 

Version 

Number 

 

Reason 

1/1/13 1 Compliance with ASCLD/LAB requirements 

7/14/14 2 Update 

8/3/15 3 Addition of CNE, ICP, NCP, RVS and DIG to analysis 

abbreviations 

1/19/16 4 Addition of FR, SUF, CST, EXO and BRM to analysis 

abbreviations.  Removal of notification and vendor 

communication log templates. 
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Rapid Notification E-mail Template 
 

Latent Print Notification 

 

 

LEA #/ CCBI# Date / 

Location 

Subject name ID # Print lifted 

from/ id'd to: 

     

     

     

     

 

 

 

The report/s for the above-listed case/s is/are not yet complete, but should be available soon 

for your review. If you have any questions please feel free to contact me at any time. 
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Vendor Communication Log Template       

    
 

 

 
 

 

 

 

 
 

 


